CONFIDENTIAL INFORMATION

The information herein is the property of Ex Libris Ltd. or its affiliates and any misuse or abuse will result in economic loss. DO NOT COPY UNLESS YOU HAVE BEEN GIVEN SPECIFIC WRITTEN AUTHORIZATION FROM EX LIBRIS LTD.

This document is provided for limited and restricted purposes in accordance with a binding contract with Ex Libris Ltd. or an affiliate. The information herein includes trade secrets and is confidential.

DISCLAIMER

The information in this document will be subject to periodic change and updating. Please confirm that you have the most current documentation. There are no warranties of any kind, express or implied, provided in this documentation, other than those expressly agreed upon in the applicable Ex Libris contract. This information is provided AS IS. Unless otherwise agreed, Ex Libris shall not be liable for any damages for use of this document, including, without limitation, consequential, punitive, indirect or direct damages.

Any references in this document to third-party material (including third-party Web sites) are provided for convenience only and do not in any manner serve as an endorsement of that third-party material or those Web sites. The third-party materials are not part of the materials for this Ex Libris product and Ex Libris has no liability for such materials.

TRADEMARKS

"Ex Libris," the Ex Libris Bridge to Knowledge, Primo, Aleph, Voyager, SFX, MetaLib, Verde, DigiTool, Rosetta, bX, URM, Alma, and other marks are trademarks or registered trademarks of Ex Libris Ltd. or its affiliates.

The absence of a name or logo in this list does not constitute a waiver of any and all intellectual property rights that Ex Libris Ltd. or its affiliates have established in any of its products, features, or service names or logos.

Trademarks of various third-party products, which may include the following, are referenced in this documentation. Ex Libris does not claim any rights in these trademarks. Use of these marks does not imply endorsement by Ex Libris of these third-party products, or endorsement by these third parties of Ex Libris products.

Oracle is a registered trademark of Oracle Corporation.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through X/Open Company Ltd.

Microsoft, the Microsoft logo, MS, MS-DOS, Microsoft PowerPoint, Visual Basic, Visual C++, Win32, Microsoft Windows, the Windows logo, Microsoft Notepad, Microsoft Windows Explorer, Microsoft Internet Explorer, and Windows NT are registered trademarks and ActiveX is a trademark of the Microsoft Corporation in the United States and/or other countries.

Unicode and the Unicode logo are registered trademarks of Unicode, Inc.

Google is a registered trademark of Google, Inc.

Copyright Ex Libris Limited, 2017. All rights reserved.

Document released: March 2017

Web address: http://www.exlibrisgroup.com
# Table of Contents

Updates to This Guide ........................................................................................................... 17

**Part I  Introduction**

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Understanding Staff Users</td>
<td>21</td>
</tr>
<tr>
<td>3</td>
<td>Searching and Reporting For All Staff</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Home Page</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Home Page Summary</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>Quick Search</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>Advanced Search</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>Advanced Search Page Layout</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>Advanced Search Conditions</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>Field Element Selection</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Nested Search Conditions</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>Operators</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>Value Field</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>Search Results Features and Options</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>List or Thumbnail View</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>Sort By</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>Column Display</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>Facets</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>Actions</td>
<td>41</td>
</tr>
<tr>
<td></td>
<td>Export to Excel</td>
<td>42</td>
</tr>
<tr>
<td></td>
<td>Running and Viewing Reports</td>
<td>42</td>
</tr>
<tr>
<td></td>
<td>Accessing Reports</td>
<td>42</td>
</tr>
<tr>
<td></td>
<td>Running a Report: Uploads</td>
<td>43</td>
</tr>
<tr>
<td></td>
<td>Scheduling Reports</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>Reports Available in Rosetta</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>ALTERNATIVES_EVALUATION</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>APPLIBRARY</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>APPLICATION_LIBRARY_EVENTS</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>AUTO_EVALUATION</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>AUTO_EVALUATION_PER_REP</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>BIRT_GENERAL_PARAMETERS</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>BITSTREAM_VIEW</td>
<td>52</td>
</tr>
<tr>
<td>Category</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>CLASSIFICATION_LIBRARY_EVENTS</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>CLASSIFICATIONPROPERTY</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>COMMITS_TO_PERMANENT_BY_TYPE</td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>DELETED_IEs</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>DEPOSIT_ACTIVITIES_PER_MF</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>DEPOSIT_ACTIVITIES_PER_MT</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>DEPOSIT_ACTIVITY_EVENTS</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>DEPOSIT_ACTIVITY_HISTORY</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>EVALUATION_RESULTS</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>EVENT_KEYS</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>EVENT_STATISTICS</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>EVENTS</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>EXTRACTOR_LIBRARY_EVENTS</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>FILE_TYPE_GROUPS_IN_PERMANENT</td>
<td>53</td>
<td></td>
</tr>
<tr>
<td>FILES_IGNORED - FILE_EXTENSION_MISMATCH</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>FILES_IGNORED - MD_ERROR</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>FORMATAPPLICATIONS</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>FORMATS_BREAKDOWN</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>FORMATS_PER_CLASSIFICATION_GROUP</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>FORMATLIBRARY</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>FORMAT_LIBRARY_EVENTS</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>FORMATRISKS</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>HOMEPAGE_DASHBOARD</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>IE_EVENTS</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>IES_BY_SIP_ID</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>IES_PERMANENT_LIST</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>IES_TO_BE__DELETED</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>INTELLECTUAL_ENTITIES_DELIVERED</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>MANUAL_EVALUATION</td>
<td>55</td>
<td></td>
</tr>
<tr>
<td>MATERIAL_FLOW_LIST</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>METADATA_FORM_LIST</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>MOST_VIEWED_OBJECTS</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>NEW_MONOGRAPHS_IN_PERMANENT</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>NEW_PERIODICALS_IN_PERMANENT</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>PERMANENT_INDEX</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>PROCESS_EXECUTION_HISTORY</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>PRODUCER_DEPOSITS</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>PRODUCER_GROUP_DEPOSITS</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>PRODUCER_PROFILES_LIST</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>PRODUCERS_LIST</td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>REPOSITORY_STATS_A</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>Subject</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>REPOSITORY_STATS_A</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>REPOSITORY_STATS_B</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>REPOSITORY_STATS_C</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>REPOSITORY_STATS_D</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>RISKLIBRARY</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>SIP_PROCESSING_STATS_PIE</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>SIPS_STATS</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>SUBMISSION_JOB_DETAILS</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>TOTAL_PRODUCER_GROUP_DEPOSITS</td>
<td>57</td>
<td></td>
</tr>
<tr>
<td>USER_DETAILS</td>
<td>57</td>
<td></td>
</tr>
</tbody>
</table>

**Chapter 4** Submission Information Package (SIP) Overview .......... 59

Understanding SIP Statuses and Stages ........................................ 59

System Reports ........................................................................... 62

- SIPS Dashboard ....................................................................... 62
- Find a SIP ............................................................................... 63

SIP Processing Flow ................................................................... 65

**Part II** Deposit Managers ................................................... 69

**Chapter 5** Understanding Deposit Managers .............................. 69

**Chapter 6** Configuring Deposit Control Settings ......................... 71

**Chapter 7** Configuring Metadata Forms ................................... 73

- About Configuring Metadata Forms ......................................... 73
- Accessing the List of Metadata Forms Page ............................. 74
- Adding a Metadata Form ........................................................ 75
- Adding Lists of Values to Metadata Forms ............................... 78
  - Generic Lists of Values ..................................................... 81
- Working with Metadata Forms ................................................ 82
  - Previewing a Metadata Form ............................................... 82
  - Duplicating a Metadata Form ............................................. 82
  - Updating a Metadata Form ............................................... 83
  - Deleting a Metadata Form ................................................ 83
  - Viewing Material Flows Associated with the Metadata Form ...... 84

**Chapter 8** Configuring Material Flow Infrastructure ..................... 85

- About Configuring Material Flow Infrastructure ......................... 85
- Configuring Submission Formats .............................................. 86
  - Accessing the List of Submission Formats Page ..................... 86
  - Adding an HTTP Load or Bulk Submission Format ................... 87
Adding a Detailed Submission Format .................................................. 89
Adding an Automated Submission Format for Deposit Through FTP/SFTP 92
Adding an Automated Submission Format for Deposit Through NFS .... 94
Viewing Submission Format Details .................................................. 97
Duplicating a Submission Format ..................................................... 97
Viewing Material Flows Associated with a Submission Format .......... 98
Updating a Submission Format ......................................................... 98
Deleting a Submission Format ........................................................... 98

Configuring Content Structures ....................................................... 99
Accessing the List of Content Structures Page ................................. 99
Adding a Content Structure .............................................................. 100
CSV Templates .................................................................................. 107
Viewing Content Structure Details .................................................. 109
Duplicating a Content Structure ....................................................... 109
Viewing Material Flows Associated with the Content Structure ...... 110
Updating a Content Structure ........................................................... 110
Deleting a Content Structure ............................................................. 111

Working with Configuration Files ..................................................... 111
Delivery XSLs .................................................................................... 113
Delivery Copyrights Statements ....................................................... 113
Configuring Copyright Boilerplate Statements ................................. 114
Configuring Producer Agent E-mail .................................................. 116
Configuring Terms of Use ................................................................. 120

Configuring Metadata Profiles .......................................................... 121
Accessing the List of Metadata Profiles Page ................................. 122
Creating a New Metadata Profile ...................................................... 123
Editing or Duplicating an Existing Metadata Profile ...................... 123
Deleting a Profile ............................................................................. 125

Associating Material Flow Components with Material Flows ...... 125

Chapter 9

Access Rights ..................................................................................... 127

Configuring Access Rights Policies .................................................. 127
How Access Rights Work ................................................................. 127
Access Rights as Shared Metadata .................................................. 128
Accessing the Metadata Search Page ............................................... 128
Adding an Access Rights Policy ....................................................... 129
Editing an Access Rights Policy ....................................................... 134
Deleting an Expression from an Access Rights Policy .................... 136
Chapter 10  Retention Policies ................................................................. 147
About Retention Policies ................................................................. 147
Creating Retention Policies ......................................................... 148
   Working With Retention Policies .............................................. 151
      Editing a Retention Policy .................................................. 151
      Deleting a Retention Policy ............................................... 152
      Displaying a Previous Version of a Retention Policy .......... 152
      Assigning a Retention Policy to an IE .............................. 152

Chapter 11 Managing Generic Material Flows .................................... 155
About Generic Material Flows ........................................................ 155
Accessing the List of Material Flows Page .................................. 155
Adding a Material Flow .............................................................. 157
Activating and Deactivating Material Flows ............................... 161
Duplicating a Material Flow ....................................................... 162
Updating a Material Flow ........................................................... 162
Deleting a Material Flow ............................................................ 163

Chapter 12 Managing Generic Producer Profiles .............................. 165
About Managing Producer Profiles .............................................. 165
Accessing the List of Producer Profiles Page ............................. 165
Adding a Producer Profile .......................................................... 167
Activating and Deactivating Producer Profiles ........................... 168
Updating a Producer Profile ....................................................... 169
Duplicating a Producer Profile ................................................... 170
Deleting a Producer Profile ........................................................ 170

Chapter 13 Managing Material Flows Associated with a Producer Profile ........................... 171
About Managing Material Flows .................................................. 171
Accessing the Material Flows List Page ...................................... 171
Chapter 14 SIP Processing, Configuration, and Routing Rules .......... 177

Understanding SIP Processing .......................................................... 177
  Pre-Approval Stage ........................................................................ 178
  Approval Stage ............................................................................ 181
  Enrichment Stage .......................................................................... 181
  Move to Permanent Stage .............................................................. 181

SIP Routing Rules ......................................................................... 182

Defining SIP Processing Configuration .............................................. 186
  Adding a SIP Processing Configuration .......................................... 187
  Updating a SIP Processing Configuration ....................................... 188
  Duplicating a SIP Processing Configuration .................................... 189
  Deleting a SIP Processing Configuration ........................................ 189
  Activating and Deactivating a SIP Processing Configuration .......... 190

Configuring SIP Routing Rules ......................................................... 190
  Adding a SIP Routing Rule ............................................................ 191
  Updating a SIP Routing Rule ........................................................ 193
  Duplicating a SIP Routing Rule ...................................................... 194
  Deleting a SIP Routing Rule .......................................................... 194
  Activating and Deactivating a SIP Routing Rule ......................... 194

Chapter 15 OAI-PMH Harvester ....................................................... 197

Overview ....................................................................................... 197

Loading New Objects ...................................................................... 197

Updating Existing Objects ............................................................... 198

Creating the OAI_PMH Harvest Job .............................................. 198

Viewing the OAI-PMH Harvest Job History ................................. 203

Part III Negotiators

Chapter 16 Understanding Negotiators ............................................ 207

Chapter 17 Managing Producers ..................................................... 211

About Managing Producers ............................................................ 211

Accessing the Manage Producers Page ........................................ 211

Searching, Filtering, and Sorting Producers ............................... 213
Chapter 18 Personalizing Producer Profiles ......................................................... 225
   About Personalizing Producer Profiles ......................................................... 225
   Accessing the Producer Details Page ............................................................ 225
   Upgrading a Registered Producer Account .................................................. 226
   Personalizing a Producer’s Deposit Control Settings .................................... 228
   Assigning Material Flows to a Producer Profile ............................................. 229

Chapter 19 Personalizing Material Flows ........................................................... 231
   About Personalizing Material Flows ............................................................... 231
   Accessing the Material Flow Details Page .................................................... 231
   Adding and Deleting CMS IDs ..................................................................... 238
   Personalizing Metadata Forms ..................................................................... 239
   Personalizing Submission Formats ............................................................... 240

Chapter 20 Depositing Content on Behalf of a Producer ..................................... 241

Chapter 21 Scheduling Producer Reports ........................................................ 245
   About Producer Reports ................................................................................ 245
   Deposit History Report ................................................................................ 245
   Intellectual Entity Views Report ................................................................... 246
   Viewing Producer Reports ............................................................................ 246
   Managing the Producer Report Job ............................................................... 248
   Modifying the Producer Report Job ............................................................... 249
   Cancelling the Producer Report Job .............................................................. 250
   Viewing the Producer Report Job History .................................................... 251
   Configuring Advanced Job Schedules ......................................................... 252

Chapter 22 Submission Jobs ............................................................................ 257
   About Submission Jobs ................................................................................. 257
   Managing Submission Jobs ............................................................................ 258
### Part IV  Assessors, Arrangers, and Approvers

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>Understanding Assessors, Arrangers, and Approvers</td>
<td>269</td>
</tr>
<tr>
<td>24</td>
<td>Working with SIPs</td>
<td>271</td>
</tr>
<tr>
<td></td>
<td>About Working with SIPs</td>
<td>271</td>
</tr>
<tr>
<td></td>
<td>Viewing SIPs to Be Reviewed</td>
<td>271</td>
</tr>
<tr>
<td></td>
<td>Accessing the SIP Content List Page</td>
<td>273</td>
</tr>
<tr>
<td></td>
<td>Viewing SIP Information</td>
<td>275</td>
</tr>
<tr>
<td></td>
<td>SIP History</td>
<td>276</td>
</tr>
<tr>
<td></td>
<td>SIP Problem Notes</td>
<td>277</td>
</tr>
<tr>
<td></td>
<td>An IE in a SIP</td>
<td>278</td>
</tr>
<tr>
<td></td>
<td>IE Structure and Metadata</td>
<td>278</td>
</tr>
<tr>
<td></td>
<td>Approving a SIP</td>
<td>280</td>
</tr>
<tr>
<td></td>
<td>Declining or Rejecting a SIP</td>
<td>280</td>
</tr>
<tr>
<td></td>
<td>Forwarding a SIP or an IE</td>
<td>281</td>
</tr>
<tr>
<td></td>
<td>Organizing IEs</td>
<td>282</td>
</tr>
<tr>
<td></td>
<td>Rearrange the Structure Map of an IE</td>
<td>282</td>
</tr>
<tr>
<td></td>
<td>Merge Single IEs</td>
<td>283</td>
</tr>
<tr>
<td></td>
<td>Split an IE</td>
<td>286</td>
</tr>
<tr>
<td></td>
<td>Tree View</td>
<td>287</td>
</tr>
<tr>
<td>25</td>
<td>Integration with External Collection Management Systems</td>
<td>291</td>
</tr>
<tr>
<td></td>
<td>Assigning a CMS ID to an Intellectual Entity</td>
<td>291</td>
</tr>
<tr>
<td></td>
<td>Unassigning a CMS ID to an Intellectual Entity</td>
<td>293</td>
</tr>
</tbody>
</table>

### Part V  Technical Analysts

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>Understanding Technical Analysts</td>
<td>299</td>
</tr>
<tr>
<td>28</td>
<td>Understanding Technical Issues</td>
<td>301</td>
</tr>
<tr>
<td>29</td>
<td>Viewing Problematic SIP Content</td>
<td>303</td>
</tr>
<tr>
<td></td>
<td>About Viewing Problematic Content</td>
<td>303</td>
</tr>
<tr>
<td></td>
<td>Accessing the Technical Issues Page</td>
<td>303</td>
</tr>
<tr>
<td></td>
<td>SIP Issues - Tabs and Details</td>
<td>305</td>
</tr>
</tbody>
</table>
Chapter 30  Resolving SIP Technical Issues ........................................ 311

About Resolving Issues .............................................................. 311
Moving a SIP to the Next Stage .................................................... 311
Rejecting and Declining Problematic Content ............................... 312
Resubmitting or Reloading Problematic Content ............................ 314
Replacing a Problematic SIP or File ............................................. 315
Viewing a Problematic SIP or File ............................................... 315
Validation Stack Error Codes ....................................................... 316
Handling a Problematic SIP or File .............................................. 317
Format Problems ........................................................................ 317
File Extension Issues ................................................................... 318
Metadata Errors .......................................................................... 319
Rerunning Processes .................................................................... 321
Rechecking a File ........................................................................ 321
Rerunning Validation .................................................................... 323
Rerunning Enrichment .................................................................. 323
Rerunning System Errors .............................................................. 323

Chapter 31  Viewing and Resolving Repository Issues ......................... 325

Technical Analyst Issues in the Repository .................................. 325
Identifying Repository TA issues .................................................. 325
Correcting Problems .................................................................... 327
Managing issues with file replacements ........................................ 329

Chapter 32  Validation Stack Rules .................................................. 331

Automating Corrections ............................................................... 331
Configuring Validation Stack Rules .............................................. 332
Adding a Rule ............................................................................. 334
Updating a Rule ........................................................................ 337
Re-Ordering Rules ...................................................................... 337
Duplicating a Rule.................................................................................. 338
Activating and Deactivating a Rule....................................................... 338
Exporting a Rule.................................................................................. 338
Deleting a Rule..................................................................................... 339

Part VI Editors

Chapter 33 Understanding Editors.......................................................... 343
Chapter 34 Working with Shared Metadata........................................... 345

Part VII Data Managers

Chapter 35 Understanding Data Managers............................................. 351
Chapter 36 Working with Sets............................................................... 353

Chapter 37 Working with Processes....................................................... 367

Viewing All Existing Processes............................................................. 367
Viewing Process Information................................................................. 369
Accessing the Process Execution History Page .................................... 369
Viewing Completed Processes............................................................... 371
Viewing Process Executions................................................................. 371
Viewing Summarized Execution History for a Process........................ 371
Viewing the History of Execution Exceptions for a Process ................. 372
Running a Process................................................................................ 373
Aborting a Process............................................................................... 377
Chapter 38  Publishing ................................................................. 379
  About Publishing ................................................................. 379
  Configuring Publishing ......................................................... 380
    Opening Page: Publishing Configuration List ......................... 380
    Adding/Updating Configurations ........................................ 381
  Converter Types ................................................................. 385
  Target Types ................................................................. 385
Chapter 39  Delete, Restore, Move, and Purge IEs ......................... 387
  Deleting, Restoring, and Purging an IE ................................ 387
  About Deleting, Restoring, and Purging an IE ....................... 387
  Deleting an IE from the Web Editor ...................................... 388
  Deleting IEs in Bulk ......................................................... 390
  Recovering an IE from the Recycling Bin .............................. 395
  Purging an IE from the System .......................................... 397
  Moving IEs ........................................................................ 397
  Restoring IEs from the Permanent Repository ...................... 402
Chapter 40  Fixity, Provenance, and Storage ................................. 405
  Fixity in Rosetta with an External Storage Layer .................... 405
  Managing Fixity Reports ..................................................... 406
Chapter 41  Scheduling Metadata Update Jobs ............................... 411
  About Metadata Update Jobs ................................................ 411
  Managing Metadata Update Jobs .......................................... 411
  Adding a Metadata Update Job ............................................ 413
  Modifying a Metadata Update Job ........................................ 415
  Cancelling a Metadata Update Job ........................................ 416
Chapter 42  Collections ............................................................... 419
  Collections in Rosetta ......................................................... 419
  Managing Collections ......................................................... 420
    Adding a New Collection .................................................. 422
    Editing a Collection ........................................................ 424
    Updating Collection Metadata ........................................... 425
    Associating IEs with Collections ........................................ 428
    Disassociating IEs from Collections ................................... 433
    Searching IEs Within Collections .................................... 433
    Searching Collections .................................................... 434
# Staff User’s Guide

## Chapter 43 Derivative Copy Representations
- Manually Adding a Derivative Copy Representation ........................................ 439
- Adding a Derivative Copy Representation with a Service .......................... 445
- Adding a Derivative Copy Representation with a Job .............................. 446

## Part VIII Web Editor

### Chapter 44 Web Editor
- About the Web Editor .............................................................................. 453
- Accessing the Web Editor ....................................................................... 453
  - Through a Search ............................................................................ 454
  - Through a List of Sets ................................................................... 454
- Viewing Digital Objects in the Web Editor ........................................... 455
  - The Object Summary Tab .............................................................. 455
  - Metadata Tab ............................................................................... 457
  - Services Tab ................................................................................ 459
  - Collections Tab ........................................................................... 460
  - Versions Tab ................................................................................ 461
  - Bitstreams Tab ............................................................................. 463
- Editing Digital Objects ........................................................................... 464
  - Editing Digital Collections ............................................................. 464
  - Editing Metadata through the Web Editor Interface ......................... 469
  - Adding a Logical Structmap ............................................................. 477
  - Generating a Logical StructMap ....................................................... 479
  - Editing a Physical Structmap ............................................................ 480
  - Exporting Objects ......................................................................... 481
  - Commit or Rollback Changes ........................................................... 482

### Chapter 45 Adding Representations
- Introducing Representation Functions .................................................. 483
- Managing Representations .................................................................... 483
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding a Representation: Process and Steps</td>
<td>484</td>
</tr>
<tr>
<td>Locking the Intellectual Entity</td>
<td>485</td>
</tr>
<tr>
<td>Adding the Representation</td>
<td>486</td>
</tr>
<tr>
<td>Processing the Representation</td>
<td>490</td>
</tr>
<tr>
<td>Updating a Representation</td>
<td>490</td>
</tr>
<tr>
<td>Replacing Files Within a Representation</td>
<td>491</td>
</tr>
</tbody>
</table>

Index ........................................................................................................... 497
Updates to This Guide

This guide is being reissued due to the following changes:

- The **Does not contain** operator was added to the list of operators. For more information, see Operators on page 32.
- A description of the BagIt converter has been added. For more information, see BagIt Converter on page 104.
- **Access Rights, Access Rights Exceptions**, and **Retention Policies** now have a **History** action, enabling users to view and revert to previous MD versions. For more information, see Displaying a Previous Version of an Access Rights Policy on page 136, Displaying a Previous Version of an Access Rights Exception on page 143, and Displaying a Previous Version of a Retention Policy on page 152.
- The explanation for List Contains string has changed for configuring SIP routing rules. For more information, see Operators Used in Rule Parameters on page 184.
- You can now test the OAI-PMH Harvester job. For more information, see OAI-PMH Harvester on page 197.
- You can view the history of the OAI-PMH Harvester and Producer’s Jobs. For more information, see Viewing the OAI-PMH Harvest Job History on page 203 and Viewing the Producer Report Job History on page 251.
- The columns of the **Technical Issues** page have been standardized and the **View Errors** action has been added. For more information, see Viewing Problematic SIP Content on page 303.
- The **Decline All** option has been added to the **Action** drop-down list. For more information, see Rejecting and Declining Problematic Content on page 312.
- MD Extraction plug-in timeout was added to Table 50 Validation Stack Error Codes on page 316.
- Virus Check Error was added to the list of validation stack errors. For more information, see Automating Corrections on page 331.
Part I

Introduction

This part contains the following sections:

- Chapter 2: Understanding Staff Users on page 21
- Chapter 3: Searching and Reporting For All Staff on page 23
- Chapter 4: Submission Information Package (SIP) Overview on page 59
Understanding Staff Users

Staff users are responsible for reviewing the content deposited by Producer Agents, managing Producers and Producer Agents, and configuring the way in which Producer Agents deposit content.

The following table describes Staff users’ roles and responsibilities:

<table>
<thead>
<tr>
<th>Staff Role</th>
<th>Responsibilities</th>
</tr>
</thead>
</table>
| Deposit Managers                  | Configuring generic Producer profiles and material flows...
|                                   | Deposit Managers work with the Producers sub-menu. For more information, see Understanding Deposit Managers on page 69. |
| Negotiators                       | Personalizing generic Producer profiles and material flows for the needs of specific Producers...
|                                   | Negotiators work with the Producers sub-menu. For more information, see Understanding Negotiators on page 207. |
| Assessors, Arrangers, and Approvers | Reviewing the content deposited by Producer Agents and deciding whether it should be approved, returned to the Producer Agent, or declined... |
|                                   | Assessors, Arrangers, and Approvers work with the Submission sub-menu. For more information, see Understanding Assessors, Arrangers, and Approvers on page 269. |
| Technical Analysts                | Repairing technical issues that occur with the content deposited by Producer Agents... |
|                                   | TAs work with the Submissions sub-menu. For more information, see Understanding Technical Analysts on page 299. |
| Editors                           | Editing metadata of the content deposited by Producer Agents...
|                                   | Editors work with areas of the Data Management sub-menu. For more information, see Understanding Editors on page 343. |
User roles are also associated with scope in terms of their level within a consortium.

- **Consortium** - Users with this scope can view and operate on objects that belong to all of the institutions in the consortium collectively. The following roles can have this scope: System Administrators, Editors, Data Managers, Preservation Analysts, and Preservation Managers.

- **Institution** - Users with this scope can work only on items (IEs, configuration items) within their own institution. All roles can be assigned an institutional scope.

- **Department** - Users with this scope can operate only on IEs that belong to their department. This scope is only relevant for Editors.

All staff users are assigned and registered by a User Manager.

This guide describes staff users and their responsibilities and explains how management staff users accomplish their tasks.

For additional information on users, role types, and administrative staff responsibilities, see the User Management chapter of the *Rosetta Configuration Guide*. 

### Table 1. Staff Users’ Responsibilities

<table>
<thead>
<tr>
<th>Staff Role</th>
<th>Responsibilities</th>
</tr>
</thead>
</table>
| Data Managers       | Scheduling and monitoring processes, managing sets, publishing configurations, and running activities that affect multiple IEs.                   
                       | Data Managers work with the Data Management sub-menu. For more information, see *Understanding Data Managers* on page 351.                      |
| Preservation Analyst| All tasks associated with risk analysis and loss prevention, including:                                                                        
                       | - populating Preservation libraries                                                                                                            
                       | - performing risk analyses on existing library collections                                                                                   
                       | - creating, testing, and running plans and plan alternates                                                                                  
                       | For more information, see the *Rosetta Preservation Guide*.                                                                                  |
| Preservation Manager| All tasks associated with risk analysis and loss prevention, including all the responsibilities of a Preservation Analyst plus signing off on and rejecting preservation plans. 
                       | For more information, see the *Rosetta Preservation Guide*.                                                                                  |
Searching and Reporting For All Staff

This section contains:
- Home Page on page 23
- Advanced Search on page 28
- Search Results Features and Options on page 33
- Running and Viewing Reports on page 42
- Reports Available in Rosetta on page 50

Home Page

The staff home page contains a summary view of statistics impacting the user, such as the number of SIPS at various stages, as well as the ability to search for SIPS or IEs or to add a Deposit activity.

For details, see:
- Home Page Summary on page 24
- Quick Search on page 25
NOTE:
If you see a red bar reporting a failed system check, contact your Administrator. For more information, see System Checks on page 224 of the Rosetta Configuration Guide.

Items on the home page are refreshed according to the following schedule:

Table 2. Home Page Item Refresh Rates

<table>
<thead>
<tr>
<th>Heading</th>
<th>Section</th>
<th>Refresh Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deposit</td>
<td>Quick Stats</td>
<td>Every 5 minutes</td>
</tr>
<tr>
<td></td>
<td>Deposits Per Producer Group</td>
<td>Every 5 minutes</td>
</tr>
<tr>
<td>Submissions</td>
<td>Quick Stats</td>
<td>Every 5 minutes</td>
</tr>
<tr>
<td>Preserved</td>
<td>Quick Stats</td>
<td>Every 5 minutes</td>
</tr>
<tr>
<td></td>
<td>Files by Classifications</td>
<td>Every 2 hours</td>
</tr>
</tbody>
</table>
Quick Search

Staff can search for objects using the single-field quick search provided on the Home page.

For the quick search under the **Submissions** heading, users can enter the SIP ID number and receive information about the SIP’s status.

For the search under the **Preserved** heading, users can perform one of three search types on the permanent repository—by PID, SIP ID, or text field. The table below describes the three search types.
The above search options are available for the **Preserved** heading search only. Rosetta activates one of the three types of searches by analyzing the string typed by the user.

PID searches, when successful, return a single IE, Representation, or File in the Web Editor, as shown in **Figure 3, Quick Search Results for Found PID**.
PID searches that fail to find a match return results on an Advanced Search page with the search terms reformatted into a query row (see Figure 4, Quick Search (PID) to Advanced Search). All other searches, whether successful or not, resolve to the Advanced Search page.
From here, users can modify their search, add conditions for a complex query, view thumbnails, export results, and sort and configure columns for results displays.

**Advanced Search**

The advanced search provides flexibility in the degree of complexity and specificity of a search.

See the following sections for details:

- Advanced Search Page Layout on page 29
- Advanced Search Conditions on page 29
- Field Element Selection on page 30
- Nested Search Conditions on page 31
- Operators on page 32
- Value Field on page 32
**Advanced Search Page Layout**

The Advanced Search page opens following most searches conducted from a Quick Search box (also from the **Search for Objects** link of the Data Management module).

The page consists of a top portion, where users can hone their search conditions, set sort preferences for results, and specify columns for display in the results (and to Excel), and a bottom portion, where results are displayed.

![Advanced Search Page](image)

Figure 5: Advanced Search Page

Options for searching, saving, exporting, and displaying results are discussed below.

**Advanced Search Conditions**

For each condition of a search, a row with the field element name, an operator selection, and a value (either text-based or drop-down-list based) appear. To add a row parallel to the existing one, click the green circle button with the plus
sign. To add a nested row, click the button with the upper plus sign and lower brackets. To delete a row, click the red circle button with the minus sign.

To set the relationship between the rows, select **Any** (Boolean OR) or **All** (Boolean AND) from the **Match** drop-down menu.

**Field Element Selection**

Users can select an element on which to search by clicking the icon to the right of the first text field. A complete list of available search fields opens. (See **Figure 6**.)

Alternatively, users can type a search field name directly in the textbox, and the system will suggest matches in a drop-down list. Matches contain the same string as the user types but they do not necessarily begin with the same letters, as shown in **Figure 7, Auto-fill Element Field**. The user can continue typing or select a match from the dynamic list.
Nested Search Conditions

Users can implement nested search conditions. For each block in the nested search, the user defines (using the All or Any UI operator) whether all the conditions in that block must be true (equivalent to the SQL AND operand) or whether, of the different search conditions, only one (or more) must be true (equivalent to the SQL OR operand). The number of nested blocks is limited to five. The operand between two (or more) rows in the same block is always AND.
Operators

Operators are determined by their elements. The following are the most common operators.

- **Equals**: exact match on word or phrase in value field (alternate: **Not Equals**)
- **<**: less/earlier/older than the date in the value field (variants: **Before** and **<=** for less than or equal to)
- **>**: greater/later/more recent than the date in the value field (variants: **After** and **>=** for greater than or equal to)
- **Contains**: all of the items in the value field are present but in no particular order (variants: **Contains Keyword** and **Contains Phrase**)
- **Does not contain** (variants: keywords, phrase): Contains none of the terms in the value field.
- **Starts With**: result begins with item(s) in the value field
- **IsEmpty**: field is empty.
- **IsNotEmpty**: field is not empty.

For more information about options you can use to make your search more precise, see **Value Field** on page 32.

Value Field

To the right of each operator drop-down list is a field for entering the value that restricts your search. The type of data that you enter in the value field is determined by the conditions you selected. Date selections, for example, produce date entries and/or drop-down calendars in the value field.

To make your search more precise, you can use the following features when defining a value in the **Value** field:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cross-Object Query</td>
<td>Search for one type of object using query criteria from another type. For example, you can search for IEs that have PDF files.</td>
</tr>
</tbody>
</table>
Search Results Features and Options

Rosetta provides several options for viewing information in the Results area of the Search page:

- **List or Thumbnail View** on page 33
- **Sort By** on page 34
- **Column Display** on page 35
- **Facets** on page 38
- **Export to Excel** on page 42

**List or Thumbnail View**

Search results can be viewed as a detailed list or as thumbnails:

**Table 4. Features to Improve Search Results**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| Wildcard | Use the following wildcard characters when the value is text and you want to define a pattern:  
  - * - Use this wildcard character at the end of a value. For example, Dan* finds all matches that start with Dan (Daniel, Danzig, danish, etc.)  
  Note: This wildcard must follow a minimum of three characters.  
  - ? - Use this wildcard character as a placeholder for a single character. You can use it as many times as you want, in an adjacent string or between alternating characters.  
    For example, b??n finds all matches that have a b as the first character and an n as the fourth character (born, boon, barn, etc.) |
Sort By

All single-value elements can be configured as sortable. Four sorts can be configured in order of priority. Once an element has been selected for sorting, it no longer appears in the list of available elements.

**NOTE:**

If more than one instance of an element occurs in a single record (for example, two Creators, A and B), Rosetta uses only the first value (A) for the sort on Creator. (Both A and B are used in a search of the Creator element, but the results are sortable by A only.)

Users enter the elements and their sort priority on the **Sort** tab of the Search page (see **Figure 10**).
To choose an element, users type the beginning of the element into the **Sort By** field, then select the full element name from the auto-complete drop-down list that opens. All elements, whether visible in the Results pane or not, are available for sorting.

Users can select ascending or descending order for each element.

Clicking the **Apply Sort** button sorts the results in the priority and order specified in the top portion of the page.

**Column Display**

Because all AIP elements are indexed and searchable, the Search Results page can be configured to display any of the elements. By default, the following elements are displayed in the search results according to the object type of the search:

For **IEs** and representations:

- Title
- Type
- PID
- SIP ID
- Producer
To change the items displayed in the search results table:

1. Click the Columns tab at the top of the page.
   Two boxes open in the top section of the page. The box on the left lists items currently displaying in the search results. The box on the right contains a text field and lists all items that are available.

2. Delete any items you don’t want to view in the left box by clicking the minus sign next to the element.
   The element moves to the right-side box and will not display as a column in the results.

3. To add an element for display, type the first few letters of the element in the text field of the box on the right.
The system auto-completes with matches in the rows below the text box.

4 Click the plus sign beside any element you want to add to the list.
   The element moves from the right-side box to the left-side box, indicating that it will be displayed as a column in the results.

5 Repeat moving elements from left to right and right to left until all the elements you want to display as columns appear in the left box, and any items you don’t want to display do not appear in the left column.

6 Click the **Apply Columns** button to view your search results with the custom elements displayed. (To return to the default list of columns, click the **Restore to Default** button.)

   When the page refreshes, your new columns display information from the objects returned in your search.
Facets

Search results can be grouped and filtered using facets, which are attributes of items returned in a search. Facets allow you to narrow results according to shared characteristics of records.

When a search returns too many results, use the facets feature in the left column of the page (Figure 12).

![Figure 12: Facets on the Search Results Page](image)

When you click the down arrow in the Refine Results box, available facets appear in a drop-down list (Figure 13).
For every facet selected, Rosetta returns a list of values and the number of returned items that share that value (Figure 14).
The Refine Results attributes (for example, Event Identifier Value in Figure 14) display up to five values with an option to See All. The numbers in parentheses indicate how many records match that attribute value. To show only those records matching a specific value, click the check box for that value. The page reloads showing only those items from the facet you selected (see Figure 15).

![Figure 15: Facet 27 Selected](image)

For a facet with more than five values, the five values with the most records display in the Refine Results column under that facet’s heading. To see all of the facet’s values, or to select more than one value to be returned from the group, click See All and select the values from the light box (Figure 16).
Chapter 3: Searching and Reporting For All Staff

Figure 16: Facets “See All” Lightbox

Each search results page can have no more than four facets at one time. To remove a facet from your results, click the red circle with the minus sign beside the facet name. To remove all facets from your search results, click the Clean Facets button.

**NOTE:**
The list of available attributes is currently fixed and cannot be customized.

**Actions**

Users can click any of the action-oriented text links in the row of the item they want to work with.

Clicking **View** delivers the object using delivery rules, simulating an end-user’s delivery request.

Clicking **METS Viewer** makes the system open the General IE Viewer using the default representation profile without going through the rules.

Clicking **Info** opens the object in the Web editor.

Clicking **Export** generates an export process and prompts the user for the export path and other export task-related parameters.

**NOTE:**
If the enforce_ar_export general parameter is set to true, Access Rights will be enforced during export. Certain representations, or the entire IE, may not be exported, in accordance with the IE/REP AR policies.
Export to Excel

Users can export search results into Excel by clicking the export to Excel icon at the top of the Results section. The page reloads with a text message at the top of the page:

Your IE will be exported to "/exlibris/dps/d4_1/profile/operational_shared/staff_work_area/admin1/export/queries/QueryList<date and time>.csv". This process will complete shortly.

In addition to downloading the file to the server, you can click Download to download the excel locally.

The exported Excel spreadsheet includes the same columns and information that appear on the UI. This information is configurable (see Column Display on page 35).

Running and Viewing Reports

Staff users can run reports needed by their various positions and roles. Every module in the system has a list of available reports accessed by clicking a link from the module's main page.

NOTE:
Rosetta uses BIRT for its reporting. To view reports within Rosetta, users should have Office 2003 or higher installed on their machines. If they do not, reports will appear in XML format.

This topic includes:
- Accessing Reports on page 42
- Running a Report: Uploads on page 43
- Scheduling Reports on page 44

Accessing Reports

On the main menus for Producers, Submissions, and Data Management, there is an Advanced Tools heading and, below it, a Run Reports link that takes the user to a page of predefined reports related to the module. Staff users can also access reports through specific related areas on the interface, such as by following the path Producers > Manage Producers > List of Producers and clicking the History link for the Producer Agent whose uploads they want to view.

Rosetta integrates its reporting capabilities with those of the Business Intelligence and Reporting Tools project (BIRT). When users select a report to view, Rosetta opens a new window that is populated with the BIRT Report
Viewer interface and the contents of the report. Users can print, export, or re-run the report from this page.

**Running a Report: Uploads**

To run a report on the upload activity of depositors, click through the Submissions menu to the Advanced Tools/Run Reports link to open the list of available reports.

**NOTE:**

You can also access this report from the following paths: List of Producers > History > Uploads Report or Administration Home > Monitoring and Reports > Submissions > Uploads Report.

From the list of reports page, click **Uploads Report**. A form opens in the BIRT interface with fields for entering parameters for the report.

The following table describes each field in the Uploads report and how it is used.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>The date the reporting period starts. This is required.</td>
</tr>
<tr>
<td>End Date</td>
<td>The date the reporting period ends. This is required.</td>
</tr>
<tr>
<td>Producer Name (not pictured)</td>
<td>The Producer name. This field will be a drop-down menu that lists all existing Producers.</td>
</tr>
<tr>
<td>Producer ID</td>
<td>The Producer ID. This parameter is optional. By default, the report is generated for all Producers.</td>
</tr>
<tr>
<td>Deposit activity ID</td>
<td>The ID of one deposit activity. This field is optional. By default, the report will be generated for all the deposit activities in the period.</td>
</tr>
<tr>
<td>SIP ID</td>
<td>The ID of one SIP. This field is optional. By default, the report will be generated for all the SIPs that were deposited within the report period.</td>
</tr>
</tbody>
</table>

After you enter parameters and run the report, BIRT displays the report results.

The report contains two sections:

1. The Summary Information section includes the total number of deposit activities and the number that succeeded (were moved to the permanent repository), how many are still being processed, and how many failed.

2. The detail of deposits will be headed by the current reporting period. For each deposit activity, the list includes the date and time of the deposit
activity, the deposit activity ID, SIP reference ID, name of the Depositor, name of the Producer, and status of the deposit activity.

Possible status values are "Draft," "Submitted," "Rejected," "Declined," and "Approved." A deposit that has been partially approved and partially declined will have status Approved. A deposit that has been partially rejected will have the status Rejected.

If the status of a deposit activity is Rejected or Declined, the reason will be displayed adjacent to the status.

**Scheduling Reports**

You can schedule a job to email reports. This job is available under each lobby for the reports of that lobby.

**NOTE:** Reports with parameters are not supported.

**Managing Scheduling Report Jobs**

The Manage Scheduled Jobs page enables you to schedule report jobs. To access this page, follow the Rosetta drop-down menu path from any lobby, for example: **Producers > Advanced Tools > Schedule Reports.**

The Manage Scheduled Jobs page opens to existing scheduled report jobs:

![Figure 17: Manage Scheduled Jobs (Scheduled Report Jobs List)](image)

This page enables you to monitor the status of each scheduled report job and perform the following tasks:

- **Add a new job** – For more information, see Adding a Scheduled Report Job on page 46.
- **View a job’s details** – Click the View link next to the job you want to view.
- **Modify a job** – For more information, see *Modifying a Scheduled Report Job* on page 48.

- **Execute a job** – Click the Run Now link to run a job manually.

In addition, you can cancel a job. For more information, see *Cancelling a Scheduled Report Job* on page 49.
Adding a Scheduled Report Job

This task allows you to create a new scheduled report job.

To add a Scheduled Report job:

1. Click the Add job button on the Manage Scheduled Jobs page.
   The Job Details page opens.

2. Enter a name for the scheduled Report job in the Name field.

3. Select the interval at which to execute the job: Hourly, Daily, Weekly, Monthly, and Advanced.
4 To configure hourly, daily, weekly, and monthly intervals:
   a Use the following table to configure the common interval fields:

   **Table 6. Common Interval Fields**

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Time</td>
<td>Select the hour and minutes from the drop-down fields to specify the time at which to run the job.</td>
</tr>
<tr>
<td></td>
<td>Date</td>
<td>Use the calendar tool or select the month, day, and year from the drop-down fields to select the date at which to start running the job.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Indefinitely</td>
<td>Select this option to run the job indefinitely.</td>
</tr>
<tr>
<td></td>
<td>Until</td>
<td>Select the month, day, and year from the drop-down fields to specify the date at which to stop running the job.</td>
</tr>
</tbody>
</table>

   **NOTE:** After this date, the state of the job will change from Normal to Not Running.

   b Use the following table to configure the interval-specific fields:

   **Table 7. Interval-Specific Fields**

<table>
<thead>
<tr>
<th>Type of Interval</th>
<th>Perform this task:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly</td>
<td>Every</td>
<td>Select the hourly interval from the Hours drop-down field.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Week days</td>
<td>Select which days of the week to run this job.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Monthly At</td>
<td>Select the day of the month to run this job.</td>
</tr>
</tbody>
</table>

   For information on how to configure advanced intervals, see **Configuring Advanced Job Schedules** on page 252.

5 Complete the required fields in the **Job Parameters** pane.

6 Click the **Apply** button to add the job to the list of scheduled report jobs.
Modifying a Scheduled Report Job

This task allows you to modify the details for an existing scheduled report job.

To modify a Scheduled Report job:

1. On the Manage Scheduled Jobs page, click the Edit link next to the job that you want to modify.
   The Job Details page opens.

2. Select the interval at which to execute the job: Hourly, Daily, Weekly, Monthly, and Advanced.

3. To configure hourly, daily, weekly, and monthly intervals:
a  Use the following table to configure the common interval fields:

Table 8. Common Interval Fields

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start At</td>
<td>Time</td>
<td>Select the hour and minutes from the drop-down fields to specify the time at which to run the job.</td>
</tr>
<tr>
<td></td>
<td>Date</td>
<td>Use the calendar tool or select the month, day, and year from the drop-down fields to select the date at which to start running the job.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Indefinitely</td>
<td>Select this option to run the job indefinitely.</td>
</tr>
<tr>
<td></td>
<td>Until</td>
<td>Select the month, day, and year from the drop-down fields to specify the date at which to stop running the job.</td>
</tr>
</tbody>
</table>

**NOTE:**
After this date, the state of the job will change from Normal to Not Running.

b  Use the following table to configure the interval-specific fields:

Table 9. Interval-Specific Fields

<table>
<thead>
<tr>
<th>Type of Interval</th>
<th>Perform this task:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly</td>
<td>Every</td>
<td>Select the hourly interval from the Hours drop-down field.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Week days</td>
<td>Select which days of the week to run this job.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Monthly At</td>
<td>Select the day of the month to run this job.</td>
</tr>
</tbody>
</table>

For information on how to configure advanced intervals, see Configuring Advanced Job Schedules on page 252.

4  Complete the required fields in the Job Parameters pane.

5  Click the Apply button to add the job to the list of scheduled report jobs.

**Cancelling a Scheduled Report Job**

Cancelling a job allows you to postpone the execution of job indefinitely without deleting it from the system.

**NOTE:**
The Unschedule option will not be available when the state of the job is Not Running.
To cancel a Scheduled Report job:

1. On the Manage Scheduled Jobs page, click the **Edit** link next to the job that you want to modify.
   
   The Job Details page opens.

2. Click the **Unschedule** button.

   The state of the job should change to **Not Running**.

---

**Reports Available in Rosetta**

Additional reports available in Rosetta may not be set up in your system. The full list includes the following:

- **ALTERNATIVES_EVALUATION** on page 52
- **APPLIBRARY** on page 52
- **APPLICATION_LIBRARY_EVENTS** on page 52
- **AUTO_EVALUATION** on page 52
- **AUTO_EVALUATION_PER_REP** on page 52
- **BIRT_GENERAL_PARAMETERS** on page 52
- **BITSTREAM_VIEW** on page 52
- **CLASSIFICATION_LIBRARY_EVENTS** on page 52
- **CLASSIFICATIONPROPERTY** on page 52
- **COMMTS_TO_PERMANENT_BY_TYPE** on page 52
- **DELETED_IEs** on page 53
- **DEPOSIT_ACTIVITIES_PER_MF** on page 53
- **DEPOSIT_ACTIVITIES_PER_MT** on page 53
- **DEPOSIT_ACTIVITY_EVENTS** on page 53
- **DEPOSIT_ACTIVITY_HISTORY** on page 53
- **EVALUATION_RESULTS** on page 53
- **EVENT_KEYS** on page 53
- **EVENT_STATISTICS** on page 53
- **EVENTS** on page 53
- **EXTRACTOR_LIBRARY_EVENTS** on page 53
- **FILE_TYPE_GROUPS_IN_PERMANENT** on page 53
- **FORMATAPPLICATIONS** on page 54
Chapter 3: Searching and Reporting For All Staff

FORMATS_BREAKDOWN on page 54
FORMATS_PER_CLASSIFICATION_GROUP on page 54
FORMATLIBRARY on page 54
FORMAT_LIBRARY_EVENTS on page 54
FORMATRISKS on page 54
HOMEPAGE_DASHBOARD on page 54
IE_EVENTS on page 55
IES_BY_SIP_ID on page 55
IES_PERMANENT_LIST on page 55
IES_TO_BE__DELETED on page 55
INTELLECTUAL_ENTITIES_DELIVERED on page 55
MANUAL_EVALUATION on page 55
MATERIAL_FLOW_LIST on page 56
METADATA_FORM_LIST on page 56
MOST_VIEWED_OBJECTS on page 56
NEW_MONOGRAPHS_IN_PERMANENT on page 56
NEW_PERIODICALS_IN_PERMANENT on page 56
PERMANENT_INDEX on page 56
PROCESS_EXECUTION_HISTORY on page 56
PRODUCER_DEPOSITS on page 56
PRODUCER_GROUP_DEPOSITS on page 56
PRODUCER_PROFILES_LIST on page 56
PRODUCERS_LIST on page 56
REPOSITORY_STATS_A on page 57
REPOSITORY_STATS_B on page 57
REPOSITORY_STATS_C on page 57
REPOSITORY_STATS_D on page 57
RISKLIBRARY on page 57
SIP_PROCESSING_STATS_PIE on page 57
SIPS_STATS on page 57
SUBMISSION_JOB_DETAILS on page 57
TOTAL_PRODUCER_GROUP_DEPOSITS on page 57
EX EbIRs DeCfRINt on page 57

**ALTERNATIVES_EVALUATION**
Description: The list of Preservation evaluations with plan ID and alternative ID.

**APPLIBRARY**
Description: Application Library information (prsv00.HPRAPPLIBRARY).

**APPLICATION_LIBRARY_EVENTS**
Description: All events related to the Application Library.

**AUTO_EVALUATION**
Description: The results of the automatic evaluations.

**AUTO_EVALUATION_PER_REP**
Description: The results of the automatic evaluations per representation.

**BIRT_GENERAL_PARAMETERS**
Description: All BIRT general parameters.

**BITSTREAM_VIEW**
Description: The BitStream information (rep00.HDEBITSTREAMREF) that allows the viewer to run reports based on this information.

**CLASSIFICATION_LIBRARY_EVENTS**
Description: All the events related to the Classification Library.

**CLASSIFICATIONPROPERTY**
Description: The classification group’s significant mapping properties (including mapping to F fields) (prsv00.HPRCLASSIFICATIONPROPERTY).

**COMMITS_TO_PERMANENT_BY_TYPE**
Description: The number of commits to the permanent repository by object type.
DELETED_IEs
Description: Lists all IEs that have been deleted or purged within a given time frame.

DEPOSIT_ACTIVITIES_PER_MF
Description: The amount of deposit activities per material flow.

DEPOSIT_ACTIVITIES_PER_MT
Description: The number of deposit activities per material type.

DEPOSIT_ACTIVITY_EVENTS
Description: All the events for each deposit activity.

DEPOSIT_ACTIVITY_HISTORY
Description: All the deposits so far with minimal information.

EVALUATION_RESULTS
Description: The evaluation results.

EVENT_KEYS
Description: The keys for the events stored in the EVENTS view.

EVENT_STATISTICS
Description: The statistical information gathered by the statistical analyzer for the events as listed in the events spreadsheet.

EVENTS
Description: All the events in the system.

EXTRACTOR_LIBRARY_EVENTS
Description: Events related to the Extractor Library.

FILE_TYPE_GROUPS_IN_PERMANENT
Description: The types of the various files with quantities and percentage.
FILES_IGNORED - FILE_EXTENSION_MISMATCH
Description: Number of files per format ID that were ignored by the File Extension Mismatch rule.

FILES_IGNORED - MD_ERROR
Description: Number of files per format ID that were ignored by the MD Error rule.

FORMATAPPLICATIONS
Description: The Format/Application connection (prsv00.HPRFORMATAPPLICATIONS).

FORMATS_BREAKDOWN
Description: List of file formats and their occurrence throughout the repository.

NOTE:
Refreshed every 12 hours.

FORMATS_PER_CLASSIFICATION_GROUP
Description: The association of a format to a classification group

NOTE:
Refreshed every 12 hours.

FORMATLIBRARY
Description: Format Library information (prsv00.FORMATLIBRARY).

FORMAT_LIBRARY_EVENTS
Description: Events related to Format Library.

FORMATRISKS
Description: Risks per format.

HOMEPAGE_DASHBOARD
Description: The information presented to the user on the home page:
- SIPs Having Technical Issues
Chapter 3: Searching and Reporting For All Staff

- SIPs Waiting For Approval
- SIPs Waiting For Arrangement
- SIPs Waiting For Assessment
- Deposit Activities
- Files In Permanent
- Active Producers

**IE_EVENTS**
Description: Events for an individual intellectual entity. Parameter = IE ID.

**IES_BY_SIP_ID**
Description: The intellectual entities for a given SIP.

**IES_PERMANENT_LIST**
Description: The list of IEs with their URLs in the permanent repository.

**IES_TO_BE__DELETED**
Description: All IEs that are about to be deleted in a given time frame due to retention policies.

**INTELLECTUAL_ENTITIES_DELIVERED**
Description: Lists key details about access to each digital object:
- PID
- Title
- End user ID accessing the object
- Date and time of access
- End user ID accessing the object (guest for users that are not logged in)

**NOTE:**
There are two versions of this report. One contains user details, but is hidden in Rosetta unless configured in the BIRT report mapping table to appear, and the other is anonymized.

**MANUAL_EVALUATION**
Description: The manual evaluation results.
**MATERIAL_FLOW_LIST**
Description: A list of the material flows currently defined in the system.

**METADATA_FORM_LIST**
Description: The metadata forms available in the system.

**MOST_VIEWED_OBJECTS**
Description: A list of viewed objects ordered by the number of views.

**NEW_MONOGRAPHS_IN_PERMANENT**
Description: Monographs (material type = ‘MON’).

**NEW_PERIODICALS_IN_PERMANENT**
Description: Periodicals (material type = ‘PRD’).

**PERMANENT_INDEX**
Description: The permanent index table which lists all objects stored in the permanent repository.

**PROCESS_EXECUTION_HISTORY**
Description: The history of all the existing processes in the system with their statuses.

**PRODUCER_DEPOSITS**
Description: All the deposits performed so far.

**PRODUCER_GROUP_DEPOSITS**
Description: All the deposits with a field showing to which Producer group the Depositor belongs.

**PRODUCER_PROFILES_LIST**
Description: All existing Producer profiles.

**PRODUCERS_LIST**
Description: All the Producers currently in the system.
**REPOSITORY_STATS_A**
Description: The number of files for groups of different sizes.

**REPOSITORY_STATS_B**
Description: The list of MIME types and the number of files in each type.

**REPOSITORY_STATS_C**
Description: Information regarding quantities in the system.

**REPOSITORY_STATS_D**
Description: Shows numbers regarding the permanent preservation.

**RISKLIBRARY**
Description: The risks library (prsv00.HPRRISKLIBRARY).

**SIP_PROCESSING_STATS_PIE**
Description: The number of SIPs in each SIP processing stage.

**SIPS_STATS**
Description: All the SIPs currently in the system. This is used for the report SIPs - Status and Events. The report shows the totals and the details for each stage in the system.

**SUBMISSION_JOB_DETAILS**
Description: No OOTB report (view only). Contains submission job details including the load directory, generated SIPs and their respective statuses.

**TOTAL_PRODUCER_GROUP_DEPOSITS**
Description: The counts of deposits for each Producer group.

**USER_DETAILS**
Description: Information about the user, roles, and roles parameters currently in the system.
Submission Information Package (SIP) Overview

This section contains:
- Understanding SIP Statuses and Stages on page 59
- System Reports on page 62
- SIP Processing Flow on page 65

Understanding SIP Statuses and Stages

A SIP’s status and stage define its orientation in the SIP Processing workflow.
- Status determines where in the Rosetta interface the SIP can be found and which actions can be carried out on the SIP.
- Stage defines the node that the SIP has completed.

NOTE:
Stage is relevant only while the SIP is in the Repository module. There are no different stages for a SIP in the Deposit module or in the Permanent module (AIP).
The following table describes the different stages and statuses of a SIP:

<table>
<thead>
<tr>
<th>Module</th>
<th>Stage</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deposit</td>
<td>-</td>
<td>Draft</td>
<td>The SIP has been created by a Producer Agent but has not yet been submitted. (The Producer Agent has clicked Save in the Deposit workflow.)</td>
</tr>
<tr>
<td>-</td>
<td>Declined</td>
<td></td>
<td>The SIP has been declined by the system, Technical Analyst, Assessor, Arranger, or Approver, and the Producer Agent cannot re-submit it.</td>
</tr>
<tr>
<td>-</td>
<td>Rejected</td>
<td></td>
<td>The SIP has been rejected by the system, Technical Analyst, Assessor, Arranger, or Approver, and the Producer Agent can re-submit it.</td>
</tr>
<tr>
<td>-</td>
<td>Created</td>
<td></td>
<td>The SIP has been submitted by the Producer Agent and is waiting for loading into the Repository module.</td>
</tr>
</tbody>
</table>
The SIP has failed in one of the following system stages in the Repository module and is waiting to be handled manually by the Technical Analyst:

1. Loading
2. Validation Stack:
   - Virus Check
   - Format Identification
   - Technical Metadata Extraction
   - Fixity
   - Risk Extraction
3. Bytestream
4. Enrichment
5. To permanent

<table>
<thead>
<tr>
<th>Module</th>
<th>Stage</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
</table>
| Repository  | Error Stage (Loading, Validation etc.) | In Technical Analyst | The SIP has failed in one of the following system stages in the Repository module and is waiting to be handled manually by the Technical Analyst:  
   1. Loading  
   2. Validation Stack:  
      - Virus Check  
      - Format Identification  
      - Technical Metadata Extraction  
      - Fixity  
      - Risk Extraction  
   3. Bytestream  
   4. Enrichment  
   5. To permanent |
| Loading     | Active                      |            | The system has completed loading the SIP from the Deposit into the Repository stage.                                                        |
| Validation Stack | Active                |            | The system has completed validating the SIP through the Validation Stack.                                                                   |
| Bytestream  | Active                      |            | The system has completed extracting bytestream(s) from the files. (Performed only when there are container files such as ZIP files or multiple images.) |
| Enrichment  | Active                      |            | The system has completed enriching the SIP with access copies (according to rules) and/or with descriptive metadata from external systems. |
| To Permanent| Active                      |            | The system has finished loading the SIP into the permanent repository.                                                                       |
| Assessor    | In Human Stage              |            | The SIP is in the Assessor work area waiting for user actions.                                                                            |
| Arranger    | In Human Stage              |            | The SIP is in the Arranger work area waiting for user actions.                                                                             |
| Approver    | In Human Stage              |            | The SIP is in the Approver work area waiting for user actions.                                                                            |
On the Management homepage dashboard, SIPs In Process refer to SIPs that have all the following characteristics:

- have not reached the permanent repository
- have not been rejected/declined
- are not waiting in a work area.

### System Reports

All SIP stages and statuses are kept in the database for reporting and tracking purposes. Two system reports can be used to get this information:

- **SIPs Dashboard**
- **Find a SIP** (by SIP ID or by Deposit Activity ID)

### SIPs Dashboard

Available from **Home > Submissions > Run Reports > SIPs Dashboard.**

<table>
<thead>
<tr>
<th>Module</th>
<th>Stage</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permanent</td>
<td>-</td>
<td>Finished</td>
<td>The SIP is in the Permanent repository (AIP).</td>
</tr>
</tbody>
</table>
The SIP dashboard displays summary information about SIPs by module. Information includes the number of SIPs in various stages and statuses.

**Find a SIP**

Available from **Submissions > Advanced Tools > Run Reports**, the Reports List page allows you to view reports for SIPS based on SIP ID or deposit activity ID (see **Submissions Reports List Page** on page 64).
From the Reports List page, click **Find a SIP by SIP ID** to return a report of a specific SIP. To return a report by deposit activity ID, click **Find a SIP by Deposit Activity ID**. Enter the SIP ID or the deposit activity ID into the Parameters field, and Rosetta returns the report on the Detail Report page (SIP Detail Report on page 65)
The SIP detail report provides general information about SIP module, status, and stage. The report also displays data about the SIP’s files, structure, content, and history, among other things.

**SIP Processing Flow**

The following diagram illustrates the different statuses and stages of a SIP and the applicable transitions between them during SIP Processing:
Figure 23: SIP Process Flow Diagram

NOTE:
The stage is updated after a process has been completed, so a SIP in the “Loading” stage has actually completed loading and is waiting for the validation stack.
Part II
Deposit Managers

This part contains the following sections:

- Section 5: Understanding Deposit Managers on page 69
- Section 6: Configuring Deposit Control Settings on page 71
- Section 7: Configuring Metadata Forms on page 73
- Section 8: Configuring Material Flow Infrastructure on page 85
- Section 9: Access Rights on page 127
- Section 10: Retention Policies on page 147
- Section 11: Managing Generic Material Flows on page 155
- Section 12: Managing Generic Producer Profiles on page 165
- Section 13: Managing Material Flows Associated with a Producer Profile on page 171
- Section 14: SIP Processing, Configuration, and Routing Rules on page 177
- Section 15: OAI-PMH Harvester on page 197
Understanding Deposit Managers

Deposit Managers are responsible for configuring generic Producer profiles and generic material flows. (For more information on Producer profiles and material flows, see the Rosetta Overview Guide.)

Deposit Managers accomplish their tasks by managing the following components:

- Producer profile’s deposit control settings (For more information, see Configuring Deposit Control Settings on page 71.)
- Metadata forms (For more information, see Configuring Metadata Forms on page 73.)
- Material flow infrastructure (For more information, see Configuring Material Flow Infrastructure on page 85.)
- Generic material flows (For more information, see Managing Generic Material Flows on page 155.)
- Generic Producer profiles (For more information, see Managing Generic Producer Profiles on page 165.)
- Material flows associated with a Producer profile (For more information, see Managing Material Flows Associated with a Producer Profile on page 171.)

Generic Producer profiles and material flows are automatically assigned to all Producers when they register in the Rosetta system. The profiles can be personalized at a later point in time by a Negotiator in order to meet the needs of specific Producers. (For more information on Negotiators, see Understanding Negotiators on page 207.)

Deposit Managers are assigned by a User Manager, who registers them and defines their access. Privileges can be either Typical (without delete privileges) or Full (with edit and delete privileges).

Deposit Managers’ scope is institutional.
Configuring Deposit Control Settings

Deposit Managers can configure deposit control settings for generic Producer profiles. These settings include the following parameters:

- The Producer’s deposit quotas
- The amount of content to be reviewed by staff users

To configure deposit control settings:

2. Under Deposit Arrangements, click Manage Producer Profiles. The List of Producer Profiles is displayed.
3. Locate the Producer profile with which you want to work and click Update. The Update Producer Profile page opens.
4. In the Name field, enter the name of the Producer profile.

Figure 24: Update Producer Profile Page
5 In the **Status** drop-down list, select one of the following:
- **Active**, when you want to begin using the profile immediately (for example, to associate the profile with a Producer and allow Producer Agents to deposit content)
- **Inactive**, when you want to complete profile configuration and begin using the profile later

6 In the **Active Deposit Quotas** (GB) field, enter the number of gigabytes that the producer can deposit simultaneously. Set to 0 for no limit.

7 In the **Fast Track Enabled** drop-down list, select **No**.

8 In the **Disk Usage Quota** field, enter the total disk space that is available to Producer Agents associated with the Producer.

9 In the **Default Sampling Rate** field, enter the percentage of the Producer Agent’s content that needs to be reviewed by staff users as follows:
- 100% - All deposited content must be reviewed by Assessors and Arrangers.
- Any value less than 100% - The specified percentage of content must be reviewed by an Approver.

**NOTES:**
- Sampling rates for specific Producers are defined by a Negotiator. For more information, see *Personalizing Producer Profiles* on page 225.
- This value takes effect only if the sampling rate on the material flow is not set and the SIP processing rule approval is set to Approver.

10 Click **Save**.
Producer Agents associated with the Producer can deposit content as specified in the deposit control settings.
About Configuring Metadata Forms

Deposit Managers configure metadata forms as one of the main components of a material flow.

After these forms are configured, a Deposit Manager can use them in a material flow in combination with additional components (such as submission formats and access rights policies). Each form or component can be associated with multiple material flows. (See Configuring Material Flow Infrastructure on page 85)

Metadata forms contain fields that Producer Agents must complete when depositing content.

Deposit Managers work with metadata forms using the List of Metadata Forms page (see Accessing the List of Metadata Forms Page on page 74). The following activities can be performed from this page:

- Adding a Metadata Form on page 75
- Previewing a Metadata Form on page 82
- Duplicating a Metadata Form on page 82
- Viewing Material Flows Associated with the Metadata Form on page 84
- Updating a Metadata Form on page 83
Accessing the List of Metadata Forms Page

The List of Metadata Forms page enables Deposit Managers to view the existing metadata forms and create new metadata forms.

To access the List of Metadata Forms page, from the Rosetta drop-down menu, click Producers > Advanced Tools > Metadata Form.

The List of Metadata Forms page opens (Figure 25).

![List of Metadata Forms Page](image)

Figure 25: List of Metadata Forms Page

The List of Metadata Forms page displays columns containing the following information:

Table 11. List of Metadata Forms Page Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the metadata form</td>
</tr>
</tbody>
</table>
Adding a Metadata Form

Deposit Managers can add a metadata form to provide Producer Agents with fields that they use to describe their content.

**To add a metadata form:**

1. On the List of Metadata Forms page (Producers > Advanced Tools > Metadata Forms), above the list of the metadata forms, click the Add Metadata Form button.

   The Metadata Form Details page opens to the Design Information tab (Figure 26).
2 In the **Name** field, enter a name (required) for the metadata form. Enter additional optional information on the **Design Information** tab.

3 When you are finished, click the **Fields Information** tab.

The page refreshes with a fields/properties table for entering new elements. No fields appear yet in the left column.
4 Enter information for the new field in the form on the right. (Required fields are marked with an asterisk.)

**NOTES:**

- **Field Name** is for system use and is not displayed to Producer Agents.
- The **Label** field displays on the Producer Agent’s form. To see the form as an Agent sees it, click the **Preview** button.
- The DC Tag drop-down list contains the Dublin Core and DNX tags. Select the tag that corresponds to each label.

5 Click **Save Field**. The field label is displayed in the list of existing fields on the left.

**NOTE:**

You can edit an existing field at any time by clicking the field label in the list of fields on the left.

6 Click **Save Form**. The metadata form is saved to the Rosetta system.

7 Repeat steps 4-5 to add more fields, as needed.

The metadata form is created.
To enable Producer Agents to use the form, Deposit Managers must associate the metadata form with a material flow (see Associating Material Flow Components with Material Flows on page 125).

**Adding Lists of Values to Metadata Forms**

When a metadata form field requires a list of several predefined values for the user to select from, Deposit Managers can load these values from an Excel spreadsheet rather than entering them individually.

**NOTES:**

- Loading these values from Excel spreadsheets is only possible for subsystems in which creating new tables is allowed.
- The Excel spreadsheet must be formatted as two columns with the left column containing the labels for the drop-down list and the right column containing the code corresponding to each value.
- Before you perform the following procedure, make sure your Excel data references fields of the type radio button, check box, and/or drop-down list where the code table name is locally defined.
To load a list of values from an Excel spreadsheet:

1. If you have not done so already, add a field to your metadata form that requires the drop-down list for which you have an Excel spreadsheet with a formatted list of values (labels and codes).

2. Enter properties for all required fields and any optional fields.

3. For the **Type** field, select **ComboField** from the drop-down menu.

   The page reloads with an additional Options Fields section below the fields section (Figure 29).

4. In the **Code Table Name** field, select **Locally Defined**. This tells the system that you will be loading your own defined values for the drop-down field.

![Figure 29: Metadata Form for New ComboField](image)

5. Click the **Import** button.

   An upload form opens (Figure 30).
6 Browse to the Excel file containing the list of field-value pairs.

7 Click the **Import** button.

   The system loads the data and displays it in a list for you to view and confirm (**Figure 31**).

8 Click the **Import** button if the codes match the values you want and the description contains the name of the value. (Otherwise, click the **Cancel** button and adjust your Excel file.)

   The code table field and values display in the Options Fields section of the Update Form (**Figure 32**).
Figure 32: Drop-Down Values Imported from Excel

NOTE:
Once you have imported Excel data, you will see an Export button beside the Import button. You can use this to download an Excel file and edit values on your PC, then import the file again.

9  Adjust the list as needed by deleting any rows (click the corresponding Delete text) or by adding an option manually (enter text in the Label and Value fields below the list and click the Add New Option button).

10 Click the Preview button to see how the field displays in the final form. Use the Back button to return to editing the page.

11 When the form appears the way you want it, click the Save Form button.

The system implements your edits and returns you to the List of Metadata Forms.

Generic Lists of Values

Predefined lists of values for use in drop-down fields, radio buttons, and check boxes are available to Rosetta metadata forms as generic code tables. These tables can be accessed from the Metadata Forms page.
To use generic code tables for creating multi-value fields:

1. Follow the instructions for adding a list of values to a metadata form's drop-down list. (See Metadata Form for New ComboField on page 79).
2. For the Type field, enter ComboField.
   The page refreshes with the Code Table Name drop-down field available.
3. Select one of the generic code tables from the Code Table Name drop-down menu.
4. Click the Save button.
   The new values are added to the metadata form and made available to the user in the relevant drop-down field.

Working with Metadata Forms

From the List of Metadata Forms, Deposit Managers can perform the following actions:

- Previewing a Metadata Form
- Duplicating a Metadata Form
- Updating a Metadata Form
- Deleting a Metadata Form
- Viewing Material Flows Associated with the Metadata Form

Previewing a Metadata Form

Deposit Managers can preview how the metadata form is displayed to Producer Agents.

To preview a metadata form:

On the List of Metadata Forms page (see Accessing the List of Metadata Forms Page on page 74), locate the metadata form that you want to preview and click Preview. The Preview Metadata Form page opens.

To return to the List of Metadata Forms page, click Save.

Duplicating a Metadata Form

Deposit Managers can duplicate a metadata form. This is especially helpful when creating a new form. It is often faster to duplicate an existing metadata form and modify it than to create a new metadata form.
To duplicate a metadata form:

On the List of Metadata Forms page (see Accessing the List of Metadata Forms Page on page 74), locate the metadata form you want to duplicate and click Duplicate. The Rosetta system creates a copy of the form.

An exact copy of the metadata form is added to the List of Metadata Forms page. The Rosetta system automatically labels the new metadata form with the name Copy of followed by the name of the original metadata form.

Updating a Metadata Form

Deposit Managers can update metadata form details at any time. For example, a Deposit Manager can add new fields or specify a mandatory field.

To update a metadata form:

1. On the List of Metadata Form page (see Accessing the List of Metadata Forms Page on page 74), locate the metadata form that you want to update and click Update. The Update Metadata Form Details page opens.

2. Modify the fields as required.

3. To save your changes and return to the List of Metadata Forms page, click Save. The List of Metadata Forms page opens.

The metadata form details are updated.

Deleting a Metadata Form

A Deposit Manager can delete a metadata form when it is not being used by any Producers and the Deposit Manager does not want to maintain the metadata form.

Deposit Managers cannot delete a metadata form when a Producer Agent is using it to deposit content. Deposit Managers can delete the metadata form only after the deposit process is complete and no other Producer Agent is using the metadata form.

To delete a metadata form:

1. On the List of Metadata Forms page (see Accessing the List of Metadata Forms Page on page 74), locate the metadata form you want to delete and click More. Additional options are displayed.

2. Click Delete. The confirmation page opens.

3. Click OK. The metadata form is removed from the list.

The metadata form is removed from the Rosetta system. Producer Agents can no longer use this metadata form when depositing content.
Viewing Material Flows Associated with the Metadata Form

Deposit Managers can view the material flows that are associated with the metadata form.

To view the material flows:

On the List of Metadata Forms page (see Accessing the List of Metadata Forms Page on page 74), locate the metadata form for which you want to view the material flows and click one of the following:

- The Associated Material Flows link, when multiple material flows are associated with the metadata form.
- The name of the material flow, when a single material flow is associated with the metadata form.


To return to the List of Metadata forms page, click Save.
About Configuring Material Flow Infrastructure

Deposit Managers can configure the following components of a material flow:

- Metadata forms (see previous section, Configuring Metadata Forms on page 73)
- Submission formats (see Configuring Submission Formats on page 86)
- Content structures (see Configuring Content Structures on page 99)
- Copyright boilerplate statements (see Configuring Copyright Boilerplate Statements on page 114)
- Access rights policies (see Access Rights on page 127)
- Retention policies (see Retention Policies on page 147)

After these components are configured, a Deposit Manager can use them in a material flow. Each component can be associated with multiple material flows.

Generic material flow infrastructure configured by a Deposit Manager can be personalized by a Negotiator for the needs of specific Producers (see Personalizing Producer Profiles on page 85).
Configuring Submission Formats

Submission formats govern how Producer Agents upload files and what limitations are applied to these files. Deposit Managers work with submission formats using the List of Submission Formats page (see Accessing the List of Submission Formats Page on page 86). The following activities can be performed using this page:

- Adding an HTTP Load or Bulk Submission Format on page 87
- Adding a Detailed Submission Format on page 89
- Adding an Automated Submission Format for Deposit Through FTP/SFTP on page 92
- Adding an Automated Submission Format for Deposit Through NFS on page 94
- Viewing Submission Format Details on page 97
- Duplicating a Submission Format on page 97
- Viewing Material Flows Associated with a Submission Format on page 98
- Updating a Submission Format on page 98
- Deleting a Submission Format on page 98

Accessing the List of Submission Formats Page

The List of Submission Formats page enables Deposit Managers to view, activate, duplicate, and delete existing submission formats. In addition, Deposit Managers can use this page to add new submission formats.

To access the List of Submission Formats page, follow the Rosetta rollover menu path: Producers > Advanced Tools > Submission Format

The List of Submission Formats page opens (see Figure 33).
Chapter 8: Configuring Material Flow Infrastructure

Adding an HTTP Load or Bulk Submission Format

The HTTP load and bulk submission formats limit the file types as well as the total size and number of files that Producer Agents can upload. (For more information on submission formats, see Configuring Material Flow Infrastructure in the Rosetta Overview Guide.)
To allow Producer Agents to upload one file at a time, Deposit Managers must add one of the HTTP load formats. To allow Producer Agents to perform bulk submissions while applying the same general restrictions, Deposit Managers must add a bulk submission format.

The user interface for configuring the submission format is almost the same for HTTP load and bulk formats.

**To add an HTTP load or bulk submission format:**

1. Access the List of Submission Formats page (see Accessing the List of Submission Formats Page on page 86).
2. Above the submission formats list, in the Add Submission Format dropdown list, select:
   - **HTTP load**, when you want to add a submission format for an individual file
   - **Bulk**, when you want to add a submission format for a multi-file/bulk upload (Aurigma licensed users only)
3. Click **Add**. The Submission Format Editor page opens.

4. Provide the information as requested.

**NOTE:**
Fields marked with an asterisk (*) are required.

5. Provide allowed extensions for your individual, non-bulk files.
In the **File Extensions** list box, select the file extensions of the file types that the Producer Agents are allowed to deposit.

Click the **Right** arrow. The selected extensions moves to the **Selected File Extensions** list.

Repeat a) and b) until you have selected all the extensions you want. (Alternately, to select all extensions, click the double-arrow button between the two boxes.)

To save the submission format and return to the List of Submission Formats page, click **Save**.

The new format is saved in the Rosetta system. It does not have associated material flows. To enable Producer Agents to use the submission format for uploading content, Deposit Managers must associate the submission format with a material flow (see **Associating Material Flow Components with Material Flows** on page 125).

**Adding a Detailed Submission Format**

The detailed submission format specifies the number and type of files that can be uploaded as well as the maximum file size of each file type. (For more information about submission formats, see **Configuring Material Flow Infrastructure** in the *Rosetta Overview Guide*.)

Deposit Managers can add the detailed submission format to apply detailed restrictions on individual files that Producer Agents upload. For example, a Deposit Manager can specify the number of files of each type (by adding one file of a particular type for every file the user should be able to upload of the same type), and limit the size of the file for each addition.

**To add a detailed submission format:**

1. On the List of Submission Formats page (see **Accessing the List of Submission Formats Page** on page 86), in the **Add Submission Format** drop-down list, select **Detailed**.

2. Click **Add**. The Detailed Submission Format Editor page opens.
3 In the **General Information** pane, provide the general information as requested.

4 In the **File Details** pane, click **Add File**. The Add File Details page opens.
5 Enter a **File Descriptor** value and change any of the default values in the other fields.

6 In the **File Extensions** list box, select the file extensions of the file types that the Producer Agents can deposit.

7 Click the **Right** arrow. The selected extensions are displayed in the **Selected File Extensions** list.

**NOTE:**
To select multiple extensions, hold **CTRL** while selecting the extensions.

8 Click **Save**. The Detailed Submission Format Editor page opens.

9 Click **Save** again. The detailed submission format is added to the Rosetta system.

To enable Producer Agents to use the submission format for uploading content, Deposit Managers must associate the submission format with a material flow (see **Associating Material Flow Components with Material Flows** on page 125).
Adding an Automated Submission Format for Deposit Through FTP/SFTP

Deposit Managers can configure an automated submission format to upload files from a predefined location on a Producer Agent’s server to the Rosetta system. The Rosetta system uploads content through FTP/SFTP.

To add an automated submission format for deposit through FTP/SFTP:

1. On the List of Submission Formats page (see Accessing the List of Submission Formats Page on page 86), in the Add Submission Format drop-down list, select FTP or SFTP.
2. Click Add. The Submission Format Editor page opens.

3. Complete the fields as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the submission format.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the submission format.</td>
</tr>
<tr>
<td>Max. number of files</td>
<td>The maximum number of files that associated Producer Agents can deposit.</td>
</tr>
</tbody>
</table>
### Table 13. FTP/SFTP Automated Submission Format Editor Page Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Handling method</td>
<td>Determines whether the files needs to be deleted from the server when the deposit process is finished:</td>
</tr>
<tr>
<td></td>
<td>- <strong>move</strong> - The files are uploaded to the Ex Libris Rosetta system and then deleted from the server.</td>
</tr>
<tr>
<td></td>
<td>- <strong>copy</strong> - the files are uploaded to the Ex Libris Rosetta system and are not deleted from the server.</td>
</tr>
<tr>
<td>User name</td>
<td>The valid user name to access the files.</td>
</tr>
<tr>
<td>Password</td>
<td>The valid password to access the files.</td>
</tr>
<tr>
<td>Max.file size</td>
<td>The maximum file size that associated Producer Agents can deposit.</td>
</tr>
<tr>
<td>Min.number of files</td>
<td>The minimum number of files that associated Producer Agents must deposit.</td>
</tr>
<tr>
<td>Server</td>
<td>The host name of the server on which the files are located.</td>
</tr>
<tr>
<td>Port</td>
<td>The server port to be used to access the files.</td>
</tr>
<tr>
<td>Subdirectory</td>
<td>The location of the files on the server. A forward slash before a given path indicates that the path is absolute, while a path without a leading forward slash indicates that the sub-directory is relative to the FTP user's home directory.</td>
</tr>
</tbody>
</table>

**NOTE:**

If Deposit Managers leave this field empty, the Rosetta system prompts the Producer Agent depositing content for the location.
Click **Save**. The automated submission format is added to the Rosetta system.

To enable Producer Agents to use the submission format for uploading content, Deposit Managers must associate the submission format with a material flow (see **Associating Material Flow Components with Material Flows** on page 125).

### Adding an Automated Submission Format for Deposit Through NFS

Deposit Managers can configure an automated submission format to upload files from a library’s computer to the Rosetta system.

The Rosetta system uploads content through NFS.

**To add an automated submission format for deposit through NFS:**

1. On the List of Submission Formats page (see **Accessing the List of Submission Formats Page** on page 86), in the **Add Submission Format** drop-down list, select **NFS**.

2. Click **Add**. The Submission Format Editor page opens.
3 Complete the fields as described in the following table:

Table 14. The NFS Automated Submission Format Editor Page Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the submission format.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the submission format.</td>
</tr>
<tr>
<td>Handling method</td>
<td>Determines whether the files needs to be deleted from the server when the deposit process is finished:</td>
</tr>
<tr>
<td></td>
<td>- move - The files are uploaded to the Ex Libris Rosetta system and then deleted from the server.</td>
</tr>
<tr>
<td></td>
<td>- copy - the files are uploaded to the Ex Libris Rosetta system and are not deleted from the server.</td>
</tr>
<tr>
<td>NFS Path</td>
<td>The path of the files to be uploaded from a local computer.</td>
</tr>
</tbody>
</table>
Table 14. The NFS Automated Submission Format Editor Page Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sub-directory</td>
<td>The location of the files on the computer.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>If the Deposit Managers leave this field empty, the Rosetta system prompts</td>
</tr>
<tr>
<td></td>
<td>the Producer Agent depositing content for the location.</td>
</tr>
<tr>
<td>Min. Number of files</td>
<td>The minimum number of files that associated Producer Agents must deposit.</td>
</tr>
<tr>
<td>Allow Navigation</td>
<td>Indicates whether the user can navigate to the SIP files located in the</td>
</tr>
<tr>
<td></td>
<td>subfolders of the specified NFS path. The following values are valid:</td>
</tr>
<tr>
<td></td>
<td>- <strong>True</strong> – Navigation to SIP files in subfolders is allowed.</td>
</tr>
<tr>
<td></td>
<td>- <strong>False</strong> – Navigation is not allowed and SIPs only in the NFS path folder</td>
</tr>
<tr>
<td></td>
<td>are available for deposit.</td>
</tr>
<tr>
<td>Absolute/Remote streams</td>
<td>Check this box if mets:FlLocat references (xlink:href) are linked to files</td>
</tr>
<tr>
<td></td>
<td>that are not located under the ./content/streams directory.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>File validation (number, size, extension) will be disabled if this box is</td>
</tr>
<tr>
<td></td>
<td>checked.</td>
</tr>
<tr>
<td>Max. number of files</td>
<td>The maximum number of files that associated Producer Agents can deposit.</td>
</tr>
<tr>
<td>Max. file size (MB)</td>
<td>The maximum file size that associated Producer Agents can deposit.</td>
</tr>
<tr>
<td>File Extensions</td>
<td>The list of available extensions.</td>
</tr>
<tr>
<td>Selected File Extensions</td>
<td>The list of extensions that were selected from the <strong>File Extensions</strong> list</td>
</tr>
<tr>
<td></td>
<td>box.</td>
</tr>
</tbody>
</table>

4 In the **File Extensions** list box, select the file extensions of the file types that the Producer Agents can deposit.
5 Click the Right arrow. The selected extensions are displayed in the Selected File Extensions list.

NOTE: To select multiple extensions, hold CTRL while selecting the extensions.

6 Click Save. The automated submission format is added to the Rosetta system.

To enable Producer Agents to use the submission format for uploading content, Deposit Managers must associate the submission format with a material flow (see Associating Material Flow Components with Material Flows on page 125).

Viewing Submission Format Details

Deposit Managers can view the submission format details, such as the name, description, and settings for files that Producer Agents can upload.

NOTE: Deposit Managers cannot update the details while viewing them.

To view the submission format details:

On the List of Submission Formats page (Producers > Advanced Tools > Submission Format), locate the submission format you want to view and click View. The View Submission Format Details page opens.

For a description of the fields on this page, see List of Submission Formats Page on page 87.

Duplicating a Submission Format

Deposit Managers can duplicate a submission format. This is especially helpful when creating a new submission format. It is often faster to duplicate an existing submission format and then modify it, than to create a new submission format.

To duplicate a submission format:

On the List of Submission Formats page (Producers > Advanced Tools > Metadata Form), locate the submission format you want to duplicate and click Duplicate. The Rosetta system creates a copy of the format.

An exact copy of the submission format is added to the List of Submission Formats page. The Rosetta system automatically labels the new submission format with the name Copy of followed by the name of the original submission format.
Viewing Material Flows Associated with a Submission Format

Deposit Managers can view the material flows that are associated with a submission format.

To view the material flows:

On the List of Submission Formats page (see Accessing the List of Submission Formats Page on page 86), locate the submission format for which you want to view the material flows and click the Associated Material Flows link.

The List of Material Flows Per Submission Format page opens. The page displays columns containing the information described in Table 18. You cannot update the material flow details.

To return to the List of Submission Formats page, click Save.

Updating a Submission Format

Deposit Managers can update submission format details at any time. For example, a Deposit Manager can specify additional file types or change the number of files that Producer Agents can deposit.

To update a submission format:

1. On the List of Submission Formats page (Producers > Advanced Tools) > Submission Format see Accessing the List of Submission Formats Page on page 86), locate the submission format that you want to update and click Update. The Update Submission Format Details page opens.

2. Modify the fields as required.

3. To save your changes and return to the List of Submission Formats page, click Save. The List of Submission Formats page opens.

The submission format details are updated.

Deleting a Submission Format

A Deposit Manager can delete a submission format when it is not being used by any Producers and the Deposit Manager does not want to maintain the submission format.

Deposit Managers cannot delete a submission format when a Producer Agent is using it to deposit content. Deposit Managers can delete the submission format only after the deposit process is complete and no other Producer Agent is using the submission format.
To delete a submission format:

1. On the List of Submission Formats page (Producers > Advanced Tools > Submission Format), locate the submission format you want to delete and click More. Additional options are displayed.
2. Click Delete. The confirmation page opens.
3. Click OK. The submission format is removed from the list.

The submission format is removed from the Rosetta system. Producer Agents can no longer use this submission format when depositing content.

Configuring Content Structures

Content structures define the structure of the package that must be delivered to Rosetta in order to convert it to a Rosetta-compatible METS.

Deposit Managers work with content structures using the List of Content Structures page (see Accessing the List of Content Structures Page). The following activities can be performed using this page:

- Adding a Content Structure on page 100
- Viewing Content Structure Details on page 109
- Duplicating a Content Structure on page 109
- Viewing Material Flows Associated with the Content Structure on page 110
- Updating a Content Structure on page 110
- Deleting a Content Structure on page 111

Accessing the List of Content Structures Page

The List of Content Structures page enables Deposit Managers to view, activate, duplicate, and delete existing content structures. In addition, Deposit Managers can use this page to add new content structures.

To access the List of Content Structures page:

From the Rosetta drop-down menu, select Producers > Advanced Tools > Content Structure.

The List of Content Structures page opens.
NOTE:
To narrow your view to a subset of what is shown, click the Filter dropdown arrow and select the type, class, or group you want to see. To find an existing structure, enter its name or type in the Find field, select an in: option, and click the Go button.

The table displays the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the content structure.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of content structure.</td>
</tr>
</tbody>
</table>
| Material Flow  | - The name of the material flow, if the content structure is associated with only one material flow  
                 - The Associated Material Flows link, if the content structure is associated with multiple material flows  |
| Created On     | The date on which the content structure was created.                        |

Adding a Content Structure

Deposit Managers can add a new content structure to define how metadata must be converted from its original format to one supported by Rosetta.
To add a content structure:

1. Access the List of Content Structures page (see Accessing the List of Content Structures Page on page 99).

2. In the Add Content Structure drop-down list, select the content structure to which the original format must be converted.

3. Click Add. The Content Structure Details page for that format converter opens.

4. Enter information in the fields for the format converter you selected. See Set of Files Converter on page 101, Dublin Core Converter on page 102, XSL Converter on page 103, BagIt Converter on page 104, METS Converter on page 104, or CSV Content Structure on page 105 for examples of each format.

5. Click Save. The content structure is saved in the Rosetta system.

To enable Producer Agents to use the content structure for uploading content, Deposit Managers must associate the content structure with a material flow (see Associating Material Flow Components with Material Flows on page 125).

Set of Files Converter

The Set of Files Converter is the simplest and quickest method to load content into Rosetta. Use this content structure for UI-based deposits and other non-structured content.

![Content Structure Form: Set of Files](image)

Figure 40: Content Structure Form: Set of Files

All fields except Name are populated with default values. Enter a name for the converter and review and change, if necessary, the default values, using the descriptions below.

- **Name**: The name of the content structure.
Status: The status of the content structure, either Active or Inactive. If the content structure is Inactive, it cannot be used in a Material Flow.

Create Complex: If set to false, Rosetta creates one IE with one representation and one file for each file in the streams subfolder. If set to true, Rosetta creates only one IE. Its one representation contains all of the files in the streams subfolder.

Preservation Type: A metadata field of the Representation. It should be set to Preservation Master.

**Dublin Core Converter**

The Dublin Core Converter is similar to the Set of Files Converter but it allows users to maintain a relation between specific metadata and filestreams. This is useful when you want to create multiple IEs with different metadata in one SIP.

A dc.xml file may contain multiple DC records. `<record>` elements can be nested in any root element (for example: `<records>`, `<collection>`, etc.).

![Content Structure Form: Dublin Core](image)

**Name:** The name of the content structure.

**Status:** Should be set to active.

**Stream Source:** The dc field that references files (one or more) to be ingested. File location is relative to the SIP’s streams subfolder. Absolute NFS paths and HTTP references are also supported (URL must be a direct link to the binary file).

**NOTE:**
The list of available stream source fields can be edited from the Content Structure Stream Source code table in the administration UI.

**Preservation Type:** A metadata field of the Representation. It should be set to Preservation Master.
XSL Converter

The XSL converter allows users to upload SIPs of any source format in an automated material flow. This is done by preparing deposits in XML format and creating an XSL file that can convert the input XML files to DC files. This format allows customers uploading files to Rosetta to enrich the IEs with metadata information without the need to create a full, valid Rosetta METS (only DC information can be provided along with the streams to be uploaded).

The XSL converter definitions are similar to the DC converter with the addition of the following fields:

- **Upload XSL File**: The XSL file name including full path.
- **Create Complex**: If this field is set to **False**, Rosetta creates one IE with one representation and one file for each file in the streams subfolder. If this field is set to **True**, Rosetta creates only one IE. Its one representation contains all of the files in the streams subfolder.

The file extension (**.xsl**) is validated by Rosetta at the time of creating the content structure’s instance.

The system performs steps as follows:

1. Using the XSL, it converts the input XML to DC format.
2. The system uploads the DC and stream file(s) based on the information in the converted DC.
**BagIt Converter**

The BagIt converter allows you to upload SIPs in BagIt format. This format consists of the following sections:

- **Data** – the digital files
- **Manifest** – contains a checksum with the relative path to the files that enables Rosetta to perform a validation on the files
- **txt file** – contains the MD tags of the BagIt data

The BagIt content structure form contains the following fields:

<table>
<thead>
<tr>
<th>Tag File</th>
<th>Tag</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>bag-info.txt</td>
<td>External-Identifier</td>
<td>SIP - Identifier (DC)</td>
</tr>
<tr>
<td>bag-info.txt</td>
<td>Bagging-Date</td>
<td>SIP - Date (DC)</td>
</tr>
<tr>
<td>bag-info.txt</td>
<td>External-Description</td>
<td>SIP - Description (DC)</td>
</tr>
<tr>
<td>bag-info.txt</td>
<td>Source-Organization</td>
<td>SIP - Publisher (DC)</td>
</tr>
</tbody>
</table>

*Figure 43: BagIt Converter*

- **Store Tags as Source Metadata** check box – select to convert tag files to source md (whether or not they are mapped)
- **Tag File** – the name of the txt file that contains the BagIt metadata tags
- **Tag** – the BagIt metadata tag to which you want to map the METS field
- **Property** – the METS field to which you want to map the BagIt metadata tag

**METS Converter**

The METS content structure form contains the following fields:
Name: The name of the content structure.

Status: Should be set to active.

CSV Content Structure

The CSV Content Structure allows users to submit metadata in CSV format, along with zipped file streams. Rosetta transforms each CSV row into an object (Collection, IE, Representation, File—depending on the Object type field). The CSV file should hold all the relevant information for creating the objects. This can include metadata about the SIP and can also be used to create new collections.

The CSV Content Structure can be used only in a material flow with system-defined Detailed CSV or NFS submission format. To use NFS, place the zip file under the streams directory and the CSV file under the content directory.

The CSV Content Structure UI requires users to specify a CSV template, which determines the metadata fields depositors are required to fill. These templates are managed in the CSV Template UI, in the Producers section. For more information, see CSV Templates on page 107.
The Generate CSV Option field enables staff users to allow Producer Agents to auto-generate a full CSV file that represents the structure of the uploaded zip file. According to the selected value, Producer Agents will be prompted to download an auto-generated CSV file once a zip file has been uploaded. They will then be able to save their deposit activity as a draft, conveniently edit the CSV file, add metadata for each object, and upload and submit at a later stage. The following options are available:

- **None** - no CSV auto-generation will be available.
- **Simple** - each file in the zip file will become one IE.
- **Collections** - like simple, but with each node in the zip file becoming a collection.
- **Complex** - the entire zip file will become one IE.

**NOTES:**

- A physical structure map will be created based on the order of the files in the CSV file. When using **Complex**, it may be advisable to use the Generate Logical Structmap enrichment task to maintain the zip file structure hierarchy.
- When using Collections, a `dcterms:isPartOf` field must be added to the CSV mapping table so that sub-collections are created properly. Three additional fields may be added with the `collection` prefix:
  - `collection.externalSystem`
  - `collection.externalId`
The `collection.description` field must be unique as a pair.

The Download CSV Template downloads a CSV file with all the mandatory fields defined in the selected mapping table. This can be provided to Producer Agents when auto-generation is set to **None**.

**CSV Templates**

CSV templates include a list of mandatory metadata fields that must be part of a deposited CSV file. This list populates the CSV **Template** drop-down list in the CSV Content Structure UI. From the Rosetta drop-down menu, select **Producers > Advanced Tools > CSV Templates**.

![CSV Template Details](image)

**Figure 46: CSV Template - View**
The mandatory metadata fields include both system-level mandatory fields (such as file original path and file original name, which determine the NFS and HTTP location of the streams), and user-level mandatory fields, which can include additional fields the library may require (such as an IE dc:creator field). System mandatory fields are visible on the right and cannot be changed. To add or remove a user-level mandatory field, simply drag and drop the requested field in the multi-select widget.
NOTES:

- Collection-level mandatory fields are relevant only if the selected CSV content structure is configured to use collections (Generate CSV Option=Collections).
- Preservation Type field default value is Preservation Master.

**Viewing Content Structure Details**

Deposit Managers can view the content structure details, such as the content structure format, original format, and mapping table.

**NOTE:**
Deposit Managers cannot update the details while viewing them.

**To view the content structure details:**

On the List of Content Structures page (see Accessing the List of Content Structures Page on page 99), locate the content structure you want to view and click View. The View Content Structure Details page opens.

![Figure 48: Read-Only View of Content Structure Details](image)

For a description of the information displayed on this page, see Table 15 on page 100.

**Duplicating a Content Structure**

Deposit Managers can duplicate a content structure. This is especially helpful when creating a new content structure. It is often faster to duplicate an existing content structure and then modify it, than to create a new content structure.
To duplicate a content structure:

On the List of Content Structure page (see Accessing the List of Content Structures Page on page 99), locate the content structure you want to duplicate and click Duplicate. The Rosetta system creates a copy of the structure.

An exact copy of the content structure is added to the List of Content Structures page. The Rosetta system automatically labels the new content structure with the name Copy of followed by the name of the original content structure.

Viewing Material Flows Associated with the Content Structure

Deposit Managers can view the material flows that are associated with the content structure.

To view the material flows:

On the List of Content Structures page (see Accessing the List of Content Structures Page on page 99), locate the content structure for which you want to view the material flows and click one of the following:

- The Associated Material Flows link, when multiple material flows are associated with the content structure.
- The name of the material flow, when a single material flow is associated with the content structure.

The List of Material Flows page opens. The page displays columns containing the information described in Adding a Material Flow on page 157. You cannot update the material flow details.

To return to the List of Content Structures page, click Save.

Updating a Content Structure

Deposit Managers can update content structure details at any time. For example, a Deposit Manager can specify another content structure or change the mapping table.

To update a content structure:

1. On the List of Content Structures page (see Accessing the List of Content Structures Page on page 99), locate the content structure that you want to update and click Update. The Update Content Structure Details page opens.
2. Modify the fields as needed.
3 To save your changes and return to the List of Content Structure page, click Save.

The system updates the content structure details.

Deleting a Content Structure

A Deposit Manager can delete a content structure when it is not being used by any Producers and the Deposit Manager does not want to maintain the content structure.

Deposit Managers cannot delete a content structure when a Producer Agent is using it to deposit content. Deposit Managers can delete the content structure only after the deposit process is complete and no other Producer Agent is using the content structure.

To delete a content structure:

1 On the List of Content Structures page (see Accessing the List of Content Structures Page on page 99), locate the content structure you want to delete and click More. Additional options are displayed.

2 Click Delete. The confirmation page opens.

3 Click OK. The content structure is removed from the list.

The content structure is removed from the Rosetta system. Producer Agents can no longer use this content structure when depositing content.

Working with Configuration Files

Configuration files are text files that enable Deposit Managers to configure advanced settings for Producers such as metadata configuration and e-mail formatting. Configuration files can be stored in various formats, including XML and XSL.

Users access individual files by clicking through paths from the Rosetta Management Home page. Figure 49 follows the path Producers > Advanced Tools > Delivery XSL files.
To open a file for editing, click the Edit text of the file’s row. The example below uses ie.xsl, which allows you to specify how the metadata for IEs should appear and behave in a delivery situation.

Once you have opened the XSL page, you can make any alterations to the XSL and click the Save button to implement the changes.
Deliver XSLs

Deposit Managers can define how an IE’s metadata will be displayed or printed for other users by editing XSL files. Different XSL files can be used for IEs, representations, and files.

For example, a Deposit Manager can edit lines of an XSL file to determine the exact metadata to be printed with an IE image. While the default print contains no metadata or additional information, information and additions can be made available to a file when it prints.

Deposit Managers can configure these files using the Delivery XSLs page. To reach this page, follow the path Producers > Advanced Tools > Delivery XSL files.

The Configuration Files page enables you to view the list of available configuration files and open individual files for editing.

**NOTE:**

The Configuration Files page differs in content based on the type of file you select from the Producers > Advanced Tools menu.

Delivery Copyrights Statements

Delivery copyrights statements are displayed to users viewing an IE that has such a statement associated with its Access Rights policy (see Adding an Access Rights Policy on page 129 and Figure 62 in that section).

Deposit Managers can add new files or edit existing ones from the Configuration Files page (Producers > Advanced Tools > Delivery Copyrights Statements).

![Figure 51: Delivery Copyright Statements List](image)

Delivery copyright statements can be viewed, edited, copied, created anew, and deleted. All of the options are available from the Configuration Files page for delivery copyright statements. Deposit Managers can view the list of available configuration files as well as open individual files for editing. Copyright files
can be added to the list by clicking the Add File button and entering all new information or by clicking the Duplicate text link of an existing statement that resembles one you want to create, then editing it for other purposes (Figure 52).

![Figure 52: Adding a Statement by Duplicating](image)

**Configuring Copyright Boilerplate Statements**

Copyright boilerplate statements contain copyright statements displayed to Producer Agents when they deposit content. Deposit Managers can create multiple boilerplate statements and then use them in different material flows.

Deposit Managers work with copyright boilerplate statements using the Boilerplate Statements page (see Accessing the Boilerplate Statements Page on page 114). The following activities can be performed using this page:

- Editing Boilerplate Statements on page 115
- Viewing Boilerplate Statements on page 115

**Accessing the Boilerplate Statements Page**

The Boilerplate Statements page enables Deposit Managers to view the list of boilerplate copyright statements stored in the Rosetta system. In addition, Deposit Managers can use this page to edit existing boilerplate statements.
To access the Boilerplate Statements page:

From the Rosetta rollover menu, click Producers > Advanced Tools > Boilerplate Statements.

The Configuration Files page opens to the boilerplates subgroup.

| Home > Producers > Advanced Tools > Configuration Files |
|---|---|
| File Group: Deposit Configuration | Sub-Group: Boilerplates |
| 1 - 1 of 1 Files |
| Filename | Description | Updated by | Update Date | View |
| copyrights/boilerplate1.html | | 3/8/11 | | |

Figure 53: Boilerplate Statements Page

Editing Boilerplate Statements

Deposit Managers can edit an existing boilerplate statement to modify the copyright statement displayed to Producer Agents when they deposit content.

To edit a boilerplate statement:

1. On the Boilerplate Statements page (Producers > Advanced Tools > Boilerplate Statements), locate the boilerplate statement you want to modify and click Edit.

   The Edit Boilerplate Statement page opens.

2. Edit the copyright statement as required and then click Save. The updated boilerplate copyright statement is saved in the Rosetta system.

   The updated statement is now displayed to Producer Agents depositing content.

Viewing Boilerplate Statements

Deposit Managers can view copyright boilerplate statements.

**NOTE:**

Deposit Managers cannot modify the statements while viewing them.
To view a boilerplate statement:

On the Boilerplate Statements page (Producers > Advanced Tools > Boilerplate Statements), locate the boilerplate statement you want to modify and click View. The View Boilerplate Statement page opens.

Configuring Producer Agent E-mail

Communication between Staff users who review SIP submissions and the Producer Agents who submit them is automated in the Rosetta system. Some communications (e-mail) are sent by default, others must be configured by a Deposit Manager.

Default E-mail to Producer Agents

When a SIP is rejected, declined, or when a SIP is received successfully by the staging server or accepted for deposit in the permanent repository, Rosetta sends a confirmation e-mail to the Producer Agent. The default fields that appear on these reports include the deposit activity ID, Title, Deposit Date, and Status, as well as the Agent’s name and the URL where the Agent can link to view the deposit. Further fields that appear on the e-mails:

- For IEs, the PID.
- For each file:
  - The applicable identifier (such as ISBN, ISSN, or ISMN)
  - The computed checksum(s)
  - The time stamp of the Rosetta activity (that is, the date and time of the SIP status change)

E-mail notifications can make use of digital signatures if configured by a Deposit Manager (see Digital Signature on page 73 in the Configuration Guide).

Customizing Display Fields

E-mails are drawn from an XML file defining many of the fields a user might want to add to the e-mail. All additions and adjustments are made through the email_to_depositor.xsl file.
To access this file and make changes to the e-mail:

1. Access the Configuration Files page of the Management module by following the path **Producers > Advanced Tools > Email Configuration**.

![Figure 54: Configuration Files for Formatting Deposit-Related E-mail](image)

2. In the **Filename** column, find the **email_to_depositor.xsl** file and click on it or on the corresponding **Edit** text link. The file opens in an editable window (**Figure 55**).
3 Add or edit definitions for any available fields. The following information can be transmitted if it is added to the XSL file:

- For each IE in an approved SIP:
  - IE PID
  - IE title
- For each file in the IE:
  - the applicable identifier (that is, ISBN, ISSN, ISMN, and so forth)
  - the computed checksum (md5, SHA-256, and CRC32)
  - file name
  - the time stamp of the file status change (that is, the date and time the file status changed to Moved to Permanent)
- For each rejected or declined IE in the SIP and for each IE containing rejected or declined files:
  - the IE PID
  - the IE title
- For each file in the IE:
the applicable identifier (that is, ISBN, ISSN, ISMN, and so forth)
- the file status (Approved, Rejected, or Declined)
- if the file status is Rejected or Declined, the time stamp of the file status change (that is, the date and time the file status changed to Reject or Decline)

Additional E-mail Configuration Files

In addition to the email_to_depositor.xsl file and related XSL files, the following XSL files are available for editing:

- deposit_activity_status_change/email_to_depositor.xsl: Email sent to the producer agent when a deposit is rejected or declined
- deposit_activity_status_change/email_to_depositor_body.xsl: Email sent to the producer agent when a deposit is rejected or declined
- deposit_activity_status_change/email_to_depositor_preview.xsl: Email sent to the producer agent when a deposit is rejected or declined
- deposit_activity_status_change/email_to_depositor_submission.xsl: Email sent to the producer agent when a deposit is submitted
- EmailToPlanAnalyst.xsl: sends preservation plan information to the Preservation Analyst
- EmailAddingRepresentation.xsl: sends an e-mail to the user when a representation is added to an IE
- EmailIndividualProducerRegister.xsl: confirms the registration of an individual Producer
- EmailProducerReport.xsl: sends deposit report to the Producer
- EmailProducerWithNoContact.xsl: sends a notification to a Producer that there are no contacts associated with the account
- EmailUserIsPrimaryContact.xsl: notifies the user that he or she is the primary contact
- EmailUserNewPasswordIndProd.xsl: confirms a new password for an individual Producer
- EmailUserRegister.xsl: confirms a user’s registration
- EmailUserassignedAsPA.xsl: sent when a user is assigned as a Producer Agent to a Producer
- EmailUserNew.xsl: sends an acknowledgment confirming a new user
- EmailUserUpdate.xsl: confirms the update of a user’s information
- EmailUserDelete.xsl: notifies the user that they are being deleted from the system
Most e-mail messages can be previewed by the sender before being sent to the recipient.

**Adding an E-mail Confirmation**

Rosetta can be configured to send confirmation e-mail to depositors when
- a SIP has been accepted by the staging server and is being processed or
- a SIP has been approved and its contents sent to the permanent repository.

These confirmation emails will be sent if Email Notification is set to true in the SIP processing configuration for this Material Flow. See **SIP Routing Rules** on page 182 for further details.

**Configuring Terms of Use**

A Terms of Use (TOU) statement appears in the Deposit interface and in the viewers that render objects in the Rosetta interface. Viewers display a TOU statement for the institution that owns a displayed object.

Only one TOU file is allowed for each institution. The file can be edited but not deleted.

**To view or edit TOU text for your institution:**

1. Open the Configuration Files page from the Rosetta menu (*Producers > Advanced Tools > Terms of Use Configuration Files*).
   
The Configuration Files page opens.

   ![Figure 56: Configuration Files Page](image)

2. To view the text file or edit it, click the relevant link, **View** or **Edit**.
   
The View or Edit Configuration File page opens.
If you selected **Edit**, you can make edits to the file and click the **Save** button. (If you selected **View**, you do not have a Save button on the page. Click **Cancel** or **Back** to return to the Configuration Files page.)

**Configuring Metadata Profiles**

A metadata profile defines:

- Which metadata elements are mandatory for a given IE
- Which validation routines should apply for each of the IE’s metadata elements
- Whether a user can add elements or whether the list of elements that can be associated with the IE is restricted according to a predefined list
This section contains the following topics:
- Accessing the List of Metadata Profiles Page on page 122
- Creating a New Metadata Profile on page 123
- Editing or Duplicating an Existing Metadata Profile on page 123
- Deleting a Profile on page 125

**Accessing the List of Metadata Profiles Page**

The List of Metadata Profiles page enables Deposit Managers to edit, duplicate, and delete existing Metadata Profiles. Deposit Managers can also use this page to add new metadata profiles.

To access the List of Metadata Profiles page:

From the Rosetta rollover menu, click **Producers > Advanced Tools > List of Metadata Profiles**.

The List of Metadata Profiles page opens.

![Figure 58: List of Metadata Profiles Page](image)

You can search specifically for a profile using the **Find/in** search in the row below the breadcrumb. This searches the existing list for the term you enter.

The table itself displays the profile name and description (as entered by the staff who created the entry) and the creation and modification dates (system-generated).

From this page, you can perform the following actions:
- Creating a New Metadata Profile on page 123
- Editing or Duplicating an Existing Metadata Profile on page 123
- Deleting a Profile on page 125
Creating a New Metadata Profile

To create a new metadata profile:

1. From the List of Metadata Profiles page (Producers > Advanced Tools > List of Metadata Profiles), click the Add Metadata Profile button (above the Name column of the table).

The Metadata Profile Editor page opens.

![Metadata Profile Editor Page](Figure 59: Metadata Profile Editor page)

2. Enter a name for the metadata profile and a brief description of it in the fields provided.
3. Add elements to the profile by using the available add buttons and selecting items from the drop-down fields on the Element Editor pages that open.
4. Click Apply to save the profile and remain on the page or Save to save it and return to the List of Metadata Profiles page.

Editing or Duplicating an Existing Metadata Profile

Staff Managers can make changes to an existing profile by editing it or by duplicating it. Duplicating an existing profile allows users to keep the original profile intact while creating a new profile based on the values entered in the original.
To edit or duplicate an existing metadata profile:

1. Access the List of Metadata Profiles page (Producers > Advanced Tools > List of Metadata Profiles) and find the profile you want to edit.

2. In the row of the profile, click the Edit text link if you want to change the profile, click Duplicate if you want to keep a copy of the original profile and use its values as a starting point for a new profile.

3. The Metadata Profile Editor page opens. Values for the profile selected appear on the form. (See figure below.)

4. Make changes to any of the editable fields, and add, edit, or delete any of the descriptive metadata or DNX elements.

5. Click Apply to save, Save to save and return to the previous page (the Metadata Profile List page). To cancel changes you made and return to the previous page, click the Back button.
Deleting a Profile

To delete an existing profile

1. To delete a metadata profile, access the List of Metadata Profiles page
   (Producers > Advanced Tools > List of Metadata Profiles) and find the
   profile you want to delete.

2. Click the Delete text link of that row.
   A Deletion Confirmation page opens.

3. Confirm the deletion by clicking the Confirm button.
   The system deletes the profile and returns you to the List of Metadata Profiles
   page.

Associating Material Flow Components with
Material Flows

After metadata forms, submission formats, access rights options, retention
policies, and content structure templates are configured, Deposit Managers can
associate these components with material flows. Each component can be
associated with multiple material flows.

For instructions on associating material flow components with a material flow
(or, creating a new material flow), see Adding a Material Flow on page 157.
Access Rights

This section contains:
- Configuring Access Rights Policies on page 127
- Assigning an Access Rights Policy on page 137
- Access Rights Exceptions on page 139

Configuring Access Rights Policies

Access rights policies define who can view which content under what conditions. The policies can be applied to entire IEs or to specific representations of IEs (if, for example, you want to provide staff with access to a high-quality Preservation Master and the public with a lower-quality, faster-loading derivative copy). Access rights cannot currently be applied to individual files or groups of files.

NOTE:
In order to configure access rights policies, you must be assigned either the Deposit Manager or Data Manager role with the Edit Access Rights Policies role parameter.

How Access Rights Work

Access rights for IEs and representations are processed as follows:

a. A user requests an IE or a representation.

b. The system checks the access rights policy for the IE.

c. If the access rights requirements are not met, the system blocks the IE and sends a message to the user.

d. If the access rights requirements for the IE are met, the system grants access to the user seeking the IE.
For the user seeking a representation, the system checks the access rights policy for the representation. If the access rights for the representation are not met, the system repeats the access rights check for all additional representations until it runs through every representation in the IE. All the representations that pass the Access Rights are displayed. If all are blocked, the system behaves as if the IE's access rights are not met.

**Access Rights as Shared Metadata**

Because access rights policies are stored as shared metadata, their configuration can be accessed from the Metadata Search page. (They can also be accessed from the **Producers > Advanced Tools** menu.) The Metadata Search page is used for searching shared metadata across the Rosetta system.

The following activities can be performed from this page:

- Accessing the Metadata Search Page on page 128
- Adding an Access Rights Policy on page 129
- Editing an Access Rights Policy on page 134
- Deleting an Expression from an Access Rights Policy on page 136
- Displaying a Previous Version of an Access Rights Policy on page 136

**Accessing the Metadata Search Page**

The Metadata Search page enables Deposit Managers to view and add access rights policies.
To access the Metadata Search page:

1. From the Rosetta drop-down menu, click Deposits > Policies > Access Rights Policies. The Metadata Search page, populated with the list of existing access rights policies, opens.

![Metadata Search Page](image)

Figure 61: Metadata Search Page

Adding an Access Rights Policy

Deposit Managers can add a new access rights policy to the Rosetta system. This is done through the copyright statement that displays when a user views content to which this access rights policy applies.

After a policy is added, it can be associated with a material flow.
To add an access rights policy:

1. On the Metadata Search page (see Accessing the Metadata Search Page on page 128), click Add Shared Metadata Record. The Details page opens.

![Add Access Rights Policy Page](image)

2. In the Copyright Template drop-down list, select the template that must be used to display the copyright statement.

3. Click Add Expression. The Add Expression page opens.
In the **Criteria** drop-down list, select the criterion by which the Rosetta system must compare the actual parameters of a user with the parameters you define in the expression. Criteria values are taken from the Access Rights Key Code Table. **Table 16** defines the items you are likely to find in the list.

**Table 16. Expression Criteria**

<table>
<thead>
<tr>
<th>Name</th>
<th>Access Is Granted...</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Group</td>
<td>to users who belong to this user group, as defined in their user group field.</td>
</tr>
<tr>
<td>User ID</td>
<td>to the specific user with this user ID (Rosetta user ID).</td>
</tr>
<tr>
<td>IP Range</td>
<td>for calls coming from the specified IP range.</td>
</tr>
<tr>
<td>Registered User</td>
<td>to users who are registered and authenticated by the PDS module. (Not to users who attempt to access from outside the institution's network)</td>
</tr>
</tbody>
</table>
Table 16. Expression Criteria

<table>
<thead>
<tr>
<th>Name</th>
<th>Access Is Granted...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone</td>
<td>to everyone.</td>
</tr>
<tr>
<td>Concurrent Users</td>
<td>to a certain number of users at a time (IE-level policies only).</td>
</tr>
<tr>
<td>AR Plug-in</td>
<td>to users of an access rights plug-in that integrates its external interface with that of Rosetta.</td>
</tr>
<tr>
<td>LDAP User Group List</td>
<td>to a user who belongs to the listed group defined in the institution's directory and whose credentials are transferred by LDAP (Lightweight Directory Access Protocol).</td>
</tr>
<tr>
<td>LDAP User Department</td>
<td>to a user who belongs to the listed department defined in the institution's directory and whose credentials are transferred by LDAP.</td>
</tr>
<tr>
<td>LDAP Tuples</td>
<td>if the text string sent through LDAP meets the criterion.</td>
</tr>
<tr>
<td>LDAP Course Enrollment</td>
<td>if the text string sent through LDAP meets the criterion.</td>
</tr>
<tr>
<td>Moving Wall</td>
<td>based on a specified time before/from the selected date. Select Metadata to choose from any metadata-based IE-level date field (dc, dcterms, DNX) or Date to specify a fixed date. Supported time units are years, months, weeks, and days.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>up until the specified date.</td>
</tr>
</tbody>
</table>

**NOTE:**
Your selection for **Criteria** may change the labels for the fields just below it. Wait to see if the page refreshes before continuing.

5 In the **Operator** drop-down list, select an operator (such as equals) to be used to compare the actual parameters of a content consumer with the parameters defined in the **Value** field. The values for operators are generated by the type of data selected in the **Criteria** field.

**NOTE:**
The page reloads when you enter a value that changes the fields below the active field. For example, **IP Range** as a **Criteria** will change the **Operator** field to **within** or **contains**; if you select **contains**, one blank field loads below the operator field; if you select **within**, two values load. See **Figure 64** below.
Figure 64: Adding an Expression to an Existing Group

6 Finish entering the values. If your policy includes more than one group, make sure you have the correct group specified in the top portion of the form.

7 Click Save. The policy is saved to the group specified. The list of existing access rights policies re-opens.

8 You can add groups and expressions within the groups until you have completed a policy. The following figure shows a policy with two groups and three expressions among them.
### IMPORTANT:
Rosetta reads the groups as if an OR logical operator separated them. Rosetta reads the expressions within the groups as if an AND operator separates them. So, for the figure above, the user gains access if he or she is both in the IP range AND a Registered user, or if he or she is in the user group Staff. Either one of those two groups/conditions will qualify the user for access.

![Figure 65: Access Rights Groups and Expressions](image)

<table>
<thead>
<tr>
<th>Group 1</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Range contains 178.90.1.0-178.90.1.255</td>
<td>Accessible for users within the institution</td>
</tr>
<tr>
<td>User Group equal Registered</td>
<td></td>
</tr>
<tr>
<td>Group 2</td>
<td>User Group equal Staff</td>
</tr>
</tbody>
</table>

9. Click **Save**. The Metadata Search page opens with your access rights policy included in the list.

The access rights policy now can be associated with a material flow.

**Editing an Access Rights Policy**
Deposit Managers can edit an existing access rights policy by adding or deleting expressions.
To edit an access rights policy:

1. On the Metadata Search page (see Accessing the Metadata Search Page on page 128), locate the access rights policy that you want to edit and click Edit. The Access Rights Editor opens.

![Access Rights Editor](image)

Figure 66: Access Rights Editor

The page contains a list of expressions. Each expression defines criteria (such as an IP address) that a content consumer must meet in order to view the content object.

2. Do one of the following:
   - Add an expression, as described in steps 3 through 8 in Adding an Access Rights Policy on page 129.
   - Delete an expression, as described in Deleting an Expression from an Access Rights Policy on page 136.
NOTE:
When saving changes to a shared metadata record, the following warning message appears:

Changes will affect all institutions - Continue?

Deleting an Expression from an Access Rights Policy
Deposit Managers can delete an expression from an access rights policy when they do not want to use the criteria defined in the expression.

To delete an expression:

1. On the Access Rights Editor page (see Editing an Access Rights Policy on page 134), locate the expression that you want to delete and click Delete. The confirmation page opens.
2. Click OK. The expression is removed from the list of expressions. The group of content consumers for which the expression was defined can no longer view the content object.

Displaying a Previous Version of an Access Rights Policy
You can display a previous version of an access rights policy and revert to it.
To display a previous version of an access rights policy and revert to it:

1. Click History for the access rights policy that you want to roll back. A list of versions of the access rights policy appears.

![Figure 67: Reverting to a Previous Version of an Access Rights Policy](image.png)

2. Click Revert for the version to which you want to revert.

The details of the access rights policy revert to the version you selected.

Assigning an Access Rights Policy

Data Managers can assign an access rights policy to an IE to define who can view the content and when this content can be accessed. Data Managers can also assign an access policy to a representation. Because only one access rights policy can be associated with a representation, if a representation is assigned an access policy, any existing access rights policy assigned to that representation will be overwritten and replaced by the current one.

To assign an access rights policy:

1. Conduct a search for the object whose access you want to restrict. From the Search Results page, click the Info link that corresponds to your object’s row. The object opens in the Web Editor.
2 In the **Actions** drop-down menu at the bottom right of the page, click **Lock Object** and then click the **Go** button.

The page refreshes with the notice: **Locked By: Me.**

3 In the tree pane, select the IE or representation to which you want to assign an access rights policy.

4 In the main pane, click the **Metadata** tab.

5 From the Metadata tab, click the **Assign AR Policy** button. The Access Rights Policies page opens.
6 Locate the access rights policy you want to assign to the IE or representation and select its button, then click **Add**.

The access rights rule is assigned to the IE or representation and can be seen on the object’s Metadata tab.

Users can now view the IE or representation under the new conditions of the access rights policy.

**NOTES:**

- Because an access rights policy is not required for a representation, the policy can be removed by clicking the **Remove** action.
- The system generates a provenance event whenever an access rights policy is assigned or removed.

---

**Access Rights Exceptions**

Rosetta provides the granting of specific user rights to specific materials through the use of access rights exceptions. These rights add access for certain users that exceed rights already granted to a general user population. Access rights exceptions never restrict users’ access further. They are only used to increase the specified user group’s access to certain IEs or sets of data where they do not exist in the current active rights.

Access rights exceptions are set up in three stages:

- **Setting Up Access Rights Exceptions** on page 139
- **Displaying a Previous Version of an Access Rights Policy** on page 136
- **Assigning an Exception to a Set** on page 143
- **Access Rights Exceptions in the Web Editor** on page 145

**NOTE:**

In order to configure access rights exceptions, you must be assigned either the Deposit Manager or Data Manager role with the **Edit Access Rights Exceptions** role parameter.

---

**Setting Up Access Rights Exceptions**

To set up an access rights exception, add an exception from the Access Rights Exceptions List page.
To add an access rights exception:

1. From the Rosetta drop-down menu, follow the path: Data Management > Policies > Access Rights Exceptions.

The Access Rights Exceptions List page opens (Figure 70). Any existing rights exceptions display in a table with several options for actions that can be performed on them.

![Access Rights Exceptions List](image)

*Figure 70: Access Rights Exceptions List*

2. Click the Add Access Rights Exceptions button above the list of exceptions. The Edit Access Rights Exceptions page opens (Figure 71).
3 Select a Copyright Template from the existing templates in the drop-down list.

4 Enter a description for the AR in the Description text field. This text identifies the exception on the List of Access Rights Exceptions page.

5 Enter the message you would like users to see when they do not have access to the object based on this particular access rights policy. If you do not enter a custom message, a general default message appears on the user's page.

6 Click the Add Expression button.

   The AR Expression page opens. If this is your first expression for this exception, New Group will be selected by default. (On subsequent expressions, To Existing Group will also be available for selection.)
For the **Criteria** drop-down field, select the item you want to use as a measure for this expression.

The fields below may adjust to accommodate the Criteria selection.

8. Select an **Operator** to compare the Criteria selection with the value(s) you will enter.

9. Enter a value or values in the **Value 1** (and **Value 2**, if applicable) field.

10. Click the **Save** button.

The AR Full View page opens with the expression you just added (**Access Rights Exception with One Expression**).
To add another expression, click the **Add Expression** button and repeat that portion of the procedure. Repeat as needed.

Click the **Save** button.

Your exception is added to the List of Access Rights Exceptions.

**Displaying a Previous Version of an Access Rights Exception**

You can display a previous version of an access rights exception and revert to it in the same way you do so for an access rights policy. For more information, see *Displaying a Previous Version of an Access Rights Policy* on page 136.

**Assigning an Exception to a Set**

Once you have created one or more rules for access rights exceptions, you need to assign the exceptions to a set of data. Rosetta uses a wizard to help you do this.

**To assign an exception to a set:**

1. On the Access Rights Exception List page, find the AR exception you want to assign and click the corresponding **Assign to Set** text link.

   Step 1 of the Assign to Set wizard opens. It displays the name of the process, which is assigned by the system and is read-only.
2. Click the **Next** button to move to step 2 of the wizard.

![Figure 74: Assign AR Exception to Set](image)

3. Select the set to which you want to apply the AR exception to and click **Next**. The third step of the wizard opens, displaying the process name and scheduling information.

![Figure 75: Assign to Set - Wizard Step 3](image)

4. If the information is correct, click **Next**. (If it is not, click **Back** and return to step 2 to correct it, if possible.) The access rights exception will be applied to the set you identified. The original Access Rights Exceptions List opens to complete the procedure.
NOTE:
You can repeat this procedure to assign more exceptions to more sets (or a single exception to multiple sets).

Access Rights Exceptions in the Web Editor
Access rights exceptions can be applied to IEs from the Web Editor.

To assign an exception to the rights for an IE:

1. Using the Search for Object or Search for Metadata page (Data Management > Search and Manage Queries > Search for Objects), look up the IE to which you want to assign access rights exceptions.

2. Click the Info text link of the row corresponding to the IE you want.
   The IE opens in the Web Editor with the Object Summary tab open. If the IE is already locked, an exclamation point with brief text will indicate this above the object hierarchy tree.

3. If the IE is not locked, then, in the Actions drop-down box (lower right of page), select Lock object and click the GO button.

4. Click the Metadata tab in the object information box.
   Metadata for the IE displays in the object information box. Above the metadata table, several buttons, including Add AR Exceptions, are available for this IE.

5. Click the Add AR Exceptions button.
   The Local Access Rights Metadata Type page opens. The system displays a list of all access rights exceptions created from the Access Rights Exceptions List page.
Figure 76: Local AR Exceptions

6 Click one radio button beside the exception you want, then click the Add button.

The IE details page opens with the added exception showing under the Metadata tab with options to view or remove the exception.
Retention Policies

About Retention Policies

Retention policies allow libraries to place limits on the length of time particular items will be stored in a repository. Records that are required to be kept for legal or fiscal purposes, for example, may have no value to a library after the required retention time has elapsed. In such cases, Rosetta users can place retention limits on items and have them sent to recycling or purged entirely from the system after a span of time or a particular date.

Retention policies are classified as shared metadata, and, as with access rights in Rosetta, they can be applied to multiple IEs.

Retention policies can be accessed from the following areas on the Staff interface:

- To create and manage retention policies: Producers > Advanced Tools > Retention Policies
- To associate a retention policy with a material flow: Producers > Deposit Arrangements > Manage Material Flows
- To work on the retention policy of a single IE: Web editor, individual IEs, Metadata tab

Retention policies also appear on deposit forms (in the Deposit module) and on the list of scheduled jobs in the Administration module.
NOTE:
In order to configure retention policies, you must be assigned either the Deposit Manager or Data Manager role with the Edit Retention Policies role parameter.

Creating Retention Policies

To set up retention policies, sign in to the Management module and follow the path Data Management > Policies > Retention Policies.

The Retention Policy page opens (Figure 77).

By default, only one policy is preconfigured by the system: a NO_RETENTION policy. This configuration defaults to an indefinite retention of all items in the system that do not have a specified retention policy.

To create a retention policy limit:

1. From the Retention Policy page (Figure 77), click the Add Shared Metadata Record button.

A blank retention policy form opens (Figure 78).
By default, the retention policy uses After particular date and the impact of the purge is not permanent (check box is cleared)—that is, all purged items for this policy are retained in a recycle bin and can be retrieved.

OPTIMAL: To change the retention policy to a span of time rather than an exact date, use the Retention Policy drop-down menu.

Date fields will change according to the type of retention policy you select. Figure 79 shows one type of policy.
3 Enter values in the form’s fields. Use Table 17 for definitions of fields.

Table 17. Retention Policy Form Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Retention Measure (Date or Span)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Both</td>
<td>Describes the policy. Shows in the list of retention policies and helps users identify it.</td>
</tr>
<tr>
<td>Retention Policy</td>
<td>Both</td>
<td>Select a specific date in the future or a period of time to lapse from a particular date/event.</td>
</tr>
<tr>
<td>Date</td>
<td>Specific date</td>
<td>The exact date on which the items associated with this policy can be deleted from the database. Use DD/MM/YYYY fields or drop-down calendar (as seen in Figure 79).</td>
</tr>
<tr>
<td>Reference Date</td>
<td>Time elapsed</td>
<td>The date/event on which the period of retention time begins.</td>
</tr>
<tr>
<td>Retention Unit</td>
<td>Time elapsed</td>
<td>The unit of time used, as in days or years.</td>
</tr>
</tbody>
</table>
Table 17. Retention Policy Form Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Retention Measure (Date or Span)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Units</td>
<td>Time elapsed</td>
<td>The number of units to equal the full time elapsed (as in 180 for days).</td>
</tr>
<tr>
<td>Permanently Delete</td>
<td>Both</td>
<td>If checked, the items associated with this policy are purged from the system and cannot be retrieved. If left unchecked (the default), items are removed from the standard storage but remain available in a “recycle” storage area.</td>
</tr>
</tbody>
</table>

4 When you have completed the form, click the Save button.
Your new policy is saved to the system, appears in the list of retention policies, and can be assigned to an IE as shared metadata through, for example, the Web Editor, under the Metadata tab, or as part of a material flow.

**Working With Retention Policies**

The following actions can be undertaken to edit, delete, or assign policies to IEs.

- Editing a Retention Policy on page 151
- Deleting a Retention Policy on page 152
- Displaying a Previous Version of a Retention Policy on page 152
- Assigning a Retention Policy to an IE on page 152

**Editing a Retention Policy**

You can edit any of the retention policies except for the system-created NO_RETENTION policy.

**To edit an existing retention policy:**

1 Open the List of Retention Policies page (Producers > Advanced Tools > Retention Policies).
2 Find the policy you want to change in the list.

**NOTE:**
If there are many policies and you are having trouble finding the one you want, perform a quick search in the upper right corner of the page. You
can search by MID if you have the number, or by a case-insensitive search of the Description field.

3 Click the Edit text corresponding to your policy’s row. The policy form opens with its existing entries.

4 Make the changes you want on the form. For information on specific fields, see Table 17.

Deleting a Retention Policy

You can delete any staff-created policies unless they are associated with an IE. If you attempt to delete a retention policy that is in use, you will receive a notice telling you the number of IEs to which this policy is attached.

To delete an existing retention policy:

1 Open the List of Retention Policies page (Producers > Advanced Tools > Retention Policies).

2 Find the policy you want to delete in the list.

NOTE: If there are many policies and you are having trouble finding the one you want, perform a quick Find search in the upper right corner of the page. You can search by MID if you have the number, or by a case-insensitive search of the Description field.

3 Click the Delete text corresponding to your policy’s row. A confirmation page opens.

4 Click the Confirm button to continue with the deletion. The system returns you to the list of retention policies.

Displaying a Previous Version of a Retention Policy

You can display a previous version of a retention policy and revert to it in the same way you do so for an access rights policy. For more information, see Displaying a Previous Version of an Access Rights Policy on page 136.

Assigning a Retention Policy to an IE

Data Managers can assign a retention policy to a particular IE.
To assign a retention policy to an IE:

1. Open the IE in the Web Editor (see Accessing the Web Editor on page 453).
2. In the IE Tree pane, make sure the IE object (and not the File, for example) is highlighted.
3. In the Actions field at the bottom right of the page, select Lock the IE from the drop-down menu and click the GO button. The page refreshes. New buttons may appear on the display.
4. Click the Metadata tab.
   The page refreshes with several buttons under the Metadata tab (Figure 80).
5. Click the Assign RP button.
   The Retention Policies list opens. Beside each option is a radio button.
6. Select the policy you want to add, then click the Add button.
   The IE reopens in the Web editor with the retention policy appearing in the list under the Metadata tab. The IE now adheres to this retention policy.

To unassign a retention policy of an IE:

1. Search for the IE whose retention policy you want to remove.
2. View the metadata list for the IE and click Remove for the retention policy.
   The retention policy is removed.
Managing Generic Material Flows

This section contains:

- About Generic Material Flows on page 155
- Accessing the List of Material Flows Page on page 155
- Adding a Material Flow on page 157
- Activating and Deactivating Material Flows on page 161
- Duplicating a Material Flow on page 162
- Updating a Material Flow on page 162
- Deleting a Material Flow on page 163

About Generic Material Flows

Deposit Managers can manage generic material flows that exist in the Rosetta system as a single unit. For example, a Deposit Manager can activate, or change the name of, a generic material flow. (For general information on material flows, see Managing Generic Material Flows in the Rosetta Overview Guide.)

Deposit Managers work with generic material flows using the List of Material Flows page.

Accessing the List of Material Flows Page

The List of Material Flows page enables Deposit Managers to view the existing generic material flows and create new material flows.

To access the List of Material Flows page, click the following links from the Rosetta rollover menu: Producers > Deposit Arrangements > Manage Material Flows.
Figure 81: List of Material Flows Page

The list contains the following information for each material flow:

Table 18. List of Material Flows Page Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Indicates the material flow status:</td>
</tr>
<tr>
<td></td>
<td>▪ Yellow - The material flow is active.</td>
</tr>
<tr>
<td></td>
<td>▪ Grey - The material flow is inactive.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name of the material flow.</td>
</tr>
<tr>
<td>Producer Profile</td>
<td>Displays:</td>
</tr>
<tr>
<td></td>
<td>▪ The name of the Producer profile when the material flow is associated with only one Producer profile</td>
</tr>
<tr>
<td></td>
<td>▪ The Associated Producer Profiles link when the material flow is associated with multiple Producer profiles</td>
</tr>
<tr>
<td>Template</td>
<td>Displays the type of template on which the material flow is based:</td>
</tr>
<tr>
<td></td>
<td>▪ Manual - Producer Agents can use the material flow to deposit content manually.</td>
</tr>
<tr>
<td></td>
<td>▪ Automated - Content is automatically deposited to the Rosetta system from a remote server or local computer.</td>
</tr>
</tbody>
</table>
Adding a Material Flow

Deposit Managers can add a new generic material flow to define how Producer Agents can deposit content.

**NOTE:**
To add a material flow, the metadata forms, submission formats, access rights options, retention policy, and content structure must already be configured. For more information, see Configuring Material Flow Infrastructure on page 85.

**To add a material flow:**


2. Complete the fields as follows:
   - In the **Name** field, enter a name for the material flow.
   - In the **Material Flow Template** drop-down list, select one of the following options:
     - **Automated,** when you want to enable Producer Agents to deposit content automatically from a specified location on a server or local computer

---

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created On</td>
<td>Displays the date on which the material flow status was created.</td>
</tr>
<tr>
<td>Updated On</td>
<td>Displays the last date on which the material flow was updated.</td>
</tr>
</tbody>
</table>
Manual, when you want to enable Producer Agents to upload content or specify its location manually.

For more information on automated and manual deposit, see Managing Generic Material Flows in the Rosetta Overview Guide.


4. Complete the fields as described in the following table:
### Table 19. Add Material Flow: Step 2 Page Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Material Flow Definition</strong>  pane:</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name of the material flow.</td>
</tr>
<tr>
<td>Description/Instructions</td>
<td>The description of the material flow.</td>
</tr>
</tbody>
</table>
| Status                        | The material flow’s status:  
  - **Active** - The material flow is available to associated Producer Agents.  
  - **Inactive** - The material flow is not available to associated Producer Agents. |
| Sampling Rate                 | The percentage of Producer Agent content that needs to be reviewed by staff users:  
  - **100%** - All deposited content needs to be reviewed by Assessors and Arrangers.  
  - **Less than 100%** - The specified percentage of content needs to be reviewed by an Approver. |
| Internal                      | No – available to all users  
  - Yes – available to staff users only |
| Assertion of Copyrights       | The copyright boilerplate that must be displayed to Producer Agents. |
| Status Date                   | Displays the last date on which the material flow was updated. |
| Material Type                 | The types of content that Producer Agents can deposit. |

**Note:**  
This drop-down list contains the material types that were configured in advance by a Deposit Manager or a Rosetta Administrator. For more information, see the Rosetta Configuration Guide.
### Technical Definitions pane:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Select Content Structure      | The content structure that is available to associated Producer Agents when they deposit content automatically.  

**NOTE:** This drop-down list contains the content structure templates that were configured in advance by a Deposit Manager or Back Office Administrator. For more information, see Configuring Content Structures on page 99 on page 99. |

| Select Submission Format      | The submission format that Producer Agents can use when they upload files.  

**NOTE:** This drop-down list contains the submission formats that were configured in advance by a Deposit Manager or Back Office Administrator. For more information, see Configuring Submission Formats on page 86 on page 86. |

| Automatically extract compressed files | If this check box is selected, the system automatically extracts submitted compressed files, in accordance with the automatic decomposition rules (see Configuring Automatic Decomposition Rules in the Rosetta Configuration Guide). |

**NOTE:** For automated material flows, submission format validation (file max/min number, size, extension.) will be ignored for compressed files. |

### Descriptive Definitions pane:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Select Metadata Form           | The metadata form that Producer Agents must complete when they deposit content.  

**NOTE:** This drop-down list contains the metadata forms that were configured in advance by a Deposit Manager or Back Office Administrator. For more information, see Configuring Metadata Forms on page 73.
Table 19. Add Material Flow: Step 2 Page Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upload Source Metadata files</td>
<td>Select this option to allow a Producer Agent to upload source metadata files when depositing IEs in metadata structures other than Dublin Core. This allows your institution to store complete information for IEs conforming to complex and custom metadata schemes and to view this data in the Web editor.</td>
</tr>
</tbody>
</table>

Access Rights Form pane:

<table>
<thead>
<tr>
<th>Access Rights list</th>
<th>Select the options that must be available to Producer Agents when they deposit content. Selections are made by double-clicking a list item or clicking the plus (+) sign beside an item. To remove an item, double-click it from the selected box or click the minus sign (-) beside it.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE:</strong></td>
<td>The Access Rights list box contains the options that were configured by a Data Manager. You cannot update this list from this page.</td>
</tr>
</tbody>
</table>

Retention Policy Form pane:

<table>
<thead>
<tr>
<th>Retention Policy list</th>
<th>Select a retention policy from the list of available policies. If you want the material to be saved indefinitely, select the No Retention Policy option. Selections are made by double-clicking a list item or clicking the plus (+) sign beside an item. To remove an item, double-click it from the selected box or click the minus sign (-) beside it.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE:</strong></td>
<td>The Retention Policy list contains the options that were configured by a Data Manager. You cannot update this list from this page.</td>
</tr>
</tbody>
</table>

5 Click **Save**.

The List of Material Flows page opens. The list contains the newly added material flow. The material flow is added to the Rosetta system.

**Activating and Deactivating Material Flows**

Deposit Managers can deactivate a material flow when they need to finish configuring the material flow settings, or if they want to temporarily disable the material flow without deleting it. Deposit Managers can activate an inactive material flow at any time.
Deposit Managers cannot deactivate a material flow when a Producer Agent is using it to deposit content. Deposit Managers can deactivate the material flow only after the deposit process has been completed and no other Producer Agent is using the material flow.

On the List of Material Flows page, the material flow’s status is indicated by the check mark in the **Active** column:

- Yellow - The material flow is active.
- Grey - The material flow is inactive.

**To activate or deactivate a material flow:**

1. On the List of Material Flows page (see Accessing the List of Material Flows Page on page 155), locate the material flow that you want to activate or deactivate.
2. In the **Active** column, click the check mark. The check mark in the **Active** column indicates the new status.

   The material flow status is changed from active to inactive, or from inactive to active.

**Duplicating a Material Flow**

Deposit Managers can duplicate material flows. This is especially useful when creating a new material flow. It is often faster to duplicate an existing material flow and modify it, than to create a new material flow.

**To duplicate a material flow:**

On the List of Material Flows page (see Accessing the List of Material Flows Page on page 155), locate the material flow you want to duplicate and click **Duplicate**. The Rosetta system creates a copy of the material flow.

An exact copy of the material flow is added to the List of Material Flows page. The Rosetta system automatically labels the new material flow with the name **Copy of** followed by the name of the original material flow.

**Updating a Material Flow**

Deposit Managers can modify material flow details at any time. For example, a Deposit Manager can add more submission formats or metadata forms.
To update a material flow:

1. On the List of Material Flows page (see Accessing the List of Material Flows Page on page 155), locate the material flow you want to update and click Update. The Update Material Flow Details page opens.
2. Modify the fields as required.
3. To save your changes and return to the List of Material Flows page, click Save. The List of Material Flows page opens.

The material flow details are updated.

Deleting a Material Flow

A Deposit Manager can delete a material flow when it is not used by any Producers and the Deposit Manager does not want to maintain the material flow.

Deposit Managers cannot delete a material flow while a Producer Agent is using it to deposit content. Deposit Managers can delete the material flow only after the deposit process has been completed and no other Deposit Manager is using the material flow.

To delete a material flow:

1. On the List of Material Flows page (see Accessing the List of Material Flows Page on page 155), locate the material flow you want to delete and click More. Additional options are displayed.
2. Click Delete. The confirmation page opens.
3. Click OK. The material flow is removed from the list.

The material flow is removed from the Rosetta system. Producer Agents can no longer use it when they deposit content.
Managing Generic Producer Profiles

This section contains:

- About Managing Producer Profiles on page 165
- Accessing the List of Producer Profiles Page on page 165
- Adding a Producer Profile on page 167
- Activating and Deactivating Producer Profiles on page 168
- Updating a Producer Profile on page 169
- Duplicating a Producer Profile on page 170
- Deleting a Producer Profile on page 170

About Managing Producer Profiles

Deposit Managers can manage Producer profiles as a single unit. For example, a Deposit Manager can activate a Producer profile or add a new profile. (For general information on Producer profiles, see Understanding Rosetta Users in the Rosetta Overview Guide.)

Deposit Managers work with Producer profiles using the List of Producer Profiles page (see Accessing the List of Producer Profiles Page on page 165).

Accessing the List of Producer Profiles Page

The List of Producer Profiles page enables Deposit Managers to work with Producer profiles and perform activities, such as adding new Producer profiles, updating Producer profile details, and activating Producer profiles.

To access the Producer Profile List page, from the Rosetta rollover menu, follow the path Producers > Deposit Arrangements > Manage Producer Profiles. The Producer Profile List page opens (Figure 84).
This page displays columns containing the following information:

Table 20. Producer Profile List Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Indicates the Producer profile status:</td>
</tr>
<tr>
<td></td>
<td>▪ Yellow - The Producer profile is active.</td>
</tr>
<tr>
<td></td>
<td>▪ Grey    - The Producer profile is inactive.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name of the Producer profile.</td>
</tr>
<tr>
<td>Type</td>
<td>Displays the type of the Producer profile:</td>
</tr>
<tr>
<td></td>
<td>▪ Generic - The Rosetta system automatically assigns the generic settings that are defined by a Deposit Manager.</td>
</tr>
<tr>
<td></td>
<td>▪ Personalized - A Negotiator defines and assigns personalized settings.</td>
</tr>
<tr>
<td>Update Date</td>
<td>Displays the last date on which the Producer profile was updated.</td>
</tr>
</tbody>
</table>
Adding a Producer Profile

Deposit Managers can add a generic Producer profile to define how the associated Producer Agents deposit content. When adding a profile, Deposit Managers configure settings on the following pages:

- On the Producer Profile page, deposit control settings are defined.
- On the Material Flows page, material flows that are associated with the Producer profile are defined.

To add a generic Producer profile:

1. On the Producer Profile List page (Producers > Deposit Arrangements > Manage Producer Profiles), above the Producer profiles list, click the Add Producer Profile button. The Producer Profile page opens.

   Figure 85: Producer Profile Page, Producer Profile Tab

   ![Producer Profile Page](image)

2. Define the deposit control settings, as described in Configuring Deposit Control Settings on page 71.

3. Click Save.
   
   The deposit control settings are saved in the Rosetta system.

4. Click the Material Flows tab.
   
   The Material Flow List page opens.
5. Associate material flows with the Producer profile, as described in Associating Material Flows with a Generic Producer Profile on page 173. The selected material flows are displayed in the Material Flow Selected pane.

6. Click Save.

The Producer profile is added to the Rosetta system.

**Activating and Deactivating Producer Profiles**

Deposit Managers can deactivate a Producer profile when they need to finish configuring the profile settings, or if they want to temporarily disable the profile without deleting it. Deposit Managers can activate an inactive profile at any time.
Deposit Managers cannot deactivate a profile if it is associated with one or more Producers.

On the Material Flows List page, the status of the material flow is indicated by the check mark in the **Active** column:
- Yellow - The material flow is active.
- Grey - The material flow is inactive.

**To activate or deactivate a Producer profile:**

1. On the List of Producer Profiles page (**Producers > Deposit Arrangements > Manage Producer Profiles**), locate the Producer profile that you want to activate or deactivate.

2. In the **Active** column, click the check mark. The check mark in the **Active** column indicates the new status.

   The Producer profile status is changed from active to inactive, or from inactive to active.

### Updating a Producer Profile

Deposit Managers can update an existing Producer profile when they need to change the profile settings. When updating a Producer profile, Deposit Managers can change:

- the way in which the deposit control settings are defined
- the material flows that are associated with the Producer profile

**To update a Producer profile:**

1. On the List of Producer Profiles page (**Producers > Deposit Arrangements > Manage Producer Profiles**), locate the Producer profile that you want to update and click **Update**. The Update Producer Profile page opens.

2. Modify the Producer profile details on the following tabs:
   - **Producer Profile**, when you want to modify the deposit quotas and the default sampling rate. (For more information, see Configuring Deposit Control Settings on page 71.)
   - **Material Flows**, when you want to associate more material flows with the profile, delete material flows, or activate and deactivate material flows. (For more information, see Configuring Material Flow Infrastructure on page 85.)

3. To save the Producer profile and return to the List of Producer Profiles page, click **Save**.
The Producer profile is updated in the Rosetta system.

**Duplicating a Producer Profile**

Deposit Managers can duplicate Producer profiles. This is especially helpful when creating a new Producer profile. It is often faster to duplicate an existing profile and modify it, than to create a new profile.

**To duplicate a Producer profile:**

On the List of Producer Profiles page (Producers > Deposit Arrangements > Manage Producer Profiles), locate the Producer profile you want to duplicate and click Duplicate. The Rosetta system creates a copy of the profile.

An exact copy of the Producer profile is added to the List of Producer Profiles page. The Rosetta system automatically labels the new Producer profile with the name Copy of followed by the name of the original Producer profile.

**Deleting a Producer Profile**

A Deposit Manager can delete a Producer profile only when it is not associated with any Producers and the Deposit Manager does not want to maintain the Producer profile.

**To delete a Producer profile:**

1. On the List of Producer Profiles page (Producers > Deposit Arrangements > Manage Producer Profiles), locate the Producer profile that you want to delete.
2. Click More. Additional options are displayed.
3. Click Delete. The confirmation page opens.
4. Click OK. The profile is removed from the list of the Producer profiles.

The Producer profile is deleted from the Rosetta system.
Managing Material Flows Associated with a Producer Profile

This section contains:
- About Managing Material Flows on page 171
- Accessing the Material Flows List Page on page 171
- Associating Material Flows with a Generic Producer Profile on page 173
- Activating and Deactivating Material Flows on page 174
- Removing Material Flows from a Producer Profile on page 174

About Managing Material Flows

Deposit Managers manage material flows that are assigned to a generic Producer profile to define how associated Producer Agents deposit content. For example, a Deposit Manager can activate a material flow for, or remove a material flow from, a Producer profile. (For general information on material flows, see Material Flows in the Rosetta Overview Guide.)

Deposit Managers work with material flows associated with a Producer profile using the Material Flows List page.

Accessing the Material Flows List Page

The Material Flows List page enables Deposit Managers to control the material flows that are associated with a generic Producer profile.
To access the Material Flows List page:

1. From the Rosetta rollover menu, click **Producers > Deposit Arrangements > Manage Producer Profiles**.
   
The Producer Profile List opens.

2. Locate the Producer profile with which you want to work and click its name.
   
The View Producer Profile page opens.

3. Click the **Material Flows** tab. The Manage Materials Flows (Generic Producer Profile) page opens.

---

The Material Flows List page consists of two panes:

- The **Material Flow Selected** pane lists the material flows that are associated with the Producer profile. This pane displays columns containing the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Indicates the material flow's status:</td>
</tr>
<tr>
<td></td>
<td>• Yellow - The material flow is active.</td>
</tr>
<tr>
<td></td>
<td>• Grey - The material flow is inactive.</td>
</tr>
</tbody>
</table>
The Material Flow Pool pane lists all available material flows that you can associate with the Producer profile. This pane displays the same columns as the Material Flow Selected pane (see above table).

### Table 21. Material Flow Selected Pane Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the material flow.</td>
</tr>
<tr>
<td>Template</td>
<td>Displays the type of template on which the material flow is based:</td>
</tr>
<tr>
<td></td>
<td>- Manual - Producer Agents can use the material flow to deposit content manually.</td>
</tr>
<tr>
<td></td>
<td>- Automatic - Content is automatically deposited to the Rosetta system from a remote server or local computer.</td>
</tr>
<tr>
<td>Content Structure</td>
<td>Displays the material flow content structure.</td>
</tr>
<tr>
<td>Acquire Method</td>
<td>Indicates how Producer Agents can deposit content:</td>
</tr>
<tr>
<td></td>
<td>- HTTP - Producer Agents deposit content manually</td>
</tr>
<tr>
<td></td>
<td>- FTP or NFS - Content is automatically deposited to the Rosetta system from a remote server (through FTP) or local computer (through NFS)</td>
</tr>
<tr>
<td>Status Date</td>
<td>Displays the last date on which the material flow status was changed.</td>
</tr>
</tbody>
</table>

### Associating Material Flows with a Generic Producer Profile

You can associate material flows with generic Producer profiles to define how Producer Agents can deposit content.

**To associate material flows with a generic Producer profile:**

1. On the Material Flows List page (see Accessing the Material Flows List Page on page 171), in the Material Flow Pool pane, select the material flows you want to associate with the profile by selecting the appropriate check boxes.

2. Click Add Selected. The selected material flows are displayed in the Material Flow Selected pane.
The Producer Agents associated with the Producer can now deposit content using the material flows you selected.

**Activating and Deactivating Material Flows**

Deposit Managers can deactivate a material flow if they need to finish configuring the material flow settings, or if they want to temporarily disable the material flow without deleting it. Deposit Managers can activate the inactive material flow at any time.

**NOTE:**
Deposit Managers cannot deactivate a material flow when a Producer Agent is using it to deposit content. Deposit Managers can deactivate the material flow only after the deposit process is complete and no other Producer Agent is using the material flow.

On the Material Flows List page, the status of the material flow is indicated by the check mark in the **Active** column:

- Yellow - The material flow is active.
- Grey - The material flow is inactive.

**To activate or deactivate a material flow:**

1. On the Material Flows List page (see Accessing the Material Flows List Page on page 171), in the **Material Flow Selected** pane, locate the material flow that you want to activate or deactivate.
2. In the **Active** column, click the check mark. The check mark in the **Active** column indicates the new status.

The material flow status is changed from active to inactive, or from inactive to active.

**Removing Material Flows from a Producer Profile**

Deposit Managers can remove a material flow from a generic Producer profile when they do not want any Producer Agents to use it for depositing content.

**NOTE:**
Deposit Managers cannot remove a material flow when a Producer Agent is using it to deposit content.
To remove a material flow from a Producer profile:

1. On the Material Flows List page (see Accessing the Material Flows List Page on page 171), in the Material Flow Selected pane, locate the material flow you want to remove and click Remove.

2. Click Save. The material flow is removed from the list of material flows associated with the Producer profile.

Producer Agents associated with the Producer cannot use the material flow to deposit content.
This section contains:
- Understanding SIP Processing on page 177
- SIP Routing Rules on page 182
- Defining SIP Processing Configuration on page 186
- Configuring SIP Routing Rules on page 190

**Understanding SIP Processing**

SIP processing settings define how a submission information package (SIP) is moved between processing stages on the Staging Server, and how this SIP is processed at each stage.

The SIP processing workflow begins when a SIP is moved from the Deposit Server to the Staging Server, and ends when a SIP is moved from the Staging Server to the Permanent Repository. At each stage, the Rosetta system performs a series of tasks, as described in the table below.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Approval</td>
<td>After files are uploaded to the Staging Server, the Rosetta system runs a series of tasks, known as a validation stack, to identify technical problems, such as viruses or corrupted files, and extract technical metadata. For more information, see Pre-Approval Stage on page 178.</td>
</tr>
</tbody>
</table>
A Deposit Manager defines the following settings to configure SIP processing:

- **SIP processing configuration**, which specifies how the SIP is processed at each stage. A Deposit Manager can select a task chain for each stage from the predefined list.

  A Deposit Manager can create multiple SIP processing configurations for different SIPs.

  For more information about SIP processing configuration, see **Defining SIP Processing Configuration** on page 186.

- **SIP routing rules**, which specify criteria for choosing the SIP processing configuration that must be applied to the specific SIP.

  When creating SIP routing rules, a Deposit Manager defines input parameters (such as material type and Producer) and corresponding output parameters (such as SIP processing configuration that must be applied to the SIP and approval group that reviews the SIP).

  For more information about SIP routing rule configuration, see **Configuring SIP Routing Rules** on page 190.

### Pre-Approval Stage

At the pre-approval stage, the Rosetta system performs a task chain known as a validation stack. The validation stack tasks verify that the files uploaded to the
Staging Server do not have any technical problems such as viruses or corruption.

The validation stack task chain can contain the following tasks:

- **Fixity Check** on page 179
- **Virus Check** on page 180
- **Format Check** on page 180
- **Technical Metadata Extraction** on page 180
- **Risk Extraction** on page 181

A Deposit Manager can configure multiple validation stack task chains for different SIP configurations. For example, one SIP configuration can use a validation stack that performs all the tasks, while another SIP configuration can use a validation stack that does not perform a virus check.

The Rosetta system moves only those files that successfully pass the validation stack checks to the next processing stage.

Otherwise, the Rosetta system marks the failed files as problematic and forwards them to a Technical Analyst. (For more information on Technical Analysts, see Technical Analysts in the *Staff User’s Guide*.)

**Fixity Check**

The fixity check task verifies that the files uploaded to the Staging Server are not corrupted. This task generates a checksum, which is stored in the file metadata. When the file is moved to the Staging Server, the Rosetta system compares the actual checksum with the original checksum using hash algorithms, such as CRC32 or MD5.

A fixity check can be run without providing an algorithm as a parameter. In this case Rosetta simply verifies the file with the expected name exists in storage without accessing the file to determine its integrity.

Checksums may be provided in the deposited METS. In such cases, Rosetta validates the checksum values. If the checksum is the same type that Rosetta runs and the value is found to be valid, Rosetta overwrites the dnx section with information from the internal outcome. If validation fails, the SIP is routed to the TA work area with an appropriate error message.

An example of such a checksum value in the deposited METS is as follows:
Virus Check
The virus check task verifies that the files uploaded to the Staging Server do not contain any viruses. To perform the virus check, the task runs specialized software, such as McAfee Virus Scan.

Format Check
The format check task automatically identifies the format of the file by analyzing its content. If the extension of the file does not correspond to the format that the task identified, the Rosetta system generates an error.

To perform the format check, the task uses the DROID utility.

Technical Metadata Extraction
The technical metadata generation task produces technical metadata about a file (such as file size and creation date). The Rosetta system generates this metadata based on the metadata embedded into the file, as well as on the information that the system identifies automatically.

To generate technical metadata, the task uses a utility such as JHOVE or the NLNZ MD Extractor. Each of these utilities generates technical metadata for different formats. Deposit Managers associate the metadata generation utilities with formats using the Format to MD Extraction mapping table.
Risk Extraction

As part of the validation stack phase in SIP processing, Rosetta determines whether the extracted technical metadata has a risk associated with its format. If it does, the system runs the risk extractor tool and saves the output in the HDeStreamRef table. The extracted technical metadata is stored in a way that allows the risk analysis job to gather the information and summarize it in risk reports.

After a validation stack is performed, the system modifies information about the SIP in the DNX section of the METS file.

Approval Stage

After a SIP successfully passed the validation stack checks (see Pre-Approval Stage on page 178), the Rosetta system forwards this SIP to one of the following routes:

- An Assessor and Arranger
- An Approver. The amount of content to be reviewed by an Approver is determined by the sampling rate parameter, which is defined at the material flow level. Staff users can mandate one of the following:
  - 100% - All content must be reviewed by an Approver
  - Less than 100% - The specified amount of content must be reviewed by an Approver. The rest of the content is moved to the next processing stage without an Approver’s review.

Enrichment Stage

At the post-approval stage, the Rosetta system prepares the SIPs for storage in the Permanent Repository. For example, the Rosetta system can generate derivative copies and thumbnails for intellectual entities (IEs), as well as synchronize metadata stored in a collection management system with the IE metadata.

If a SIP fails to pass the post-approval stage, the Rosetta system forwards this SIP to a Technical Analyst. (For more information on Technical Analysts, see Technical Analysts in the Rosetta Staff User’s Guide.)

Move to Permanent Stage

After the Rosetta system performs the enrichment, the SIP is moved to the Permanent Repository. The Permanent Repository is intended to store Producer Agent content that was approved by staff users for permanent preservation. As a result, SIPs that are stored in the Permanent Repository cannot be updated, deleted, or rearranged.
For general information on storing the SIPs in the Permanent Repository, see Storage Components in the Rosetta Overview Guide.

**SIP Routing Rules**

Deposit Managers can determine how SIP submission errors are handled by the system. An error in a SIP submission may cause the SIP to be rejected or it may be routed to a Technical Analyst for further evaluation.

To access the list of SIP routing rules, follow the path from the Rosetta rollover menu: Submissions > Advanced Tools > SIP Routing Rules.

![SIP Rule List](image)

The default rule for error handling appears in the list along with any other SIP error handling rules your institution has added. You can work with rules in one of the following ways, all of which take you to the Rule Details page (SIP Routing Rules - Rule Details on page 183).

- To add a new rule, click the Add Rule button.
- To edit an existing rule, click the Update text of the rule’s row.
- To create a rule based closely on an existing rule, click the Duplicate text of the rule’s row.

You can also delete a rule by clicking the Delete text of the rule’s row.
On the Rule Details page, you can add or edit the **Name** or **Description** fields in the Rule Editor section.

For the Input General Parameters section, create or edit the conditions for the input that will cause the rule to take effect. Include the values that define the parameters.

Refer to the **Operators Used in Rule Parameters** section for detailed information on commonly used operators.
Operators Used in Rule Parameters

The following operators are used for specific types of parameter data.

String Values

String values are words that are not separated by a comma (,), for example, one Producer name (John Smith), one MIME type (audio/mp3), one error code, one Format ID). String values use the following operators:

- Equal – The string and the input value must match exactly.
- Contains – The string and the input value must match partially with the ‘*’ character.

List of Strings

A list of strings is a list of string values separated by a comma (,) sometimes populated by a widget. Lists of strings use the following operators:

- List Contains – used when each error returned should match exactly a single given error in the rule.
- List Equals - Used when the order of the items in the list and the list itself should match exactly. For example, a rule defined as “Invalid page dictionary object, Invalid object number in cross-reference stream” will match to the actual output from JHOVE – “Invalid page dictionary object, Invalid object number in cross-reference stream.”

Numeric Fields

Numeric fields (for example, file size) use numbers as matching and comparison values.

- Greater Than (>) – The input value should be greater than the parameter value.
- Less Than (<) - The input value should be less than the parameter value.
- Equal (=) - The input value should be equal to the parameter value.
- Not Equal (!=) - The input value should be not equal to the parameter value.

Date Fields

Date fields (such as Creation Date) compare date values with time operators.

- After – The input date should be later than the parameter date value.
- Before - The input date should be earlier than the parameter date value.
- Equal (=) - The input date should be the same as the parameter date value.
Not Equal (! =) - The input date should not be the same as the date parameter value.

**Any**

All fields can use this operator for indicating that any input value will be accepted by the rule. For example, if the ‘Any’ operator is used in the Producer Name field, the rule can match all Producers.

The following table summarizes the possibilities for matching between the rule parameter values and the run-time values:

<table>
<thead>
<tr>
<th>Run-time Value</th>
<th>Operator</th>
<th>Possible Rule Values</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demo Producer</td>
<td>Equal</td>
<td>Demo Producer</td>
<td>Match</td>
</tr>
<tr>
<td>Demo Producer</td>
<td>Contains</td>
<td>Demo*</td>
<td>Match</td>
</tr>
<tr>
<td>image/tiff or image/bmp</td>
<td>In List</td>
<td>Image/tiff, image/bmp</td>
<td>Match</td>
</tr>
<tr>
<td>image/tiff, image/bmp</td>
<td>List Equals</td>
<td>Image/tiff, image/bmp</td>
<td>Match</td>
</tr>
<tr>
<td>grey or gray</td>
<td>In List with Regular Expression</td>
<td>gr[ea]y</td>
<td>Match</td>
</tr>
</tbody>
</table>
| 12345          | <, >, =, !=     | 10000                | < - No match  
               |                  | > - Match          
               |                  | = - No match      
               |                  | != - Match        |
               |                  | After - No match  
               |                  | = - Match         
               |                  | != - No match     |

To define Boolean logic when using multiple conditions, select one of the following options between conditions:

- OR
- AND (default)
NOTE:
The Boolean connector between different types of attributes (for example, IE Attributes and File Attributes) is always AND.

Defining SIP Processing Configuration

The SIP processing configuration determines how the SIP is processed at each stage. Deposit Managers define this on the SIP Processing Configuration List page.

To access this page, follow the path from the Rosetta rollover menu: Submissions > Advanced Tools > SIP Processing Configuration List.

The following actions can be performed on the SIP Processing Configuration List page:

- Adding a SIP Processing Configuration on page 187
- Updating a SIP Processing Configuration on page 188
- Duplicating a SIP Processing Configuration on page 189
- Deleting a SIP Processing Configuration on page 189
- Activating and Deactivating a SIP Processing Configuration on page 190
Adding a SIP Processing Configuration

Deposit Managers can add a new SIP processing configuration.

To add a SIP processing configuration:

1. On the List of SIP Processing Configuration page (see Defining SIP Processing Configuration on page 186), click Configuration. The SIP Processing Configuration page opens.

![SIP Processing Configuration Page](image)
2 Complete the fields as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the SIP processing configuration.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the SIP processing configuration.</td>
</tr>
<tr>
<td>Priority</td>
<td>Select a priority:</td>
</tr>
<tr>
<td></td>
<td>- High – Process ASAP</td>
</tr>
<tr>
<td></td>
<td>- Normal – SIPs are queued up to 1 hour</td>
</tr>
<tr>
<td></td>
<td>- Low – SIPs are queued up to 6 hours</td>
</tr>
<tr>
<td>Validation Stack Routine</td>
<td>The list of available routines that can be executed when the SIP enters the validation stage.</td>
</tr>
<tr>
<td>Approval</td>
<td>The list of available options for the human stage of the SIP processing (for example, reviewing a SIP by an Approver). The following options are available:</td>
</tr>
<tr>
<td></td>
<td>- Assessor + Arranger</td>
</tr>
<tr>
<td></td>
<td>- Approver</td>
</tr>
<tr>
<td>Enrichment Routine</td>
<td>The list of available routines that can be executed when the SIP enters the enrichment stage.</td>
</tr>
<tr>
<td>Email Notification</td>
<td>Whether you want notification of the results emailed to the staff user</td>
</tr>
</tbody>
</table>

**NOTE:**

All fields with an asterisk (*) are mandatory.

3 Click **Save**.
The new SIP processing configuration is saved in the Rosetta system.

**Updating a SIP Processing Configuration**

Deposit Managers can update an existing SIP processing configuration. The parameters that can be changed include the validation stack routine, the human approval process, and the enrichment routine.

**To update a SIP processing configuration:**

1 On the List of SIP Processing Configuration page (see **Defining SIP Processing Configuration** on page 186), locate the SIP processing...
configuration with which you want to work and click Update. The SIP Processing Configuration page opens.

2  Modify the fields as described in Table 24.

3  Click Save.

The updated SIP processing configuration is saved in the Rosetta system.

Duplicating a SIP Processing Configuration

Deposit Managers can duplicate an existing SIP processing configuration. This is especially helpful when creating a new SIP processing configuration. It is often faster to duplicate an existing SIP processing configuration and then modify it, than to create a new configuration.

To duplicate a SIP processing configuration:

On the List of SIP Processing Configuration page (see Defining SIP Processing Configuration on page 186), locate the SIP processing configuration that you want to duplicate and click Duplicate.

An exact copy of the SIP processing configuration is added to the List of SIP Processing Configuration page. The Rosetta system automatically labels the new SIP processing configuration with the name Copy of followed by the name of the original SIP processing configuration.

Deleting a SIP Processing Configuration

Deposit Managers can delete an existing SIP processing configuration.

NOTE: Any SIPs in progress that are associated with a deleted SIP processing configuration will complete their processing according to the deleted configuration’s instructions.

To delete a SIP processing configuration:

1  On the List of SIP Processing Configuration page (see Defining SIP Processing Configuration on page 186), locate the SIP processing configuration that you want to delete and click More. Additional options are displayed.

2  Click Delete. The Delete Confirmation page opens.

3  Click OK.

The system removes the SIP processing configuration from the List of SIP Processing Configuration page.
Activating and Deactivating a SIP Processing Configuration

Deposit Managers can activate or deactivate an existing SIP processing configuration.

On the List of SIP Processing Configuration page, the current status is indicated by the check mark in the Active column:

- Yellow - The SIP processing configuration is active.
- Grey - The SIP processing configuration is inactive.

**NOTE:**
Any SIPs in progress that are associated with a deactivated SIP processing configuration do not get promoted to the next processing stage.

To activate or deactivate a SIP processing configuration:

1. On the List of SIP Processing Configuration page (see Defining SIP Processing Configuration on page 186), locate the SIP processing configuration that you want to activate or deactivate.

2. In the Active column, click the check mark. The check mark in the Active column indicates the new status.

The SIP processing configuration is changed from active to inactive or inactive to active.

Configuring SIP Routing Rules

SIP routing rules define the SIP processing configuration that must be applied to the specific SIP.

Deposit Managers can define SIP routing rules using the List of SIP Routing Rules page. To access this page, follow the path from the Rosetta rollover menu: Submissions > Advanced Tools > SIP Routing Rules.
The following actions can be performed on the SIP Routing Rules List page:

- **Adding a SIP Routing Rule** on page 191
- **Updating a SIP Routing Rule** on page 193
- **Duplicating a SIP Routing Rule** on page 194
- **Deleting a SIP Routing Rule** on page 194
- **Activating and Deactivating a SIP Routing Rule** on page 194

### Adding a SIP Routing Rule

Deposit Managers can add a new SIP routing rule. When adding a new SIP routing rule, Deposit Managers provide information in two panes:

- In the **Input Parameters** pane, matching criteria parameters are defined.
- In the **Output Parameters** pane, result parameters are defined.

The Rosetta system determines the input and output parameters. Deposit Managers cannot add or delete these parameters.

The logical relationship between the input parameters or the output parameters is AND. Deposit Managers cannot change the logical relationship between the parameters.
To add a SIP routing rule:


2. In the Input General Parameters pane, complete the following fields:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>The list of available operators.</td>
</tr>
</tbody>
</table>

**NOTE**: The operator describes the logical relationship between the parameter and the value. The values in the drop-down list vary according to the type of parameter. For more details, see Operators Used in Rule Parameters on page 184.
Chapter 14: SIP Processing, Configuration, and Routing Rules

3 In the Output Parameters pane, complete the following fields:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>The value for the parameter. For example, the department output parameter must contain “Academic.”</td>
</tr>
</tbody>
</table>

**NOTE:**
The value is either a text input box or a drop-down list, depending on the type of parameter.

4 Click Save.
The new SIP routing rule is saved in the Rosetta system.

### Updating a SIP Routing Rule

Deposit Managers can update both the input and output parameter information of an existing SIP routing rule.

**To update a SIP routing rule:**

1 On the List of SIP Routing Rules page (see Configuring SIP Routing Rules on page 190), locate the SIP routing rule with which you want to work and click Update. The Routing Rule Editor page is displayed.

2 In the Input General Parameters pane, modify the fields that you want to update.

3 In the Output Parameters pane, modify the fields that you want to update.

4 Click Save.
The updated SIP routing rule information is saved in the Rosetta system.
Duplicating a SIP Routing Rule

Deposit Managers can duplicate an existing SIP routing rule. This is especially helpful when creating a new SIP routing rule. It is often faster to duplicate an existing SIP routing rule and then modify it than to create a new SIP routing rule.

To duplicate a SIP routing rule:

On the List of SIP Routing Rules page (see Configuring SIP Routing Rules on page 190), locate the SIP routing rule you want to duplicate and click Duplicate. An exact copy of the SIP routing rule is added to the List of SIP Routing Rules page. The Rosetta system automatically labels the new SIP routing rule with the name Copy of followed by the name of the original SIP routing rule.

Deleting a SIP Routing Rule

Deposit Managers can delete an existing SIP routing rule.

To delete a SIP routing rule:

1. On the List of SIP Routing Rules page (see Configuring SIP Routing Rules on page 190), locate the SIP routing rule you want to delete and click Delete. The confirmation window is displayed.
2. Click OK.

The SIP routing rule is deleted from the Rosetta system.

Activating and Deactivating a SIP Routing Rule

Deposit Managers can activate or deactivate an existing SIP routing rule. After a routing rule is deactivated, it is no longer used by the Rosetta system.

On the List of SIP Routing Rules page, the current status is indicated by the check mark in the Active column:

- Yellow - The SIP routing rule is active.
- Grey - The SIP routing rule is inactive.

To activate or deactivate a SIP routing rule:

1. On the List of SIP Routing Rules page (see Configuring SIP Routing Rules on page 190), locate the SIP routing rule that you want to activate or deactivate.
2. In the Active column, click the check mark. The check mark in the Active column indicates the new status.
The SIP routing rule is changed from active to inactive, or inactive to active, depending on the previous state of the rule.
OAI-PMH Harvester

This section contains:
- Overview on page 197
- Loading New Objects on page 197
- Updating Existing Objects on page 198
- Viewing the OAI-PMH Harvest Job History on page 203

Overview

The OAI-PMH Harvester allows users to load objects into Rosetta directly from an OAI-PMH digital repository. It has two modes of operation:

- Loading new objects into Rosetta
- Updating objects already existing in Rosetta – This mode can be divided into two scenarios:
  - Content originally created in Rosetta – This typically means that the metadata was harvested and enriched by an external system and is now being passed back to Rosetta for harvesting. In this case, the match is on the Rosetta PID.
  - Content originally created outside of Rosetta – This refers to content that was loaded previously into Rosetta but continues to be maintained in an external system. The latter is now sending updates to those previously loaded records. In this case, the match is on the original system ID, as stored in the DNX.

Loading New Objects

When loading new objects, the OAI-PMH Harvester job creates SIPs for loading with a Submission Job (see Submission Jobs on page 257). Users can choose to
create SIPs in either METS or Dublin Core format and schedule harvests to run at given time intervals. You can use this job for migration purposes, or for ongoing loading from an external repository into Rosetta (for example, to preserve data managed by another repository).

**Updating Existing Objects**

When updating existing objects, indicate if the content being harvested is of Rosetta origin or an external repository origin. If the content is of external origin, indicate the material flow to be used when loading new objects. If the content is of Rosetta origin, you can indicate a qualifier and string with which to match. Upon matching, the harvester can either create an update MD package with the new (transformed) metadata or ignore the changes. You can select one of the existing Update MD jobs for which the harvester creates a package or select an option to ignore the record.

**Creating the OAI_PMH Harvest Job**

This section describes the procedure for creating an OAI-PMH harvest job.
To create an OAI-PMH new harvest job:

1. Under **Producers > Advanced Tools**, select **OAI-PMH Harvester**, and click **Add Job**.

2. Enter a name for your job (for example, Fedora Harvest)
3 Schedule your job.

**NOTE:**
Rosetta appends the previously run and current timestamps to OAI-PMH harvest requests. This is not affected by your scheduling preferences.

4 Enter the OAI-PMH harvesting parameters as described in the following table:

Table 27. OAI-PMH Harvesting Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Explanation</th>
<th>Mandatory?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base URL</td>
<td>The OAI-PMH server base URL (for example: host:port/oaiprovider/request)</td>
<td>Yes</td>
</tr>
<tr>
<td>Set</td>
<td>The OAI-PMH selective harvesting setSpec element</td>
<td>No</td>
</tr>
<tr>
<td>Metadata Prefix</td>
<td>The OAI-PMH metadataPrefix element</td>
<td>Yes</td>
</tr>
<tr>
<td>User Name</td>
<td>Used for OAI-PMH servers that require login. If defined, a basic authentication header is sent with the request</td>
<td>No</td>
</tr>
<tr>
<td>Password</td>
<td>Used for OAI-PMH servers that require login. If defined, a basic authentication header is sent with the request</td>
<td>No</td>
</tr>
<tr>
<td>Ignore Last Run Time</td>
<td>Select to disregard the last run time.</td>
<td>No</td>
</tr>
<tr>
<td>Match</td>
<td>Select from the drop-down list:</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>- External Repository Origin – Imported records originate in an external repository</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Rosetta Origin – Imported records originate in Rosetta and are being reimported for updating</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Do not match – All records are imported, including duplicates</td>
<td></td>
</tr>
<tr>
<td>Qualifier</td>
<td>(Available with Rosetta Origin) Identifier of the DC record.</td>
<td>No</td>
</tr>
</tbody>
</table>
You can test the job to test connectability and record transformation and match per selected job configuration. From the Record drop-down list, select one of the following options and click Test:

- First – the first record
- Random – Rosetta picks a record at random
- By Identifier – Enter the ID of the record that you want Rosetta to test

If the test is successful, the following occurs:

- Success appears in the Status field.
- The source record appears in the Source field.
- The transformed record appears in the Transformed Record field.
- If a match is found, the IE PID of the matched record appears (unless Do not match was selected). If no match is found, No match found appears.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Explanation</th>
<th>Mandatory?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains String</td>
<td>(Available with Rosetta Origin) The string at the beginning of the DC record.</td>
<td>No</td>
</tr>
<tr>
<td>XSL File</td>
<td>Transforms OAI-PMH records to Rosetta METS/Dublin Core records. If no XSL file is selected, the default XSL that transforms to DC is used.</td>
<td>No</td>
</tr>
<tr>
<td>Material Flow</td>
<td>(Available with External Repository Origin or Do Not Match) The Rosetta Material Flow used when importing new records, which is used to generate/process the SIPs</td>
<td>Yes</td>
</tr>
<tr>
<td>Update Metadata Job</td>
<td>Select the metadata job to update records or (with external origin) select not update.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
NOTES:

- A key to Rosetta OAI-PMH harvesting is the location of the reference to the filestreams in the metadata. The OAI-PMH record must provide a URI that Rosetta can access (either via HTTP or NFS) to obtain the files. Depending on the xslt transformation, these references are either placed in the METS fileSec or the DC stream source field (defined in the DC content structure configuration). Rosetta does not harvest the filestreams during OAI-PMH metadata harvest – this is done during the submission itself.

- The selected material flow and the xslt transformation file must be aligned. For example, if the material flow uses a METS content structure, you must select an xslt transformation that produces METS. Rosetta provides built-in examples for xslt transformation. To add/edit xslt transformers, go to Deposits > Advanced Tools > OAI Harvester Transformation.

- To create a dedicated submission job for processing OAI-PMH harvested records, you must also configure a dedicated material flow for the harvester and the submission job.

- The OAI-PMH harvester job places a lock file (.locked) in the submission folders it creates and removes the lock only after the job is completed. The submission job does not process a folder with a lock file. See (About Submission Jobs on page 257) for more details.

- Rosetta generates one SIP for every OAI-PMH response. If the OAI-PMH server returns a resumption token, another request is sent and another SIP is generated from each subsequent response. The number of IEs depends on the number of records returned per response. For large IEs, it is therefore recommended to configure the OAI-PMH server to return fewer records per response.

- It is generally recommended to use a Dublin Core content structure and material flow for simple objects (IEs with one representation). If you need to apply more complex logic (for example, map streams to separate representations) use a METS flow.
- Rosetta stores the OAI identifier header in the IE Original Object Identifier DNX field. This is done either by direct mapping (in the case of METS transformation) or indirect mapping. (Rosetta stored this information in a temporary DC field, which is later mapped to IE Original Object Identifier.) If you select External Repository Origin, Rosetta searches the repository for other records (within the same institution) based on this field and value.

- The harvesting job ignores OAI-PMH records that have a Deleted status.

**Viewing the OAI-PMH Harvest Job History**

You can view the history of the OAI-PMH harvest job.

**To view the history of the OAI-PMH harvest job:**

From the OAI Harvester Job page, click the History link for a job. The OAI Harvester Job History page opens:
A list of times the job ran is displayed. The following actions are available:

- Click **View Log** to see the log of the job.
- Click **Download** to download the job log.
Part III
Negotiators

This part contains the following sections:

- Chapter 16: Understanding Negotiators on page 207
- Chapter 17: Managing Producers on page 211
- Chapter 18: Personalizing Producer Profiles on page 225
- Chapter 19: Personalizing Material Flows on page 231
- Chapter 20: Depositing Content on Behalf of a Producer on page 241
- Chapter 21: Scheduling Producer Reports on page 245
- Chapter 22: Submission Jobs on page 257
Understanding Negotiators

Negotiators are responsible for working with Producers and tailoring the generic deposit configuration of the Rosetta system to the needs of specific Producers.

Negotiators are assigned by a User Manager who registers Negotiators and defines their privileges. Negotiators can be assigned one of three types of permissions: View (no editing of data), Typical (add/edit privileges but no delete), or Full (add/edit and delete privileges). Their scope is institutional.

Producers are associated with negotiators through Producer Groups (not to be confused with a group-type producer). Negotiators can assign a producer to a producer group if that group is part of the negotiator’s scope (see Table 29).

Producer groups are managed via the Producer Group Code Table, which can be edited under Producers > Advanced Tools > Producer Groups.
To assign/unassign a producer group to/from a negotiator, edit the negotiator's Role Parameters in User Management.
Figure 99: Role Parameters
Managing Producers

This section contains:

- About Managing Producers on page 211
- Accessing the Manage Producers Page on page 211
- Searching, Filtering, and Sorting Producers on page 213
- Adding a Producer Account on page 216
- Updating a Producer Account on page 222
- Activating and Deactivating a Producer Account on page 222
- Deleting a Producer Account on page 223
- Producer Agent Registration Process on page 223

About Managing Producers

Negotiators manage Producers and the Producer Agents that deposit content in the Rosetta system.

Negotiators perform this work on the Manage Producers page.

Accessing the Manage Producers Page

The Manage Producers page enables Negotiators to perform tasks such as adding a new Producer account, updating Producer account details, and performing other related activities such as linking Producer Agents to Producers, assigning and personalizing Material Flows for Producers, and depositing material on behalf of Producers.

To access the Manage Producers page, from the Rosetta rollover menu, follow the path: Producers > Producers and Agents > Manage Producers.
The Manage Producers page opens (Figure 101).

The page contains information for all Producers and links for actions that can be taken for each (with the More... options expanded in the final row) such as updating their information, viewing their details, and creating new Producer Agents. The columns contain the following information:

<table>
<thead>
<tr>
<th>Columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>The Producer ID (system-generated)</td>
</tr>
</tbody>
</table>
Table 28. The Producer List page

<table>
<thead>
<tr>
<th><strong>Columns</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check mark indicates the Producer account status, active or inactive.</td>
</tr>
<tr>
<td></td>
<td>▪ Yellow = active.</td>
</tr>
<tr>
<td></td>
<td>▪ Grey = inactive.</td>
</tr>
<tr>
<td></td>
<td>Click the check mark to toggle between the two statuses.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the name of the Producer.</td>
</tr>
<tr>
<td>Type</td>
<td>Displays the type of Producer. For more information on the Producer types, see the Rosetta Overview Guide.</td>
</tr>
<tr>
<td>Producer Group</td>
<td>Displays the group to which the Producer belongs.</td>
</tr>
<tr>
<td>Negotiator</td>
<td>Displays the user name of the Negotiator who is assigned to the Producer.</td>
</tr>
</tbody>
</table>

**Searching, Filtering, and Sorting Producers**

Negotiators can search for, filter, and sort Producers using the Manage Producers page.

**To search for Producers:**

1. On the Producers List page (Producers > Producers and Agents > Manage Producers), in the Find field, enter the name or ID of the Producer.
2. In the In drop-down list, select the database field in which the Rosetta system should search for the Producer.
3. Click Find.

The results are returned on the Manage Producers page.

**To search for Producers using an advanced search:**

1. From the Manage Producers page (see Figure 101), click advanced search in the upper right corner.
2. The simple search is replaced by an advanced search, which includes the Add Conditions button and the link back to the Simple search.
3. Click from simple search to advanced search.
4 Click the **Add Conditions** button.

An Add Conditions box opens with Producer attributes listed.

5 Select the check boxes for one or more attributes you want to search.

6 Click **Add Fields**.

The conditions box closes and the fields you selected display in the search area.
7 Select a relational term from the first drop-down menu in the first row, then enter a value by whichever means the attribute calls for (free text or drop-down menu, for example).

8 If you have subsequent rows, for each row, you can change the logical operator (And by default) to one of the options from the drop-down menu.

9 When you have entered all your conditions, click the Go button to conduct the search.

The system returns Producers that match the terms of your search.

**To filter Producers:**

On the Manage Producers page (Producers > Producers and Agents > Manage Producers), in the Filter drop-down list, select one of the following options:

- **All**, when you want to view the unfiltered list of all Producers
- **My Producers**, when you want to view only those Producers that are assigned to you
- **My Groups**, when you want to view Producers in groups assigned to you

The list of Producers is filtered according to the option you selected.

**To sort Producers:**

On the Manage Producers page (Producers > Producers and Agents > Manage Producers), click any column heading to sort the list according to the contents of the selected column. The column heading is highlighted.

In addition, because both ascending and descending sequences are supported, the column heading indicates whether the column is sorted in an ascending or descending order.
The default sort order is by Producer Name and Status Date.

### Adding a Producer Account

Negotiators can add Producer accounts to the Rosetta system using an Add Producer Account wizard. The wizard guides the Negotiator through adding a Producer account, individual or group, and entering details about the Producer. The last page of the wizard allows the Negotiator to add Producer Agents to the account. Once this is done, Producer Agents can register in the system and begin depositing content on behalf of the Producer with whom they are associated.

Producers can also self-register. For information, see the Rosetta Producer’s Guide.

For more information about accounts, see Individual Versus Group Producers.

To go directly to the adding a Producer account procedure, see Add Producer Account Process.

### Individual Versus Group Producers

Negotiators adding a Producer account must determine if the account will be of an Individual or Group type.

Individual accounts consist of a single Producer representing themselves and depositing on their own behalf. The Producer Agent who performs the depositing is, by default, the same individual. However, additional Producer Agents can be added to the account.

Group accounts consist of a Producer representing an institution and a number of Producer Agents depositing material on behalf of the institution. Group accounts also consist of Contacts of the institution.

### Add Producer Account Process

The process of adding a Producer account consists of the following tasks:

- Deciding whether the account will be an individual or group account and selecting a choice from the wizard
- Providing information about a Producer group or individual, such as Producer classification and status, along with general information such as telephone number and address. For individual accounts, this is the final required step.
- Adding Producer Agents. For individual accounts, this step is optional because a Producer Agent has already been assigned (the same individual as the Producer). Group accounts must assign at least one Producer Agent to deposit material.
- For group accounts only, adding Contacts.
To add a Producer account:

1. On the Manage Producers page (Producers > Producers and Agents > Manage Producers), above the list of Producers, click Add Producer.

   Step 1 of the Add Producer wizard, Select Account Type for the Producer, opens.

2. Select Individual or Group type. See Individual Versus Group Producers on page 216 for more information.

3. Click Next.

   The Producer Details page opens. Some fields vary depending on account type (individual versus group, selected earlier.).

   If you are creating an individual account, the wizard will display three steps. If you are creating a group account, the wizard will display four steps.
In the Producer Information pane, complete the fields as described in the following table:

Table 29. Producer Information Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authoritative Name</td>
<td>The name of the Producer.</td>
</tr>
<tr>
<td>Producer Group</td>
<td>Used to assign several Producers to a Negotiator. Negotiators can work with Producers in their assigned groups.</td>
</tr>
</tbody>
</table>
Table 29. Producer Information Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Classification</td>
<td>The classification of the Producer. Options (such as government or publishers) display in a drop-down list that is populated through the Back Office Administrator.</td>
</tr>
</tbody>
</table>
| Status           | The Producer account status:  
|                  | - **Active** - Producer Agents can use the Rosetta system to deposit content.  
|                  | - **Inactive** - Producer Agents cannot use the Rosetta system to deposit content. However, the account is still saved in the system.          |
| Producer Type    | The Producer type that governs how associated Producer Agents deposit content. The following options are available:  
|                  | - **Casual**  
|                  | - **Registered**  
|                  | - **Trusted**  
|                  | - **Internal**  
|                  | For more information on Producer types, see the Rosetta Overview Guide.                                                                     |
| Negotiator       | The Negotiator who is responsible for managing this Producer.                                                                                |
| Status Date      | The last date on which the Producer account details were changed.                                                                              |
| Generic Profile  | The generic profile that is used for this Producer.                                                                                           |

**NOTE:**  
Back Office Administrators can add up to two additional fields to allow Negotiators to provide additional information about Producers.

5 In the General Information pane, complete the fields that are required and any additional fields. Where Institute and Department appear on the form for a group Producer, First Name and Last Name appear respectively on the form for an individual Producer.

6 Complete the required fields in the Producer Information pane.

**NOTE:**  
The e-mail address you enter on this form will be used whenever someone clicks the contact icon beside this name, as shown in the figure below.
Chapter 17: Managing Producers

Staff User’s Guide, Part III: Negotiators

Clicking the e-mail address on the Contact Information card opens a new blank message in the user’s mail client. Currently this feature is supported in Microsoft Outlook.

For individual accounts, when the form is complete, click the Next button. The ProducerAgent page opens with the Producer’s information listed as the sole Producer Agent. (The Producer and the default Producer Agent share the same user record.) To add other Producer Agents, click the Add Producer Agent button and select Agents from the list. Click Add, then Done to complete this procedure.

NOTE:
An individual account will always have the Producer listed as the first Producer Agent. Others may be added and deleted, but the original Producer Agent cannot be removed.

For group accounts, when the form is complete, click the Next button. The Contacts page opens.

8 Click the Add Contact button.
The User List page opens.
9. From the user list, select one or more users to be the Contact for the Producer and click **Add**.

**NOTE:**
If there are no users in the list, or if the user you want is not listed, you need to add the user as a Contact. Click the **Add User** button, enter values in the User Information form that opens, and click **Save**. The **User List** page refreshes with your new user. Select check boxes beside the user names you want as your Contacts. Click the **Add** button.

The **Contacts** page refreshes with your new user(s) in the list.

10. Click **Next**.

The **Producer Agents** page opens.
11 Click **Add Producer Agent**. A list of potential Producer Agents opens. Select one or more to assign to the Producer and click **Add**.

**NOTE:**
If the there are no users in the list, or if the user you want is not listed, you need to add the user as a Producer Agent. Click the **Add User** button, enter values in the User Information form that opens, and click **Save**. The User List page refreshes with your new user. Select check boxes beside the user names you want as your Producer Agents. Click the **Add** button. The Add Producer Agent page refreshes with your Producer Agent selections.

12 Click **Done**. The new Producer is added to the Producers list.

The Producer Agents associated with this Producer can now deposit content on behalf of the Producer.

## Updating a Producer Account

Negotiators can update Producer account details at any time.

**To update a Producer account:**

1. On the Manage Producers page (see Accessing the Manage Producers Page on page 211), locate the Producer whose account details you want to update and click **Update**. The Update Producer page opens.
2. Modify the fields that you want to update. See the Producer Information Fields table for details.
3. When you have finished updating the Producer information, click **OK**. The Producer details are updated in the Rosetta system.

## Activating and Deactivating a Producer Account

Negotiators can deactivate a Producer account when they must finish configuring the Producer account before making it available to Producer Agents, or if they want to temporarily disable the Producer account without deleting it. Negotiators can also activate an inactive Producer at any time.

On the Manage Producers page, the status of the Producer account is indicated by the check mark in the **Active** column:

- Yellow - The Producer account is active.
Grey - The Producer account is inactive.

**To activate or deactivate a Producer account:**

1. On the Manage Producers page (see Accessing the Manage Producers Page on page 211), locate the Producer account that you want to activate or deactivate.
2. In the Active column, click the check mark. The check mark in the Active column indicates the new status.

The Producer account status is changed from active to inactive, or from inactive to active.

**Deleting a Producer Account**

Negotiators can delete a Producer account. After a Producer is deleted, associated Producer Agents cannot deposit content on behalf of this Producer.

**To delete a Producer account:**

1. On the Manage Producers page (see Accessing the Manage Producers Page on page 211), locate the Producer account that you want to delete and click Delete.
   
   The confirmation page opens.

2. Click OK.
   
   The Producer account is removed from the system.

Associated Producer Agents can no longer use the Producer account to deposit content.

**Producer Agent Registration Process**

When Producer Agents register in the Rosetta system, they must specify the type of material they plan to deposit by selecting one of the predefined options. Administrators can define these options during advanced configuration using the Registration Reason code table (below).
Administrators can add, edit, export, or import rows in the table. For more information, see Working with Code Tables on page 217.

To access the Registration Reason code table, from the Advanced Configuration page, click Deposits > 1st-Time Registration Reasons.

**NOTE:**

These rules affect individual Producers only (depositing content on their own behalf). Producer agents registering to deposit content on behalf of a producer require manual approval before they can deposit.
Personalizing Producer Profiles

This section contains:
- About Personalizing Producer Profiles on page 225
- Accessing the Producer Details Page on page 225
- Upgrading a Registered Producer Account on page 226
- Personalizing a Producer’s Deposit Control Settings on page 228
- Assigning Material Flows to a Producer Profile on page 229

About Personalizing Producer Profiles

Negotiators can personalize generic Producer profiles for specific Producers. A personalized Producer profile is based on one of the existing generic Producer profiles.

Personalized profiles may include material flows and deposit control settings that are unavailable in the generic Producer profiles.

Negotiators personalize Producer profiles using the Producer Details page.

Accessing the Producer Details Page

The Producer Details page enables Negotiators to personalize generic Producer profiles for specific Producers.

1 To access the Producer Details page, from the Rosetta rollover menu, follow the path Producers > Producers and Agents > Manage Producers. The List of Producers page opens.

2 Locate the Producer for which you want to personalize the generic profile and click Update. The Producer Details page opens with the selected Producer’s information.
Upgrading a Registered Producer Account

Negotiators can make a specific, personalized Producer profile available to a particular group of Producers. However, to be able to use a personalized profile, Producers must be defined as trusted Producers.
This section describes how to upgrade a registered Producer account to a trusted Producer account.

To upgrade a Producer account:

1. On the Producer Details page for the Producer whose account you want to upgrade (see Accessing the Producer Details Page on page 225), in the Producer Information section, select Trusted for the Producer Type field drop-down menu.
2. Click the Save button.
   The system returns you to the List of Producers page.
3. Click the Update text link for the Producer whose account you want to change.
4. Click the Personalize Profile button.
   The Update Producer Profile page opens.

5. In the Producer Profile tab, enter information about the Producer and limits for entering information. For information on the fields, see Configuring Deposit Control Settings on page 71.
6. Click the Material Flows List tab to make adjustments to material flow rules.
   The tab displays a view the material flows selected for the profile and the entire pool of material flows. (See figure below.)
7. Click OK. The Producer is upgraded to trusted.
Associated Producer Agents now can deposit content using the personalized Producer profile that is available to trusted Producers.

**Personalizing a Producer’s Deposit Control Settings**

Negotiators can personalize deposit control settings for a specific Producer to enable the associated Producer Agents to deposit larger amounts of content.

**To change a Producer's deposit control settings:**

1. On the Producer Details page (see [Accessing the Producer Details Page](#) on page 225), click **Personalize Profile**. The Producer Profile page opens.

   ![Producer Profile Page](image)

   **Figure 112: Producer Profile Page**

2. Modify the fields as described previously in this guide. (See [Configuring Deposit Control Settings](#) on page 71.)

3. Click **Save**. Updated deposit control settings are saved in the Rosetta system.

   Associated Producer Agents can now deposit content using the updated deposit settings.
Assigning Material Flows to a Producer Profile

Negotiators can assign additional material flows to a specific Producer to provide associated Producer Agents with more opportunities to deposit content.

To assign material flows to a Producer profile:

1. On the Producer Details page (see Accessing the Producer Details Page on page 225), click Personalize Profile. The Producer Profile page opens.
3. Associate material flows as described in Associating Material Flows with a Generic Producer Profile on page 173.

Associated Producer Agents can now deposit content using the material flows you selected.
Personalizing Material Flows

This section contains:
- About Personalizing Material Flows on page 231
- Accessing the Material Flow Details Page on page 231
- Adding and Deleting CMS IDs on page 238
- Personalizing Metadata Forms on page 239
- Personalizing Submission Formats on page 240

About Personalizing Material Flows

Negotiators can personalize generic material flows for specific Producers by personalizing generic metadata forms and submission formats that are configured by Deposit Managers. For more information on generic metadata forms and submission formats, see Configuring Material Flow Infrastructure on page 69.

Negotiators personalize these material flow building blocks using the Edit Material Flow page (see Accessing the Material Flow Details Page on page 231).

Accessing the Material Flow Details Page

The Material Flow Details page enables Negotiators to personalize metadata forms and submission formats that are associated with a generic material flow.

To access the Material Flow Details page:

1. Follow these links from the Home page: Producers > Manage Producers.
2. Click the Update text link in the row of the Producer whose material flow you want to access.
Click the **Manage Material Flows** button.

The Producer Profile/Material Flow List page opens with information for the Producer you selected.

4 In the top pane, with the **Material Flow List** tab selected, find the row containing the material flow you want to personalize and click the **Personalize** text link in the same row.

The page refreshes with the following changes to the item you personalized (see **Figure 115**):
- The Name [“MF name”] has changed to “My [MF name]”
- The Type has changed from Generic to Personalized
- The link Personalize is replaced by a link to Update

![Figure 115: Material Flow Selected for Personalization](image)

5. Click the Update link corresponding to the material flow you are personalizing.

The Material Flow Details page opens.
The top section contains basic read-only information (such as ID number and date created) about the material flow itself.

All other sections contain editable text and drop-down menu fields. Fields
marked with asterisks are required.

The Material Flow Definition section contains the following fields:

Table 30. Material Flow Definition Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the material flow.</td>
</tr>
<tr>
<td>Description/Instructions</td>
<td>The description of the material flow.</td>
</tr>
<tr>
<td>Status</td>
<td>The material flow’s status:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Active</strong> - The material flow is available to Producer Agents depositing for the Producer.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Inactive</strong> - The material flow is not available to Producer Agents depositing for the Producer.</td>
</tr>
<tr>
<td>Status Date</td>
<td>Displays the last date on which the status of the material flow was updated.</td>
</tr>
<tr>
<td>Sampling Rate</td>
<td>The percentage of deposits from this material flow that will be automatically redirected to staff users for review.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This requires SIP processing Approval to be set to Approver.</td>
</tr>
<tr>
<td>Material Type</td>
<td>The types of content that Producer Agents can deposit.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This drop-down list contains the material types that were configured in advance by a Deposit Manager or Back Office Administrator. For more information, see Configuring User Static Lists in the Rosetta Configuration Guide.</td>
</tr>
<tr>
<td>Assertion of Copyrights</td>
<td>The copyright statement to which the Producer Agent must agree in order to deposit material using this material flow definition.</td>
</tr>
</tbody>
</table>

The Technical Definitions section of the page contains the following fields:
The Descriptive Definitions section contains the following fields and buttons.

Table 31. Technical Definitions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Content Structure</td>
<td>A drop-down list of content structures from which the Negotiator chooses one for the Producer. The selected content structure is set at the material flow definition level and is fixed for this material flow.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> This drop-down list contains the content structure templates that were configured in advance by a Deposit Manager or Back Office Administrator. For more information, see Configuring Content Structures on page 82</td>
</tr>
<tr>
<td>Select Submission Format</td>
<td>The submission format that the Producer uses when uploading files. The format is set by the Negotiator and fixed for this material flow at the material flow definition level.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong> This drop-down list contains the submission formats that were configured in advance by a Deposit Manager or Back Office Administrator. For more information, see Configuring Submission Formats on page 70</td>
</tr>
</tbody>
</table>

Figure 117: Descriptive Definitions section of the Material Flow Details page
Table 32. Descriptive Definitions

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Metadata Form</td>
<td>The metadata form that Producer Agents must complete when they deposit content.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This drop-down list contains the metadata forms that were configured in advance by a Deposit Manager or Back Office Administrator. For more information, see Configuring Metadata Forms on page 57.</td>
</tr>
<tr>
<td>Preview</td>
<td>Shows a preview of the form/fields for the selected Select Metadata form.</td>
</tr>
<tr>
<td>Edit MD Form</td>
<td>Opens a page with a Design tab and a Field tab where a user can edit information for either aspect of this material flow's metadata.</td>
</tr>
<tr>
<td>CMS System ID</td>
<td>The Content Management System ID (CMS ID) assigned to this material flow definition. The field is comprised of two values, a CMS system value and a CMS ID within that system. The ID is saved to the system when the Negotiator clicks the Assign CMS ID button and completes the ensuing wizard.</td>
</tr>
<tr>
<td>Assign CMS ID</td>
<td>Opens a short wizard that allows the Negotiator to select a CMS system value and to assign a CMS ID from that system by entering the value directly or by conducting a search for the value and selecting it from the results list. Both system value and ID are copied to the material flow when the Negotiator clicks the Link button.</td>
</tr>
<tr>
<td>Delete CMS ID</td>
<td>Only available when a CMS ID has been assigned. Removes the association of the CMS ID with its previously assigned material flow. The CMS ID can no longer be assigned to IEs deposited with this material flow, but IEs already deposited with the material flow will retain the existing CMS ID.</td>
</tr>
<tr>
<td>Upload Source Metadata Files</td>
<td>Allows a Producer Agent to upload source metadata files when depositing IEs in metadata structures other than Dublin Core. This allows your institution to store complete information for IEs conforming to complex and custom metadata schemes and to view this data in the Web editor.</td>
</tr>
</tbody>
</table>

The Access Rights Form section contains a list of available access rights and
a list of those access rights the Negotiator can assign to this material flow. Arrow buttons allow items to be moved back and forth from one box to the other.

**Adding and Deleting CMS IDs**

Negotiators can add or delete CMS IDs at any point during the adding or editing of material flows. Buttons to assign CMS IDs display on the Material Flows Details page. When a CMS ID has already been assigned, an additional button for deleting the existing CMS ID displays in the Descriptive Definitions section of the page.

**To assign a CMS ID to a material flow:**

1. Access the Manage Producers page by clicking from the Management Home page to the **Producers** page to the **Manage Producers** page.
2. Click the **Update** text link in the row corresponding to the name of the Producer whose material flow you want to alter by adding or deleting a CMS ID. (If you need to add a new Producer, see **Adding a Producer Account** on page 172.)
3. Under the Producer Profile information section, click the **Manage Material Flows** button.
   The Producer Profile/Material Flow List page opens.
4. With the **Material Flow List** tab selected, find the name of the material flow you want to alter and select the text link **Personalize** or **Update** in its row. (If the flow has already by personalized, only Update will show. If it has not been personalized yet, you must do so by clicking the Personalize text link.)
   The Material Flow Details page opens.
5. To add a CMS ID, click the **Assign CMS ID** button and do one of the following:
   - If you know the CMS ID, enter it on the first page. When you click **Next**, the CMS ID is assigned.
   - If you want to search a database for an existing CMS ID, click the **Search in external DBs** option, click **Next**, and follow the prompts provided by the wizard:
     - Enter a partial or full search string in the **Find** field.
     - Select a search category from the drop-down field.
     - Click **Go**.
     - Select an ID from the list of results and click the **Link** button.
   The CMS ID is assigned to the material flow.
6 To delete a CMS ID, click the **Delete CMS ID** button and click **Confirm** on the confirmation page. The Descriptive Definitions section of the material flow definition reflects the assignment or deletion of the CMS ID.

## Personalizing Metadata Forms

Negotiators can personalize a generic metadata form for a specific Producer by adding new fields or editing existing ones.

### To personalize a metadata form:

1. On the Material Flow Editor page (see **Accessing the Material Flow Details Page** on page 231), in the **Material Flow Definition** pane, click **Personalize Metadata Form**. The Metadata Form Editor page opens.

   ![Figure 118: Metadata Form Editor Page](image)

2. Update the fields as described in **Configuring Metadata Forms** on page 57.

3. Click **Save Form**. The personalized metadata form is saved in the Rosetta system.

   Associated Producer Agents can now use the metadata form that was created specifically for their Producer when providing descriptive information about deposited content.
Personalizing Submission Formats

Negotiators can personalize a generic submission format for a specific Producer to provide associated Producer Agents with more options to deposit content. Personalized submission formats are based on one of the existing generic formats.

To personalize a generic submission format:


2. Edit the fields as described in Configuring Submission Formats on page 70.

3. Click Save. The personalized submission format is saved in the Rosetta system.

Associated Producer Agents can now use the submission format settings that were created specifically for their Producer when uploading files.
Depositing Content on Behalf of a Producer

The Rosetta system enables Negotiators to deposit content on behalf of a Producer. Negotiators who deposit content are considered Producer Agents. The Rosetta system automatically creates Producer Agent accounts associated with the appropriate Producer for these Negotiators.

Like other Producer Agents, Negotiators can deposit content and manage deposit activities using the Deposit Activities page. In addition, Negotiators can use both manual and automated material flows associated with the Producer for which they are depositing content.

To deposit content on behalf of a Producer:

1. From the Rosetta drop-down menu, follow the path: Producers > Producers and Agents > Manage Producers.
2. The List of Producers page opens.
3 Locate the Producer on whose behalf you want to deposit content and click **Staff Mediated Deposit**. The Deposit Activities page opens.

NOTE: If you want to deposit content on behalf of a Producer that is not registered in the Rosetta system, you must create a new Producer account as described in **Adding a Producer Account** on page 216.

The Rosetta system creates a Producer Agent account associated with the selected Producer. Negotiators can now use this account to deposit content and
manage deposit activities. For more information on depositing content, see Depositing Content in the Rosetta Producer’s Guide.
Scheduling Producer Reports

This section contains:
- About Producer Reports on page 245
- Managing the Producer Report Job on page 248
- Modifying the Producer Report Job on page 249
- Cancelling the Producer Report Job on page 250
- Configuring Advanced Job Schedules on page 252

About Producer Reports

Two Producer reports are available for viewing:
- Data related to Producer deposit activity/history
- Intellectual Entity views (which and how many times)

Deposit History Report

A Deposit History report is available from the Producer List page (Deposits > Producers and Agents > Producers). It contains the following information for each Producer:
- General information about Producers: Producer ID and name, Producer creation date, Institution, Account status and Producer group
- Information about the report period.
- The following information for each deposit activity in the period:
  - Deposit Activity ID
  - SIP ID
  - Title
  - Date of Deposit
  - Name of the Depositor (Producer Agent)
Status of the SIP and a problem description if rejected or declined. Possible Status values are Draft, Submitted, Rejected, Declined and Approved. A deposit that has been partially approved and partially declined will have a status of Approved. A deposit that has been partially rejected will have a status of Rejected.

The Deposit History Report can be generated and e-mailed periodically to Producers that have elected to receive e-mail notifications.

The report is sent to the primary contact e-mail entered on the Producer’s record. If an e-mail address is not listed for the primary contact, the report is sent to the Producer’s e-mail address.

The system generates a single report for each Producer at each institution. This means that Producers who deposit to many institutions will receive one report for each institution to which they deposit material.

**NOTE:**

If there are no deposit activities in the current period, an e-mail notification will be sent to the Producer, but it will not include the report.

To e-mail these reports to Producers, Negotiators must schedule the Producer Report job to run periodically or execute the job manually. For more information, see Managing the Producer Report Job on page 248.

**Intellectual Entity Views Report**

This report provides information about which IEs were viewed and how many times each was viewed. The number of views is counted since the last time the Producer report was run, but a cumulative count for each IE is provided as well.

**Viewing Producer Reports**

Staff users can generate and view Producer reports on the Rosetta Management interface.

**To view a Producer’s reports:**

1. Follow the Rosetta drop-down menu path: Deposits > Producers and Agents > Producers.

   The Producer List page opens (see Figure 121).
2 Click the **Reports** link for the Producer. The Reports page opens for the selected Producer.

3 Select one of the following links to display the BIRT report:

- **Deposit Activities (Up to Date)** – Displays an up-to-date report for the Producer’s deposit activities. Note that it may be different from the last report that was sent to the Producer.

- **History** – Displays a report for all of the Producer’s deposit activities.

- **Intellectual Entity Views** – Number of IE Views

- **Uploads Report (configurable date range)** – Displays a report containing the Producer’s deposit activities for a specified date range.

- **Deposit Activities (Last period)** – Displays the last report that was sent to the Producer, if such exists.
Managing the Producer Report Job

The Manage Scheduled Jobs page allows Negotiators to manage the scheduling of the job that generates and e-mails the Producer Reports to Producers.

To access the Manage Scheduled Jobs page:

Follow the Rosetta drop-down menu path: Deposits > Jobs > Producers Reports Job.

![Figure 123: Manage Scheduled Job (Producers Report)](image)

**NOTE:**
If the job has expired or has not been scheduled, the State column will display Not Running.

The Manage Scheduled Jobs page enables Negotiators to monitor the status of the Producer Report job and perform the following tasks:

- **View the job's details** – Click the History link to display the job's details.
- **Modify the job** – For more information, see Modifying the Producer Report Job on page 249.
- **Run the job** – Click the Run Now link to run the job manually.

In addition, you can cancel the job. For more information, see Cancelling the Producer Report Job on page 250.
Modifying the Producer Report Job

This task allows Negotiators to modify the details for the Producer Report job.

To schedule the Producer Report job:

1. On the Manage Scheduled Jobs page, click the Update link next to the job. The Job Details page displays the status of the job.

2. Select the interval at which to execute the job: Hourly, Daily, Weekly, Monthly, and Advanced.
3 To configure hourly, daily, weekly, and monthly intervals:
   a Use the following table to configure the common interval fields:

   **Table 33. Common Interval Fields**

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start At</td>
<td>Time</td>
<td>Select the hour and minutes from the drop-down fields to specify the time at which to run the job.</td>
</tr>
<tr>
<td></td>
<td>Date</td>
<td>Use the calendar tool or select the month, day, and year from the drop-down fields to select the date at which to start running the job.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Indefinitely</td>
<td>Select this option to run the job indefinitely.</td>
</tr>
<tr>
<td></td>
<td>Until</td>
<td>Select the month, day, and year from the drop-down fields to specify the date at which to stop running the job.</td>
</tr>
</tbody>
</table>

   **NOTE:** After this date, the state of the job will change from Normal to Not Running.

   b Use the following table to configure the interval-specific fields:

   **Table 34. Interval-Specific Fields**

<table>
<thead>
<tr>
<th>Type of Interval</th>
<th>Perform this task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly</td>
<td>Every</td>
<td>Select the hourly interval from the Hours drop-down field.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Week days</td>
<td>Select which days of the week to run this job.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Monthly At</td>
<td>Select the day of the month to run this job.</td>
</tr>
</tbody>
</table>

   For information on how to configure advanced intervals, see Configuring Advanced Job Schedules on page 252.

4 Click the **Apply** button to schedule the job.

**Cancelling the Producer Report Job**

Cancelling a job allows the Negotiator to postpone the execution of job indefinitely without deleting it from the system.
NOTE:
The Unschedule option will not be available when the state of the job is Not Running.

To cancel the Producer Report job:

1. On the Manage Scheduled Jobs page, click the Update link next to the Producer Report job.
   The Job Details page opens.
2. Click the Unschedule button.
   The state of the job should change to Not Running.

Viewing the Producer Report Job History

You can view the history of the Producer Report job history.

To view the history of the Producer Report job:

From the Producer Report Job page, click the History link for a job. The Producer Report Job History page opens:
Figure 125: Producer Report Job History

A list of times the job ran is displayed. The following actions are available:

- Click View Log to see the log of the job.
- Click Download to download the job log.

**Configuring Advanced Job Schedules**

CronTrigger expressions allow users to define more advanced intervals for job scheduling. This option displays on the Job Details page when the user clicks the Advanced link.
To configure CronTrigger expressions:

1. Select the Advanced interval on the Job Details page.
2. Enter an expression in the CronTrigger box, using the following format:
   <Seconds> <Minutes> <Hours> <Day of Month> <Month>  
   <Day of Week> <Year>

Refer to the following tables for more information on writing expressions:

**Table 35. CronTrigger Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Range</th>
<th>Special Characters Allowed</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Seconds&gt;*</td>
<td>0 - 59</td>
<td>, *, /</td>
</tr>
<tr>
<td>&lt;Minutes&gt;*</td>
<td>0 - 59</td>
<td>, *, /</td>
</tr>
<tr>
<td>&lt;Hours&gt;*</td>
<td>0 - 23</td>
<td>, *</td>
</tr>
<tr>
<td>&lt;Day of Month&gt;*</td>
<td>1 - 31</td>
<td>, *, ? / W</td>
</tr>
<tr>
<td>&lt;Month&gt;*</td>
<td>1 - 12 or JAN - DEC</td>
<td>, *, ?</td>
</tr>
</tbody>
</table>
Table 35. CronTrigger Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Range</th>
<th>Special Characters Allowed</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Day of Week&gt;*</td>
<td>1 - 7 or SUN - SAT</td>
<td>, - * ? / L #</td>
</tr>
<tr>
<td>&lt;Year&gt;</td>
<td>1970 - 2099</td>
<td>, - * /</td>
</tr>
</tbody>
</table>

* Required parameter.

Table 36. Using Special Characters

<table>
<thead>
<tr>
<th>Special Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Indicates that all values within a parameter are used.</td>
</tr>
<tr>
<td>?</td>
<td>Indicates that no specific value within a parameter is used.</td>
</tr>
<tr>
<td>-</td>
<td>Used to specify a range of values. For example — if you enter <strong>10-12</strong> for <code>&lt;Hours&gt;</code> — hours 10, 11, and 12 are used.</td>
</tr>
<tr>
<td>,</td>
<td>Used to specify additional values. For example — if you enter <strong>10,12</strong> for <code>&lt;Hours&gt;</code> — hours 10 and 12 are used.</td>
</tr>
<tr>
<td>/</td>
<td>Used to specify increments. For example, if you specify <strong>0/15</strong> for <code>&lt;Seconds&gt;</code>, seconds 0, 15, 30, and 45 are used.</td>
</tr>
<tr>
<td>L</td>
<td>Used as follows per parameter:</td>
</tr>
<tr>
<td></td>
<td><strong>&lt;Day of Month&gt;</strong> – Indicates the last day of the month, such as 31 for January, 30 for November, and so forth.</td>
</tr>
<tr>
<td></td>
<td><strong>&lt;Day of Week&gt;</strong> – When used alone, it indicates the last day of the week Saturday.</td>
</tr>
<tr>
<td></td>
<td>When used after another value (such <code>&lt;x&gt;L</code>), it indicates the last <code>&lt;x&gt;</code> day of the month. For example, if you enter <strong>5L</strong>, the last Thursday of the month is used.</td>
</tr>
<tr>
<td></td>
<td>When used with a hyphen, it specifies an offset from the last day of the month. For example, if you enter <strong>L-2</strong>, the second-to-last day of the month is used.</td>
</tr>
</tbody>
</table>

**NOTE:**

To prevent unexpected results when using the L option, it is important not to specify lists or use ranges.
Chapter 21: Scheduling Producer Reports

Staff User’s Guide, Part III: Negotiators

Ex Libris Confidential

Table 36. Using Special Characters

<table>
<thead>
<tr>
<th>Special Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>Used to specify the nearest weekday (Monday - Friday) to the specified day. For example, if you enter 15W and the 15th falls on a Saturday, the system will use Friday the 14th. If the 15th is on a Sunday, the system will use Monday the 16th.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If the closest weekday falls in the previous or next month, the closest weekday in the current month is used.</td>
</tr>
<tr>
<td></td>
<td>The L and W options can be combined to specify the last weekday of the month.</td>
</tr>
<tr>
<td>#</td>
<td>Used to specify the nth day of the month. For example, if you enter 5#, the third Thursday of the month is used.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If there is no match, the job will not be executed.</td>
</tr>
</tbody>
</table>

Table 37. CronTrigger Examples

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 0/5 * * * ?</td>
<td>Executes the job every five minutes.</td>
</tr>
<tr>
<td>10 0/5 * * * ?</td>
<td>Executes the job every five minutes, at 10 seconds after the minute (such as 10:00:10 am, 10:05:10 am, and so forth).</td>
</tr>
<tr>
<td>0 30 10-13 ? * WED,FRI</td>
<td>Executes the job at 10:30 am, 11:30 am, 12:30 pm, and 1:30 pm every Wednesday and Friday.</td>
</tr>
<tr>
<td>0 0/30 8-9 5,20 * ?</td>
<td>Executes the job every half hour between the hours of 8:00 am and 10:00 am on the 5th and 20th of the month. Note that the job will execute only at 8:00 am, 8:30 am, 9:00 am, and 9:30 am.</td>
</tr>
</tbody>
</table>
Submission Jobs

This section contains:
- About Submission Jobs on page 257
- Managing Submission Jobs on page 258
- Adding a Submission Job on page 261
- Modifying a Submission Job on page 263
- Cancelling a Submission Job on page 265

About Submission Jobs

Submission jobs are used to submit Producer content (per material flow) at specified intervals to the Deposit server for automated deposits.

NOTES:
- You can prevent the submission job from processing a folder. (This can be useful if you do not want it to be loaded prematurely.) To do so, create an empty file in the submission job folder and name it locked (or .locked).
- While processing a folder, the submission job adds a locked file.
- After a folder has been successfully processed, the submission job adds a done file. Folders with done files are not processed by the submission job. You can create a cron job to clean up these folders.
- After a folder has been unsuccessfully processed, the submission job adds an error file. Folders with error files are reprocessed by the submission job (and should not be deleted). Users can use this file to identify problematic submission folders.
Managing Submission Jobs

The Manage Scheduled Jobs page enables Negotiators to schedule submission jobs. To access this page, follow the Rosetta drop-down menu path: Producers > Advanced Tools > Submission Job.

The Manage Scheduled Jobs page opens to existing submission jobs (Figure 127).

The following information appears on this page:
- Name – the name of the submission job
- Previous Fire Time – the last time the job ran
- Next Fire Time – the next time the job is scheduled to run
- Frequency – the frequency with which the job runs
- State – the state of the job, for example, Normal, Not Running, etc.
- Producer – the Producer who created the job
- Material Flow – the material flow with which the job is associated

This page enables Negotiators to monitor the status of each submission job and perform the following tasks:
- **Add a new job** – For more information, see Adding a Submission Job on page 261.
- **View a job’s history** – Click the History link to display a list of times the job ran. For more information, see Viewing Submission Job History on page 259
- **Modify a job** – For more information, see Modifying a Submission Job on page 263.
- **Execute a job** – Click the Run Now link to run a job manually.
- **Duplicate a job** – Click Duplicate to create a copy of the job.

In addition, you can cancel a job. For more information, see Cancelling a Submission Job on page 265.
Viewing Submission Job History

You can view the history of submission jobs.

To view the history of submission jobs:

From the Manage Scheduled Jobs page, click the History link for a job. The Submission Job History page opens:

Figure 128: Submission Job History

A list of times the job ran is displayed. The following actions are available:
Click **View Log** to see the log of the job. For example:

```
Tue Sep 13 19:56:20 EDT 2016  INFO  Started Processing Deposit For: Test_Plan-1473785662233
Tue Sep 13 19:56:21 EDT 2016  INFO  Deposit successful for Test_Plan-1473785662233, Deposit Activity ID: 157, SIP 157
Tue Sep 13 19:56:21 EDT 2016  INFO  Finished Processing Deposit For: Test_Plan-1473785662233
Tue Sep 13 19:56:21 EDT 2016  INFO  Submission Job finished
Tue Sep 13 19:56:21 EDT 2016  INFO  Job completed successfully
```

Figure 129: Submission Job History Log

- Click **Download** to download the job log.
- Click **SIPs** to display a report of SIPs generated by the job.
Adding a Submission Job

This task allows Negotiators to create a new submission job for a material flow.

To add a submission job:

1. Click the Add job button on the Manage Scheduled Jobs page. The Job Details page opens.

2. Enter a name for the submission job in the Name field.

3. Select the interval at which to execute the job: Hourly, Daily, Weekly, Monthly, and Advanced.

4. To configure hourly, daily, weekly, and monthly intervals:
Use the following table to configure the common interval fields:

### Table 38. Common Interval Fields

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start At</td>
<td>Time</td>
<td>Select the hour and minutes from the drop-down fields to specify the time at which to run the job.</td>
</tr>
<tr>
<td></td>
<td>Date</td>
<td>Use the calendar tool or select the month, day, and year from the drop-down fields to select the date at which to start running the job.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Indefinitely</td>
<td>Select this option to run the job indefinitely.</td>
</tr>
<tr>
<td></td>
<td>Until</td>
<td>Select the month, day, and year from the drop-down fields to specify the date at which to stop running the job.</td>
</tr>
</tbody>
</table>

**NOTE:**

After this date, the state of the job will change from Normal to Not Running.

Use the following table to configure the interval-specific fields:

### Table 39. Interval-Specific Fields

<table>
<thead>
<tr>
<th>Type of Interval</th>
<th>Perform this task:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly</td>
<td>Every</td>
<td>Select the hourly interval from the <strong>Hours</strong> drop-down field.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Week days</td>
<td>Select which days of the week to run this job.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Monthly At</td>
<td>Select the day of the month to run this job.</td>
</tr>
</tbody>
</table>

For information on how to configure advanced intervals, see **Configuring Advanced Job Schedules** on page 252.

5 Complete the required fields in the **Job Parameters** pane.

**NOTE:**

The list of available material flows will be populated based on the selected producer's profile. (See below.)
6 Click the **Apply** button to add the job to the list of submission jobs.

## Modifying a Submission Job

This task allows Negotiators to modify the details for an existing submission job.

**To modify a submission job:**

1 On the Manage Scheduled Jobs page, click the **Update** link next to the job that you want to modify.

   The Job Details page opens.
2 Select the interval at which to execute the job: **Hourly, Daily, Weekly, Monthly,** and **Advanced**.

3 To configure hourly, daily, weekly, and monthly intervals:
a Use the following table to configure the common interval fields:

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start At</td>
<td>Time</td>
<td>Select the hour and minutes from the drop-down fields to specify the time at which to run the job.</td>
</tr>
<tr>
<td></td>
<td>Date</td>
<td>Use the calendar tool or select the month, day, and year from the drop-down fields to select the date at which to start running the job.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Indefinitely</td>
<td>Select this option to run the job indefinitely.</td>
</tr>
<tr>
<td></td>
<td>Until</td>
<td>Select the month, day, and year from the drop-down fields to specify the date at which to stop running the job.</td>
</tr>
</tbody>
</table>

**NOTE:** After this date, the state of the job will change from Normal to Not Running.

b Use the following table to configure the interval-specific fields:

<table>
<thead>
<tr>
<th>Type of Interval</th>
<th>Perform this task:</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly</td>
<td>Every</td>
<td>Select the hourly interval from the Hours drop-down field.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Week days</td>
<td>Select which days of the week to run this job.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Monthly At</td>
<td>Select the day of the month to run this job.</td>
</tr>
</tbody>
</table>

For information on how to configure advanced intervals, see Configuring Advanced Job Schedules on page 252.

4 Complete the required fields in the Job Parameters pane.

5 Click the Apply button to add the job to the list of submission jobs.

### Cancelling a Submission Job

Cancelling a job allows the Negotiator to postpone the execution of job indefinitely without deleting it from the system.
NOTE: The Unschedule option will not be available when the state of the job is Not Running.

To cancel a submission job:

1. On the Manage Scheduled Jobs page, click the Edit link next to the job that you want to modify.
   The Job Details page opens.
2. Click the Unschedule button.
   The state of the job should change to Not Running.
Part IV
Assessors, Arrangers, and Approvers

This part contains the following sections:

- Chapter 23: Understanding Assessors, Arrangers, and Approvers on page 269
- Chapter 24: Working with SIPs on page 271
- Chapter 25: Integration with External Collection Management Systems on page 291
Understanding Assessors, Arrangers, and Approvers

Assessors, Arrangers, and Approvers are responsible for reviewing content that Producer Agents deposit.

The table below shows the responsibilities of Assessors, Arrangers, and Approvers:

<table>
<thead>
<tr>
<th>Responsibility</th>
<th>Assessor</th>
<th>Arranger</th>
<th>Approver</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approving, returning, or declining SIPs</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Approving, returning, or declining intellectual entities (IEs)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Rearranging IEs</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Assigning a collection management system (CMS) ID</td>
<td>Yes (can assign a CMS ID to one intellectual entity)</td>
<td>Yes (can assign a CMS ID to multiple intellectual entities simultaneously)</td>
<td>No</td>
</tr>
<tr>
<td>Replacing an incompatible file with a copy that is accessible to the library system</td>
<td>Yes (if also has TA or Editor privileges)</td>
<td>Yes (if also has TA or Editor privileges)</td>
<td>No</td>
</tr>
</tbody>
</table>

For more information about SIPs and IEs, see the Rosetta Overview Guide.

Each Assessor is associated with an approval group. A Back Office Administrator defines content that should be reviewed by each approval group. Assessors, Arrangers, and Approvers can work only with the content that is defined for their approval group.
Assessors, Arrangers, and Approvers are assigned by a User Manager, who registers them and defines their privileges. Privileges can be either View, Typical, or Full. Their scope is institutional.
Working with SIPs

This section contains:
- About Working with SIPs on page 271
- Viewing SIPs to Be Reviewed on page 271
- Accessing the SIP Content List Page on page 273
- Viewing SIP Information on page 275
- Approving a SIP on page 280
- Declining or Rejecting a SIP on page 280
- Forwarding a SIP or an IE on page 281
- Organizing IEs on page 282

About Working with SIPs

Assessors, Arrangers, and Approvers can view information about deposited submission information packages (SIPs) and decide whether this content should be approved, rejected, or declined.

Viewing SIPs to Be Reviewed

The Rosetta system enables Assessors, Arrangers, and Approvers to view a list of SIPs that require review. Each reviewer can view only those SIPs that are assigned to their approval group by a Back Office Administrator. (For more information, see Understanding Assessors, Arrangers, and Approvers on page 269.)
To view SIPs to be reviewed:

NOTE:
If you are working as an Arranger or Assessor, you may be able to access the SIPs page by clicking a text link in the Quick Launch section in the upper right header. (If you do this, you do not need to follow the steps below.)

1. From the Rosetta menu, roll your cursor over the **Submissions** tab, then, from the drop-down menu, select the link that corresponds to your role or task.

The SIPs List for your selected role or task opens.
The page contains the following columns:

**Table 43. Assessor SIPs List Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIP check boxes</td>
<td>Selecting these enables Assessors, Arrangers, and Approvers to perform an action on multiple SIPs.</td>
</tr>
<tr>
<td>SIP ID</td>
<td>Displays the unique ID number assigned to the SIP.</td>
</tr>
<tr>
<td>Alert</td>
<td>Displays a warning icon when a Technical Analyst has marked the SIP to draw the attention of an Assessor, Arranger, or Approver.</td>
</tr>
<tr>
<td>Title</td>
<td>Displays the SIP’s title.</td>
</tr>
<tr>
<td>Issue #</td>
<td>Links to the bibliographic citation.</td>
</tr>
<tr>
<td>Producer</td>
<td>Displays the SIP’s Producer.</td>
</tr>
<tr>
<td>Type</td>
<td>Displays the SIP’s type.</td>
</tr>
<tr>
<td>Submitted On</td>
<td>Displays the SIP’s submission date.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>Displays the staff user who is exclusively assigned to work on the SIP. If the SIP is assigned to a specific staff user, other staff users can only view the SIP but not review it.</td>
</tr>
</tbody>
</table>

**Accessing the SIP Content List Page**

The SIP Content List page enables Assessors, Arrangers, and Approvers to view SIP objects that make up the SIP and to perform various actions, including approving, rejecting, or declining SIPs, as well as merging and splitting IEs.

**To access the SIP Content List page:**

1. From the Rosetta drop-down menu, click **Submissions**, then click the link corresponding to your role’s SIP list (below the Approval heading).
2. From the SIP list, locate the SIP with which you want to work and, under **Actions**, click **Work On**. The SIP Content List page opens.
The page contains the following columns:

**Table 44. SIP Content List Page Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Displays the name of the SIP object.</td>
</tr>
<tr>
<td>PID</td>
<td>Displays the permanent unique identifier of the intellectual entity (IE).</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the status of the IE.</td>
</tr>
<tr>
<td>CMS ID</td>
<td>Displays the identifier of the IE in the collection management system (CMS).</td>
</tr>
<tr>
<td># of Files</td>
<td>Displays the number of files in the master copies of the IE.</td>
</tr>
<tr>
<td>Actions</td>
<td>Provides links to actions that can be performed on the item (for example, View or Export). Clicking More... shows additional actions such as assigning CMSIDs and access rights.</td>
</tr>
</tbody>
</table>

Arrangers and Assessors can view the IEs in a list view (as shown above) or as a Gallery (or thumbnail) display (see below). Thumbnails are generated on demand. If the system is unable to generate a thumbnail for a specific object, it uses a default image set up in the administrative module of Rosetta. (See
Generic Thumbnail Creation in the *Rosetta Configuration Guide* for instructions/details.)

![Figure 136: Gallery View for IEs in SIP](image)

The Gallery view provides a count of the IEs and the option for sorting on one field, ascending or descending.

**Viewing SIP Information**

The Rosetta system enables Assessors, Arrangers, and Approvers to view information about SIPs. Assessors, Arrangers, and Approvers can view the following items:

- **SIP History** on page 276
- **SIP Problem Notes** on page 277
- **An IE in a SIP** on page 278
- **IE Structure and Metadata** on page 278
- **Tree View** on page 287
SIP History

Assessors, Arrangers, and Approvers can view the history of a SIP. For example, an Assessor can see when the content was deposited by the Producer Agent and when the SIP was moved from the Deposit Server to the Staging Server.

To view SIP history:

1. Access the SIP Content List page by using a Quick Launch text link or clicking Submissions from the Home page and selecting a role/task from the Approval section. (See Accessing the SIP Content List Page on page 273 for details.)

2. Click the History tab. The SIP History page opens.

The page contains the following columns:

Table 45. SIP History Page Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Type</td>
<td>Displays the SIP's event type.</td>
</tr>
<tr>
<td>Description</td>
<td>Displays a description of the event.</td>
</tr>
<tr>
<td>Module</td>
<td>Displays the module in which the event took place. For example, Deposit Server or Staging Server.</td>
</tr>
<tr>
<td>Submitted On</td>
<td>Displays the date on which the SIP was submitted.</td>
</tr>
</tbody>
</table>
3 Locate the event you want to view and click its event type. The Event Details page opens.

![Event Details Page](image)

Figure 138: Event Details Page

The Event Details page displays several fields that contain information about the selected event.

**SIP Problem Notes**

Assessors, Arrangers, and Approvers can view problem-related notes of a SIP that have been entered by staff users who previously worked with the SIP.

**To view the SIP notes:**

On the SIP Content List page (see Accessing the SIP Content List Page on page 273), click the Notes tab. The SIP Notes page opens.
Notes display below the tabs.

Users can add their own notes by typing information in the Add Internal Note field and clicking the Add Note button.

**An IE in a SIP**

Assessors, Arrangers, and Approvers can view a SIP IE in a Web browser using the Delivery option.

**To view a SIP’s IE:**

On the SIP Content List page (see *Accessing the SIP Content List Page* on page 273), locate the SIP object you want to view and click View. The selected IE opens in a separate browser window.

**IE Structure and Metadata**

Assessors, Arrangers, and Approvers can view metadata about an IE as a unit, its representations, and its files. The metadata provides the following types of information:

- **Descriptive metadata**, which contains information provided by Producer Agents, such as content creator, title, category, and subject. Specific
information that Producer Agents must provide is defined by Deposit Managers, Negotiators, and Administrators.

- **Administrative metadata**, which contains information that is automatically generated by the Rosetta system. This information includes technical (such as file size, format, location, and unique identifier), provenance (such as Producer and Producer Agent's name), and access rights metadata. Specific information that the Rosetta system generates is defined by an Administrator during the configuration of the DNX profile.

Assessors, Arrangers, and Approvers can view IE metadata using the Web Editor.

**To view IE metadata:**

1. On the SIP Content List page (see **Accessing the SIP Content List Page** on page 273), locate the IE for which you want to view the metadata and click **Edit IE**.

   The IE opens in the Web Editor.

   ![Figure 140: Web Editor](image)

   For more information on the Web Editor, see **Section 44: Web Editor** on page 453.
Approving a SIP

Assessors, Arrangers, and Approvers can approve a SIP when the SIP content is found appropriate for storage in the Rosetta system. After a SIP is approved, it is moved to the next stage, as defined by a Back Office Administrator. (For more information about SIP processing, see Configuring SIP Processing in the Rosetta Configuration Guide.) A notification e-mail may be sent to the Producer Agent if such an action has been set up by the System Administrator (see Adding an E-mail Confirmation in the Rosetta Configuration Guide).

To approve a SIP:

1. On the SIP Content List page (see Accessing the SIP Content List Page on page 273), in the Action drop-down list, select Move to Next Stage.
2. Click Execute. The SIP is moved to the next stage, as defined by a Back Office Administrator.

Declining or Rejecting a SIP

Assessors, Arrangers, and Approvers can decline or reject a SIP when the SIP content is found to be inappropriate for storage in the Rosetta system, or when the SIP content contains problems that the Producer Agent must repair (such as viruses or corrupted files).

When the content is rejected, the Producer Agent receives a notification of the rejection and the reason for the rejection as specified by the Assessor, Arranger, or Approver. The Producer Agent must repair the issues and resubmit the content.

When the content is declined, the Producer Agent who deposited it cannot resubmit the content.

To decline or reject a SIP:

1. On the SIP Content List page (see Accessing the SIP Content List Page on page 273), do one of the following:
   - To decline or reject specific IEs, select their check boxes and, from the drop-down list in the bottom right of the page, select Decline IEs or Reject IEs.
   - To decline or reject the entire SIP, from the drop-down list, select Decline SIP or Reject SIP.
2. Click the Execute button. The Reason page opens.
In the Reason drop-down list, select the reason why you are declining or rejecting the content.

4. In the Optional Note field, enter notes for the Producer Agent, if necessary.

5. Click OK. The SIP or IEs are removed from the page.

The Rosetta system sends an e-mail notification to the Producer Agent that the content was rejected or declined.

**Forwarding a SIP or an IE**

Assessors, Arrangers, and Approvers can forward a SIP or specific IEs to another staff user when it is necessary to get a second opinion.

**To forward a SIP or an IE to another staff user:**

1. On the SIP Content List page (see Accessing the SIP Content List Page on page 273), do one of the following:

   - To forward specific IEs, select their check boxes and, in the Action drop-down list, select either Move to Specific Assessor (when you want to move the SIP to a specific Assessor) or Move to Assessor (when you want to move the SIP to a group of Assessors, Arrangers, or Approvers).

   - To forward the entire SIP or multiple SIPs, in the Action drop-down list, select either Assign To to assign a SIP to a specific user within the same work area, or Move SIP(s) to Assessor/Arranger/Approver Pool when you want to move the SIP between 3A work areas.
NOTE:
You cannot move SIPs that are assigned to another user.

2 Click **Execute**.
The SIP or IEs are forwarded to staff users, as specified.

Organizing IEs

Both Arrangers and Assessors have privileges to:

- Rearrange the Structure Map of an IE
- Merge Single IEs
- Split an IE

Rearrange the Structure Map of an IE

To make changes to the IE’s structure map, do the following:

1 On the Submissions page, click the **Arrange SIPs** link.
The SIPs List page opens.

2 Click the **Work On** link of the SIP that contains the IE you want to rearrange.
The SIP Content List page opens.

3 Click the **Edit IE** link of the IE.
The Intellectual Entity page opens in the Web Editor.

4 In the left column of Web Editor, click the Representation line below the IE.

5 Click the **Metadata** tab.

6 Click the **Edit** link of the row whose type equals Structure Map.
The Edit Structure Map page opens.
7 Do the following, as required:

- To re-order the files that comprise the IE, use the arrow buttons in the Order column.

- To assign a label to the root of the structure, type it in the Root - Label field.

- To assign labels to the files, type them in the Label column.

8 Click the Save button.

   The system commits the rearrangement of the structure map to memory.

**Merge Single IEs**

To merge a number of single IEs into one IE

1 On the Submissions page, click the **Arrange SIPs** link.

   The SIPs List page opens.

2 Click the Work On link of the SIP you want to change.

   The SIP Content List page opens.
3 Select the check boxes of the IEs that you want to merge.

**NOTE:**
Only IEs that contain one file can be merged. The number of files in each IE is indicated in the # of Files column of the SIP Content list.

4 In the drop-down list in the lower right corner of the page, select **Merge Selected IEs** and click the **Execute** button.

A warning page explains that the existing logical structure maps will be lost as a result of the merge, and any access copies of the IEs will be lost.

5 Click **Cancel** to stop the merging process, click **Merge** to proceed.
   The following page opens.
Choose a main IE of the group (to which other IEs will be added and which will determine the template of the merged IE). Select the radio button of this IE and click **Next**.

The following page opens.

Enter a title for the merged IE and click **Finish**.

The Edit Structure Map page opens.
8. If required, edit the structure map of the merged IE as described in Rearrange the Structure Map of an IE on page 282.

9. Click Save.

The SIP Content List page opens again. The new IE appears in the list instead of the IEs that were merged. Note that its PID is that of the main IE selected in Step 6.

Split an IE

To split complex IEs into single IEs:

1. On the Submissions page, click the Arrange SIPs link.
   The SIPs List page opens.

2. Click the Work On link of the SIP you want to rearrange.
   The SIP Content List page opens.
3. Click the **More...** link of the row containing the IE you want to split. If more than one file exists in the IE, the option to **Split** will display in the **More...** actions. Click this text link.

A confirmation form opens.

4. Click **Cancel** to stop the splitting process, click **Split** to proceed.

The SIP Content List page opens again. New one-file IEs appear in the list.

**Tree View**

You can view the IEs in a SIP in a hierarchical tree view if you have Arranger or Assessor privileges. To view the IEs in a tree view, select **Tree View** from the
View drop-down list. The tree view opens in the left pane while the list view opens in the right pane. The figure below shows these views.

![Figure 149: Tree View, Filters and Sub-folder View Options](image)

The tree view option will be available only when the system is able to reconstruct the original tree structure.

There are three ways in which information about the original path to the files can be passed to the server when a user deposits material.

- From the Deposit API, given a directory structure and multiple IE.xml files.
- From the Web interface, loading multiple files through the applet.
- From a submitter application (for example, Indigo), if the original path is provided as part of the METS file.

Selecting a node of the tree applies a filter to the IE list. Only IEs that have files in the selected node are displayed.

**NOTE:**
Rosetta displays only Master Copy files in the tree. If any of the IEs contain Access Copies, Rosetta does not display the files in the tree.

Selecting a file from the tree displays the IE containing the file.

Clicking the **Display all IEs** button when the list is filtered restores the whole list of IEs for the SIP.
Selecting the **View sub-folders** check box displays all IEs in the selected folder plus all IEs in the inclusive sub-folders. De-selecting the box removes the IEs in the sub-folders from view.

The list of IEs can be filtered using the regular filter drop-down list. The filter through the tree nodes takes precedence. Choosing a node in the tree resets any existing filter and creates a new list of IEs for the selected node.

If you select a filter from the drop-down list, it is applied to the already filtered list of IEs that are displayed as a result of the selection in the tree node. Changing the filter in the drop-down list does not affect the selection in the tree node.

Note that filtering can lead to empty results due to the combination of the two filters (the tree and the drop-down list). These empty results may not always be intuitive.

If the tree cannot be reconstructed the tree view contains a non-hierarchical list of the IEs.

---

**Figure 150: Unstructured Tree View**

---
Integration with External Collection Management Systems

This section contains:

- Assigning a CMS ID to an Intellectual Entity on page 291
- Unassigning a CMS ID to an Intellectual Entity on page 293

Assigning a CMS ID to an Intellectual Entity

The Rosetta system supports integration with external collection management systems (CMS), such as Voyager, in order to establish a relationship between IEs stored in the Rosetta system and their metadata stored in a CMS.

Assessors and Arrangers can link metadata from an external CMS to IEs by assigning a collection management system identifier (CMS ID) to an IE. In addition, Arrangers can assign a CMS ID to multiple IEs simultaneously.

To assign a CMS ID to an IE:

1. From the Rosetta Submissions drop-down menu, under the Approval heading, click Assess SIPs or Arrange SIPs, depending on your role.

   The SIPs List page for your role opens.

2. Locate the SIP that contains the IE to which you want to assign a CMS ID and click Work On.

   The SIP Content List page opens.
3 Locate the IE to which you want to assign a CMS ID and click the **Assign CMS ID** text link.

**NOTE:**
If the **Assign CMS ID** text link does not appear in the **Actions** section of the table, click the **More...** link to view additional items.

The search page for assigning CMS IDs to IEs opens (see **Figure 152**).

4 Optional: Click the **Refresh Indexes** button to update the database with the latest IEs.

5 Search for an ID using the **Search Database** drop-down list, the **Find** text box, and the **Search Category** (search fields) drop-down list. Click **GO**.

The results show in a table below the search fields.
Figure 153: Assign CMS ID Results Page

6 Locate the ID you want to assign to the IE and click the Link button.

The CMS ID is assigned to the IE.

The Rosetta system can now synchronize the metadata stored in an external CMS with the IE.

**Unassigning a CMS ID to an Intellectual Entity**

There are two methods to unassign a CMS record – manually and automatically:

**To unassign a CMS record manually:**

1 Search for the IE whose CMS record you want to remove.

2 View the metadata list for the IE. For example:
To unassign a CMS record automatically:

1. From the list of tasks (Data Management > Manage Sets and Processes > Add Process), select Unassign CMS.
2. Click Next. The following appears:

3. Click Remove for CMS.

The CMS record is removed.
Figure 155: Unassign CMS Task

3. Fill in the fields. To copy CMS metadata to the IE’s descriptive metadata, select the **Move CMS to IE DC** checkbox.

4. Click **Next**.

5. Complete the steps for configuring the job.

**NOTE:**

CMS records that are no longer assigned to any IE are removed by the Metadata Orphan Handler job as described in the **System, Background, and Operational Jobs** section of the *Rosetta System Administration Guide.*
Part V

Technical Analysts

This part contains the following section:

- Chapter 27: Understanding Technical Analysts on page 299
- Chapter 28: Understanding Technical Issues on page 301
- Chapter 29: Viewing Problematic SIP Content on page 303
- Chapter 30: Resolving SIP Technical Issues on page 311
- Chapter 31: Viewing and Resolving Repository Issues on page 325
- Chapter 32: Validation Stack Rules on page 331
Technical Analysts (TAs) handle problems that may occur when the Rosetta system processes Producer Agents’ content.

These problems can occur with deposit activities, submission information packages (SIPs), representations, access copies, and individual files in SIPs. (For more information, see Understanding Technical Issues on page 301.)

When the Rosetta system identifies a technical problem, it sends a notification to the appropriate TA by e-mail. The TA uses the Rosetta system tools to resolve the issue.

The actions that TAs can perform depend on the processing stage in which the error occurred.

Technical Analysts are assigned by a User Manager, who registers them and defines their privileges. Two types of TAs exist in Rosetta:

- A SIP-processing TA (SIP TA), who works on the issues that occur during SIP loading
- A Repository TA, who works on errors impacting files in the permanent repository

Each type of TA is one role, with one set of privileges. Their privileges are always Full, and their scope is institutional.
Understanding Technical Issues

Technical issues that are dealt with by SIP or Repository TAs comprise the following:

For SIP TAs, problems occur with deposit activities and submission information packages (SIPs):

- A deposit activity or a set of files uploaded by a Producer Agent to the Deposit Server.
- A SIP automatically generated by the Rosetta system when it moves deposit activities from the Deposit Server to the Staging Server.

For more information on the Deposit Server and Staging Server, see the Rosetta Overview Guide.

For Repository TAs, issues arise when running validation stacks on files in the permanent repository.

The following table shows content processing stages in which errors may occur and explains which objects can contain errors.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Errors May Occur When...</th>
<th>Errors May Occur With...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deposit</td>
<td>Producer Agents’ content is uploaded to the Deposit Server</td>
<td>Entire deposit activities</td>
</tr>
<tr>
<td>Loading</td>
<td>Producer Agents’ content is moved from the Deposit Server to the Staging Server</td>
<td>Entire SIPs</td>
</tr>
<tr>
<td>Validation</td>
<td>Rosetta runs a validation check on files</td>
<td>Individual files</td>
</tr>
<tr>
<td>Enrichment</td>
<td>Rosetta enriches the content before moving it to the Permanent Repository</td>
<td>Individual files</td>
</tr>
<tr>
<td>Move to Permanent</td>
<td>Rosetta moves the content from the Staging Server to the Permanent Repository</td>
<td>Individual files</td>
</tr>
</tbody>
</table>
Viewing Problematic SIP Content

This section contains:
- About Viewing Problematic Content on page 303
- Accessing the Technical Issues Page on page 303
- SIP Issues - Tabs and Details on page 305

About Viewing Problematic Content

The Rosetta system displays problematic content in tabs according to the stage in which the problem occurred. The following tabs are available:
- Deposit (For more information, see Deposit on page 305.)
- Loading (For more information, see Loading on page 306.)
- Validation (For more information, see Validation on page 306.)
- Bytestream (For more information, see Bytestream on page 306.)
- Enrichment (For more information, see Enrichment on page 308.)
- Move to the Permanent Repository (For more information, see To Permanent on page 308.)
- System error (For more information, see System Error on page 309.)

Technical Analysts work with problematic deposit activities, SIPs, and individual files using the Manage Issues in SIP Processing / SIPs List page.

Accessing the Technical Issues Page

The Technical Issues page enables Technical Analysts to work with problematic content.
To access the Technical Issues page:

From the Submissions page of the Management module, click Technical Issues below the Technical Analysis heading. The SIPs list opens.

The page consists of the following segments:

- The tabs along the top of the page show the type of issue and the number of items that exist for that type of problem.
- The table below the tabs displays the problematic objects that are stored in each tab. The columns vary from tab to tab.

The following table describes the columns of the tabs. (For descriptions of the Bytestream and System Error columns, see the relevant sections below.)

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check boxes</td>
<td>Selecting these enables Technical Analysts to perform an action on multiple activities simultaneously. Toggle selecting all and deselecting all by clicking the check box in the header row.</td>
</tr>
<tr>
<td>SIP ID</td>
<td>The unique ID number assigned to the problem. Click the SIP ID to view the Deposit Activity Problem View page.</td>
</tr>
<tr>
<td>Deposit ID</td>
<td>The ID of the deposit activity that contains the problematic file. Assigned to the deposit before the SIP ID has been implemented.</td>
</tr>
</tbody>
</table>
Chapter 29: Viewing Problematic SIP Content

SIP Issues - Tabs and Details

The following sections describe the tabs and columns on the SIPS list as well as the actions that Technical Analysts can perform in each tab:

- Deposit on page 305
- Loading on page 306
- Validation on page 306
- Bytestream on page 306
- Enrichment on page 308
- To Permanent on page 308
- System Error on page 309

Deposit

The Deposit tab contains problematic deposit activities that failed when the Rosetta system was uploading them to the Deposit Server. (For more information, see Understanding Technical Issues on page 301.)

In the Deposit tab, Technical Analysts can perform the following actions:

- Moving a SIP to the Next Stage on page 311
- Rejecting and Declining Problematic Content on page 312
Loading

The Loading tab contains problematic SIPs that failed when being moved from the Deposit Server to the Staging Server. (For more information, see Understanding Technical Issues on page 301.)

In the Loading tab, Technical Analysts can perform the following actions on problematic SIPs:

- Rejecting and Declining Problematic Content on page 312
- Resubmitting or Reloading Problematic Content on page 314
- Replacing a Problematic SIP or File on page 315
- Viewing a Problematic SIP or File on page 315
- Handling a Problematic SIP or File on page 317

Validation

The Validation tab contains problematic files that failed during the validation check. (For more information, see Understanding Technical Issues on page 301.)

On the Validation tab, Technical Analysts can perform the following actions on problematic files:

- Replacing a Problematic SIP or File on page 315
- Viewing a Problematic SIP or File on page 315
- Handling a Problematic SIP or File on page 317
- Rechecking a File on page 321
- Rerunning Validation on page 323

Bytestream

The Bytestream tab displays SIPs with bytestreams (containers) that failed during the bitstream extraction stage due to one of the following:

- Error encountered while trying to extract bitstreams
- Error encountered when running validation stack on bitstream

For more information on bytestreams and bitstream extractions, see Bitstream Extraction Rules in the Rosetta Configuration Guide.

For each entry, the following actions are available:
Table 48. SIPs List - Bytestream tab

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Errors</td>
<td>Link to the Bitstream Extraction Error Details page</td>
</tr>
<tr>
<td>Skip</td>
<td>Skip the bitstream extraction for the selected bytestream (container). Bytestream will be processed as a regular file with no bitstream information</td>
</tr>
<tr>
<td>Rerun</td>
<td>Rerun Bitstream Extraction task for the selected bytestream (container). Rerun will skip VS at the bytestream level and will rerun VS for each of the extracted bitstreams</td>
</tr>
<tr>
<td>Reject</td>
<td>Reject the bytestream (container)</td>
</tr>
<tr>
<td>Download</td>
<td>Download the bytestream (container) to the TA’s PC</td>
</tr>
</tbody>
</table>

To view error details for the SIP, click the SIP’s ID number or click the **View Errors** text link of the row containing the SIP you want to view. The following page opens.

Figure 157: View Bytestream Errors

To view further details, click the **Event Type** text for the failure event you want to see. To view the bytestream content, click the **Download** text of the row you want to view.

Details for the event type you select look like the following:
For more information on bytestreams, bitstreams, and SIPs, see Bitstream Extraction Rules in the *Rosetta Configuration Guide*.

**Enrichment**

The Enrichment tab contains problematic files that failed when the Rosetta system was enriching the content. (For more information, see Understanding Technical Issues in the *Rosetta Configuration Guide*.)

In the Enrichment tab, Technical Analysts can perform the following actions on problematic files:

- Handling a Problematic SIP or File on page 317
- Rerunning Enrichment on page 323

**To Permanent**

The To Permanent tab contains problematic files that failed when the Rosetta system was moving them from the Staging Server to the Permanent Repository. (For more information, see Understanding Technical Issues on page 301.)

In the To Permanent tab, Technical Analysts can perform the following action on problematic files:
Handling a Problematic SIP or File on page 317

System Error

When a SIP fails, the system rolls back the complete stage and attempts to rerun the SIP processing. The system will attempt to rerun the SIP processing up to five times.

The System Error tab contains SIPs that fail to complete the processing after such repeated attempts. Typically, these SIPs have failed processing due to environmental issues (e.g. network, storage, database). The expectation is that such situations are temporary and readily addressed, and re-running these SIPs once the issues have been resolved will allow them to be properly processed. In the event this is not the case, contact Ex Libris Support.

![System Error Tab](image)

Figure 159: SIPs List - System Error Tab

The System Error tab contains the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check boxes</td>
<td>Selecting these enables you to perform an action on multiple SIPs simultaneously (using the Action dropdown menu below). Toggle selecting all and deselecting all by clicking the check box in the header row.</td>
</tr>
<tr>
<td>SIP ID</td>
<td>The unique ID number assigned to the problem.</td>
</tr>
</tbody>
</table>
In the System Error tab, Technical Analysts can perform the following actions on files:

- Rerun
- Rerun All
- Decline SIP

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception Date</td>
<td>The date the exception occurred.</td>
</tr>
<tr>
<td>Source Queue</td>
<td>The last station of the SIP.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the problem.</td>
</tr>
</tbody>
</table>
Resolving SIP Technical Issues

This section contains:

- About Resolving Issues on page 311
- Moving a SIP to the Next Stage on page 311
- Rejecting and Declining Problematic Content on page 312
- Resubmitting or Reloading Problematic Content on page 314
- Replacing a Problematic SIP or File on page 315
- Viewing a Problematic SIP or File on page 315
- Validation Stack Error Codes on page 316
- Handling a Problematic SIP or File on page 317
- Rerunning Processes on page 321
- Derivative Copy Representations on page 439

About Resolving Issues

The Rosetta system enables Technical Analysts to resolve technical issues that occur with deposit activities, SIPs, and files.

Moving a SIP to the Next Stage

After handling the technical issues of a SIP, the TA should move the SIP to its next stage as defined by an Administrator. (For more information on content processing, see Configuring SIP Processing in the Rosetta Configuration Guide.)

**NOTE:**

If the SIP TA has overwritten the automatic output of the validation stack, the SIP’s next stage is to be approved by the Assessor before it continues to
the Permanent repository. If the TA has solved the issue without changing the IE's metadata, the SIP will continue to its next stage based on the SIP processing configuration.

To move a SIP to the next stage:

1. On the SIPs List - Loading page (see Accessing the Technical Issues Page on page 303), select the SIPs you want to move to the next stage. To select all the SIPs, select the check box in the header.
2. In the Action drop-down list, select Move to Next Stage.
3. Click Execute.
   
The SIP is moved to the next stage.

If the next stage includes approval of the SIP, an e-mail may be generated by the system and sent to the Producer Agent who initially submitted the material. See Adding an E-mail Confirmation in the Rosetta Configuration Guide.

Rejecting and Declining Problematic Content

Technical Analysts can return or decline deposit activities or SIPs when the content contains technical problems.

NOTE:
Rejected content can be revised and resubmitted; declined content cannot be resubmitted.

To reject or decline problematic content:

1. On the SIPs List page (Submissions > Technical Analysis > Technical Issues), click the folder containing the deposit activities or SIPs that you want to reject or decline.
2. Select the check box(es) of the SIP(s) you want to reject or decline.

NOTE:
Multiple selections must share the same reason for rejection or decline. If one SIP is rejected for failing a virus check and another for containing an invalid file format, these must be processed separately.

3. In the Action drop-down list, select one of the following:
   - Reject – to reject the file or SIP
   - Decline – to decline the file or SIP
Decline All – to decline all of the files or SIPs in the list without having to select them.

**NOTE:**
Producer agents do not receive emails when all SIPs are declined.

4. Click **Execute**. The Action Reason page opens for the selected files (see Figure 160).

![Figure 160: Action Reason Page](image)

5. In the **Reason** drop-down list, select the reason for decline or rejection.

6. In the **Note** field, enter a note (optional).

7. Click the **Save** button.
   The file status changes to Rejected or Declined.

8. Do one of the following:
   - If there are other files in the SIP that need to be handled, resolve their issues before continuing.
   - If there are no more files in the SIP, click **Move to next stage**, then **Execute**.

   The objects are removed from the folder. A new e-mail template opens for sending information to the Producer Agent.

   The information displayed on the e-mail template is configurable by a Rosetta Administrator. The following figure shows an e-mail response with minimal information. To add or customize fields, see Customizing Display Fields in the *Rosetta Configuration Guide*. 
In the **Add message** text box, enter additional information about the problem and how it can be resolved.

To have a copy of the e-mail sent to your inbox, click the **CC e-mail to me** check box.

Click the **Send** button.

The Producer Agent who submitted the deposit activity receives a notification by e-mail that the content was rejected or declined. If you requested a CC, you will receive a copy of the same e-mail.

---

**Resubmitting or Reloading Problematic Content**

Technical Analysts can request that the Rosetta system resubmit the deposit activity to the Deposit Server or reload a SIP to the Staging Server. The system automatically identifies the part of the deposit activity or SIP that failed during the initial upload process and reloads only this part.

**To resubmit or reload problematic content:**

1. On the SIPs List page page (*Submissions* > *Technical Issues* > *Manage Issues in SIP Processing*), select the deposit activities or SIPs that you want to resubmit or reload.
2. In the **Action** drop-down list, select **Resubmit** or **Reload**.
3. Click **Execute**.

The Rosetta system resubmits the failed part of the deposit process.
Replacing a Problematic SIP or File

After Technical Analysts repair a problematic SIP or file on a local computer, they can replace the SIP or file with the repaired one.

**NOTE:**
The original ID, name, and path will reflect the original deposited file details. (The TA replacement will not be reflected in the DNX.) Return should be preferred if a DNX update is required.

**To replace a problematic SIP or file:**

1. On the SIPs List page (Submissions > Technical Issues > Manage Issues in SIP Processing), do one of the following:
   - To replace a SIP in the Loading folder, click the SIP ID number.
   - To replace a file in the Validation folder, locate the SIP, click **Work On**, and then, on the SIP Content List page, click the **Replace** text in the row that corresponds to the file.

2. On Step 1 of the Replace File wizard, update the **File Label** and enter a **File Note** as needed. Click the **Next** button to proceed to the next step, the Replace Local File page.

3. If you are uploading from a local file, remain on the Insert From Local PC tab. If you are uploading from a file on the server, click the **Choose From Server** tab to switch to the Replace Server File page.

4. Browse to or select the file you want and click the **Upload** button.
   - The system uploads your replacement file and produces a confirmation page, Replaced File, with the details of the replacement. Assessors, Arrangers, and Approvers will see an alert if a file was replaced.

After the SIP is replaced, it must be reloaded on the Rosetta system.

Viewing a Problematic SIP or File

Technical Analysts can view a problematic SIP or file in a Web browser using the View option.

**To view a SIP:**

1. On the SIPs List page (Submissions > Technical Issues > Manage Issues in SIP Processing), do one of the following:
   - To view a deposit activity in the Deposit folder, select the deposit Activity ID.
To view a SIP from the Loading or Validation folder, click the SIP ID or click the Work On text link in the SIP’s row.

To view a file in the Validation folder, locate the SIP, click Work On, and then, on the SIP Content List page, click More, then View in the row corresponding to the file.

The deposit activity, SIP, or file opens.

**Validation Stack Error Codes**

The following errors can occur when running a validation stack on a SIP or file.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Error Description</th>
<th>Error ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format Identification</td>
<td>No matching format identification</td>
<td>vs_Error.3</td>
</tr>
<tr>
<td></td>
<td>Multiple matching format identification signature</td>
<td>vs_Error.5</td>
</tr>
<tr>
<td></td>
<td>Tentatively matching format identification</td>
<td>vs_Error.9</td>
</tr>
<tr>
<td></td>
<td>File Extension Mismatch</td>
<td>vs_Error.17</td>
</tr>
<tr>
<td>File Fixity</td>
<td>Fixity Check Failed</td>
<td>vs_Error.32</td>
</tr>
<tr>
<td></td>
<td>Conflict between original checksum and populate checksum</td>
<td>vs_Error.96</td>
</tr>
<tr>
<td>MD Extraction</td>
<td>Default error during MD extraction, used to catch all unexpected errors</td>
<td>vs_Error.256</td>
</tr>
<tr>
<td></td>
<td>MD Extraction Plug-in error - Can’t process extraction tool output</td>
<td>vs_Error.768</td>
</tr>
<tr>
<td></td>
<td>Mapping error - Extractor property type is not compatible with its value</td>
<td>vs_Error.2304</td>
</tr>
<tr>
<td></td>
<td>Failed to get the MD Extraction plug-in (can’t be found in the plug-in directory)</td>
<td>vs_Error.8448</td>
</tr>
<tr>
<td></td>
<td>MD Extraction plug-in - encounter unexpected error - No properties extracted</td>
<td>vs_Error.524544</td>
</tr>
<tr>
<td></td>
<td>MD Extraction plug-in timeout - Extractor timed out while attempting to extract metadata.</td>
<td>vs_Error.4352</td>
</tr>
<tr>
<td>Virus Check</td>
<td>Virus check unknown error</td>
<td>vs_Error.32768</td>
</tr>
</tbody>
</table>
Handling a Problematic SIP or File

Technical Analysts can handle the following cases by performing the actions described below. See:

- Format Problems on page 317
- File Extension Issues on page 318
- Metadata Errors on page 319

For each of these actions, the TA can create an auto-correction rule that records the decision and performs these actions automatically the next time the same thing happens. (See Automating Corrections on page 331.)

Format Problems

When DROID cannot match a file to a single format (based on its unique file signature), the TA must manually choose a format ID and assign it to the file.

To do this, click the More > Format link that corresponds to the file you want to assign a format to (Figure 162).
The Format ID page opens (Figure 163).

![Format ID page screenshot](image)

**Figure 163: Assign Format Manually**

**File Extension Issues**

After DROID has identified a format (or the TA has done it manually), the system matches the file’s extension to the list of valid extensions as they are stored in the format library.

![File Extension Issues screenshot](image)

**Figure 164: Incompatible File Extension**
If there is a mismatch, the TA can ignore this problem and add a comment to the file's DNX.

![Figure 165: Action Reason for Ignoring Mismatched Extension](image)

**Metadata Errors**

If the metadata extraction tool (for example, JHOVE, NLNZ MD Extractor) fails to extract technical MD, the file waits for the TA to evaluate the problem. The TA can handle this issue by clicking the **MD Error** link. This allows the file to continue processing without the technical MD.
After clicking the MD Error link, the Technical Analyst can enter information in the Action Reason form (Figure 167).
Rerunning Processes

Technical Analysts can re-run processes that fail to produce successful results. The following processes can be performed to this end:

- **Rechecking a File** on page 321
- **Rerunning Validation** on page 323
- **Rerunning Enrichment** on page 323
- **Rerunning System Errors** on page 323

**Rechecking a File**

Technical Analysts can rerun validation checks on the files.

**To recheck a file:**

1. On the SIPs List page (see Accessing the Technical Issues Page on page 303), click the Validation folder.
2. Find the SIP that contains the file you want to recheck and click Work On in its row.
   The SIP details open with the Content List tab displaying the files contained in the SIP.
To recheck only one file, click the Recheck text link in the file's row. To recheck multiple files, select the check boxes of the files that you want to recheck and select Recheck from the actions drop-down list, then click Execute. (See Figure 168).

Figure 168: Recheck SIP Files

The Rosetta system runs the validation check again.

During a recheck, Rosetta exhibits the following behavior:

- A message: "Rechecking file(s) \{pids\}" is displayed
- Files are not displayed in the list
- If the recheck fails, an error message: "Recheck failed, please contact your system administrator" is displayed
- When the task is complete, the "Rechecking file(s) pid" message disappears, and files with errors (after recheck), if they exist, are displayed in the list again
- All file-level operations are available.
During the recheck, all SIP level operations are available, including Move to next stage.

Trying to execute actions other than Assign and Un-Assign will display a message: "SIP(s) \{ids\} is being rechecked - please try again later."

**Rerunning Validation**

If validation stack tasks fail to process a file, Technical Analysts can rerun the validation process for problematic files.

**To rerun validation for problematic files:**

1. On the SIPs List page (see Accessing the Technical Issues Page on page 303), in the Folders pane, click Validation.
2. Select the check box(es) beside the file(s) for which you want to rerun the validation process.
3. In the Action drop-down list, select Rerun.
4. Click Execute.

The Rosetta system runs the validation process again. If validation is successfully completed, the file is removed from the SIPs List page.

**Rerunning Enrichment**

If the enrichment process fails for technical reasons, Technical Analysts can rerun the enrichment process for problematic SIPs.

**To rerun the enrichment for problematic SIPs:**

1. On the SIPs List page (see Accessing the Technical Issues Page on page 303), in the Folders pane, click Enrichment.
2. Select the check box(es) beside the SIP(s) for which you want to rerun the enrichment process. To rerun the enrichment process on particular files within a SIP, click Work On in the SIP’s row and then select the check box(es) beside the file(s).
3. In the Action drop-down list, select Rerun.
4. Click Execute.

The Rosetta system runs the enrichment process again. If enrichment is successfully completed, the file is removed from the SIPs List page.

**Rerunning System Errors**

When SIP processing fails continuously (up to five times), SIPs are placed in the System Error folder. TAs can attempt to fix the system problems, which may be
caused by lack of memory or an Oracle disconnect or something else. If rerunning the SIP still fails, the TA or System Administrator should look at the log and attempt to solve the problem.

**To rerun a SIP with a system error:**

1. On the SIPs List page (see Accessing the Technical Issues Page on page 303), in the Folders pane, click System Error.
2. Select the check box(es) for the SIP(s) you want to rerun.
3. Select Rerun from the Actions drop-down menu.

**NOTE:**
To rerun all of the SIPs in the System Error list, skip step 2 above and, instead of selecting Rerun (step 3), select Rerun All from the Actions drop-down menu.

4. Click the Execute button.

The Rosetta system runs the SIP process again on the SIPs you selected.
Viewing and Resolving Repository Issues

This section contains:
- Technical Analyst Issues in the Repository on page 325
- Identifying Repository TA issues on page 325
- Correcting Problems on page 327

Technical Analyst Issues in the Repository

Technical Analysts (TAs) who work with issues arising from maintenance on the permanent repository are referred to as Repository TAs. Their tasks involve solving problems that are identified when validation stacks are run on parts or all of the repository.

Repository TAs perform actions similar to those of SIP TAs, although Repository TAs work with data that already exists in the repository, not with submission packages.

Repository TAs also address technical issues related to adding or updating a representation. (For more information on representations, see the chapter for Editors, Adding Representations on page 483.)

Identifying Repository TA issues

Typically, repository TA issues are identified when validation stacks are run at regular intervals by Data Managers. When results of the validation checks show problems with format identification, virus checks, technical metadata extraction, fixity, and/or risk extraction, Data Managers can view the problematic files on the Monitor Process History page (a status of Waiting... indicates a file for the Repository TA to handle). They can also configure the process to send an email notification to the TA when an object has been flagged.
Repository TAs can also access flagged issues by following the menu path: **Rosetta > Data Management > Manage Technical Issues** and viewing any items that exist there.

After running a validation stack on part or all of the permanent repository, the TA can determine which items require further manual processing.

IEs containing files that fail the validation stack appear on the **Validation** tab of the **Data Management > Manage Sets and Processes > Manage Technical Issues** path.

From here, you can Work On, Ignore, or Unassign a failed IE. Or you can use the check boxes and options from the drop-down box at the bottom of the page and click **Execute** to perform an action on more than one object at a time.

To view a breakdown of problematic files on the various checks comprising the validation stack, click the blue arrow in the **Problems** column.
To dismiss an IE that you determine cannot or will not be fixed in the near future, click the **Ignore** action of the corresponding row. This removes the IE from the TA work area and sends it to the process exception list, which indicates to the Data Manager that the IE did not pass the tasks contained in the process. The object is rolled back to a previous version.

If an object is assigned to someone and you want to assign it to a different TA or to yourself, use the **Unassign** action on the far right of the page.

**Correcting Problems**

To address problems with a failed object, click the **Work On** link of the row containing the item. Details and options for the IE open in the Content List tab.
Each file belonging to the IE is listed on the Content List tab.

Problematic files can be handled individually using the Actions links for each row or in groups of two or more (by selecting the check boxes followed by an action from the Execute drop-down menu below). Available actions vary according to the file type and the task chain performed. The following actions are available either on the Actions for individual files or in the drop-down Execute actions list:

- **Download** allows you to copy the file to a local or network drive, open it, and work on it, then replace the failed file in the repository with the one you repaired.

- **Replace** provides a 2-step wizard for uploading your repaired file from a network or local drive to Rosetta. This file replaces the existing failed file.

On selecting a file, the user sees a list with the original filename in strikethrough text and the replacement file name. Clicking **Continue** triggers an Update Representation process. The TA is returned to the IE list and the IE appears with no row actions and a "replacing file(s)" indication. If Rosetta encounters technical issues with the replacement, the IE appears in Update Rep mode for further analysis (see Managing issues with file replacements on page 329).
**NOTE:**
The TA will need to resolve all non-replace issues (ignores, rules) before replacing a file.

- **Recheck** reruns a validation check on the file(s).
- **Info** links to the item in the Web Editor, where you can make any necessary changes to repair the file or IE. When **Edit** appears as an action, it has the same function.
- **View** displays the file associated with the IE and its metadata.
- Error-driven actions such as **Fixity** and **File Ext** depend on the type of error(s) that the validation stack returns. See **Table 50** for details.
- **Events** opens a log of significant events that have occurred in relation to the object. Each event lists an Event ID that links to more details (see figure below).

### Managing issues with file replacements

The Update Rep mode indicates a problem with a new or replacement file, provided either using the Add/Update Representation function in the Web Editor, the corresponding APIs, or the Replace function in the Repository TA (task chain mode).

The TA can fix the problem using the same tools as in Task chain mode. Replacing a file in Update Rep mode deletes the original replacement file (similar to SIP TA replacement) and does not generate an additional Update Representation process (since the replacement file was never committed to the permanent repository).

If the Update Representation process was triggered by the Repository TA (in task chain mode), aborting the process returns the IE to task chain mode.
Validation Stack Rules

This section contains:
- Automating Corrections on page 331
- Configuring Validation Stack Rules on page 332
- Adding a Rule on page 334
- Updating a Rule on page 337
- Re-Ordering Rules on page 337
- Duplicating a Rule on page 338
- Activating and Deactivating a Rule on page 338
- Exporting a Rule on page 338
- Deleting a Rule on page 339

Automating Corrections

Auto-correction rules are created, edited, and implemented by Technical Analysts (TAs) during the validation of SIPs. When the validation process encounters errors, the TA can manually correct the error and assign the same correction to subsequent matching errors. For instance, when a file fails validation because DROID cannot match the file’s extension to a known format, the TA can decide that, for example, a .j123 will always be read as a .jpg. This rule can be automated to apply to all occurrences of .j123.

For more information on handling errors and creating rules, see Adding a Rule on page 334.

The types of validation stack errors that a TA may configure are:

- **Format identification auto-correction rules**: If the DROID format check fails to associate a file with one and only one format (based on the file signature), Technical Analysts can add an auto-correction rule to define the specific format to be assigned when this format is encountered again.
Files extension mismatch rules: If the DROID check detects a mismatch between valid extensions for a file and the actual extension of a file (for example, if DROID detects a PDF format ending in .xyz), the TA can instruct the system to ignore the mismatch whenever the system encounters it.

Metadata extraction error handling rules: If the JHOVE tool fails to extract technical metadata, JHOVE may declare the file invalid or not well-formed. TAs can define rules that ignore the JHOVE result under specific circumstances or that direct the system to handle the file another way.

Virus Check Error: If the virus check plugin returns an error message that the TA determines does not indicate a threat, a rule can be created to ignore the error.

Rosetta adds an event with rule parameters to the file when a rule is applied. These events can be searched under the following fields:

- Format Identification Auto Correction Criteria
- Metadata Extraction Error Ignore Criteria
- File Extension Mismatch Ignore Criteria
- Virus Check Error Ignore Criteria

When a rule is triggered, a provenance event is generated with the rule parameter details.

Configuring Validation Stack Rules

Technical Analysts can configure validation rules from the Management Home page, Submissions menu, under the Rules heading. The types of validation stack rules display in the list. (For information on the types, see the bulleted list in the above section, Automating Corrections.) To add, edit, or delete a rule, click the link (see Figure 172) that describes the type of error on which the rule is based.
Clicking the **Format Identification Correction**, for example, opens a list of rules related to format identification errors (see **Figure 173**).

The following actions can be performed on the List of Auto-Correction Rules page:

- **Adding a Rule** on page 334
- **Updating a Rule** on page 337
Adding a Rule

To add a rule to one of the validation stack error types, Technical Analysts define one or more parameters on the Rule Details page (Figure 174). (To omit one or more of the parameters, leave the operator as Any.)

- Input parameters:
  - Producer name, if matching by Producer
  - Format name to which the format of a problematic file is compared
  - File extensions to which the file extension of a problematic file is compared (add the extension manually if the extension does not appear in the Format Library list)
  - Mime type, if comparing a file on the basis of its MIME type
  - File size and creation date, for comparison on those data
  - Additional fields specific to the type of rule being added or edited

- Output parameters (one of the below):
  - The file format that must be applied to the file if its file format and extension match the input parameters
  - The reason for ignoring errors that match the input parameters
To add a validation stack error rule:

1. From the Submissions rollover menu, Advanced Tools column, click the type of error to which you want your new rule to apply:
   - Format identification auto correction rules
   - Files extension mismatch rules
   - Metadata extraction error handling rules
   The Rule List page for that error opens.

2. Click the Add Rule button.
   The Rule Details page opens (see, for example, Figure 175, Rule Details for MD Extraction Error). Parameters vary slightly based on the rule type.
3 Enter a name and description for the rule in the corresponding fields.

4 Select an operator and one or more value(s) for the input parameters you want the rule to use. If, for example, you want to narrow the rule to apply only to work deposited on behalf of a particular Producer, then for the Producer parameter, select **List Equals** and the particular Producer(s) from the right-side list box.
NOTES:

- The format value list uses the format identifiers taken from the format library.
- For detailed information about operators and parameters, see Operators Used in Rule Parameters on page 184.

5 Click Save.

The Rosetta system saves the new validation stack rule and can use it to identify a specific action to be taken.

Updating a Rule

Technical Analysts can update a rule to modify its input or output parameters.

To update an auto-correction rule:

1 On the List of Rules page (see Figure 173), locate the auto-correction rule that you want to update and click Update. The Rule Details page opens.
2 Modify the fields that you want to update, and then click Save.

The Rosetta system now uses the updated parameters.

Re-Ordering Rules

To determine the rule that must be used for a specific file, the Rosetta system compares the input parameters defined in a rule with the parameters of the file.

Rules are analyzed in the same order as they are displayed on the List of Rules page. The Rosetta system uses the first auto-correction rule found that match the parameters of the file.

Technical Analysts can change the order of rules.

To re-order auto-correction rules:

1 On the List of Rules page (see Figure 173), in the Set Order column, use the up and down arrows to change the order of the rules.
2 Click Save.

The Rosetta system now processes the rules in the newly defined order.
Duplicating a Rule

Technical Analysts can duplicate an existing rule. This is especially helpful when creating a new auto-correction rule. It is often faster to duplicate an existing auto-correction rule and then modify it, than to create a new rule.

To duplicate a rule:

On the List of Rules page (see Figure 173), locate the auto-correction rule that you want to duplicate, and click Duplicate in its row.

An exact copy of the rule is added to the List of Rules page. The Rosetta system automatically labels the new rule with the name Copy of followed by the name of the original rule.

Activating and Deactivating a Rule

Technical Analysts can activate or deactivate a rule. After an auto-correction rule is deactivated, it is no longer available to the Rosetta system for matching.

On the List of Rules page, the status of the rule is indicated by the check mark in the Active column:

- Yellow – The auto-correction rule is active.
- Grey – The auto-correction rule is inactive.

To activate or deactivate an auto-correction rule:

1. On the List of Rules page (see Figure 173), locate the auto-correction rule you want to activate or deactivate.
2. In the Active column, click the check mark.

The page refreshes, and the check mark in the Active column indicates the new status. (The rule is changed from active to inactive, or from inactive to active.)

Exporting a Rule

Technical Analysts can export rules to share them with other institutions.

To export rules, on the List of Rules page (see Figure 173), click Export Rules. Rosetta generates a CSV with all the rules' details.
Deleting a Rule

Technical Analysts can delete an existing rule. After a rule is deleted, it is no longer available to the Rosetta system for matching.

To delete a rule:

1. On the List of Rules page (see Figure 173), locate the rule you want to delete and click Delete. The confirmation page opens.
2. Click OK.

The rule is deleted from the Rosetta system.
Part VI
Editors

This part contains the following sections:

- Chapter 33: Understanding Editors on page 343
- Chapter 34: Working with Shared Metadata on page 345
Understanding Editors

Editors work with IE content and shared metadata in the department, institution, or consortium to which they are assigned. They are responsible for editing individual IEs in their assigned scope, for example:
- Editing descriptive metadata of the content deposited by Producer Agents
- Adding new representations

Editors are assisted in their work by the **Data Management > Search and Queries** section of the Management module, which includes the following links:
- Search for Objects
- Search for Metadata
- Saved Queries

The search features allow the Editor to find IEs and metadata, while queries allow the Editor to save searches for future reference and research.

**NOTE:**
Queries cannot be used as the basis for sets. Only set creation wizards as executed by Data and Preservation Managers can be used for sets.

Editor permissions can be View, Typical, or Full. Editors’ scope can be either department, institution, or consortium. Scope can be set on a metadata type level. For example, the following configuration allows descriptive metadata editing and prohibits editing DNX, structmaps, and assigning an access rights policy.
Figure 176: Role Parameters
Working with Shared Metadata

This section contains:
- About Shared Metadata on page 345
- Search Metadata on page 345

About Shared Metadata

Shared metadata is the metadata that can be assigned to multiple intellectual entities (IEs). The following metadata can be shared in the Rosetta system:

- Access rights policies
- Content Management System (CMS) records

For information on working with access rights, see Access Rights on page 127.

To integrate CMS records from Voyager or another ILS in your system so that they can be shared, contact your Ex Libris Implementation or Professional Services Consultant.

NOTE:
The Search for Metadata link on the Rosetta menu only applies if you have set up Rosetta to search your ILS or CMS.

Search Metadata

The Metadata Search page enables Editors to search and view metadata shared from a CMS.
To access the Metadata Search page and perform a search of shared metadata:

1. From the Rosetta drop-down menu, click Data Management > Search and Manage Queries > Search for Metadata.

   The Metadata Search page opens. Currently, only CMS metadata is searchable from this page (Figure 177).

   ![Metadata Search Page](image)
   
   Figure 177: Metadata Search Page

2. In the Find field, enter a search term(s).

3. From the in: drop-down list, select the metadata field you want to search.
Figure 178: Metadata Fields

4 Click Go.

The system returns items from your library catalog that match the terms and restrictions specified by the metadata search parameters.

Figure 179: Metadata Search Results
Part VII
Data Managers

This part contains the following sections:

- Chapter 35: Understanding Data Managers on page 351
- Chapter 36: Working with Sets on page 353
- Chapter 37: Working with Processes on page 367
- Chapter 38: Publishing on page 379
- Chapter 39: Delete, Restore, Move, and Purge IEs on page 387
- Chapter 40: Fixity, Provenance, and Storage on page 405
- Chapter 41: Scheduling Metadata Update Jobs on page 411
- Chapter 42: Collections on page 419
Understanding Data Managers

Data Managers schedule processes, manage sets, and run activities that affect multiple IEs.

Data Managers are responsible for:
- Managing sets
- Scheduling and monitoring processes
- Publishing configurations, and
- Managing the recycle bin.

Data Managers can also work with individual IEs, but their primary role is to work on groups of data at an institutional level.

Permissions for Data Managers differ slightly from those of most other roles. Data Managers can have Typical permissions, which include adding/editing and deleting IEs or they can have Full permissions, which include all the abilities of the Typical permissions as well as the ability to purge items that have been deleted.

Data Managers’ scope can be either institutional or consortial.

NOTE:
For information on Access Rights Policies and Retention Rights Policies, see Access Rights on page 127 and Retention Policies on page 147.
Working with Sets

This section contains:
- About Sets on page 353
- Accessing the Manage Sets Page on page 354
- Creating Sets on page 355
- Viewing Sets on page 364
- Deleting a Set on page 365

About Sets

To facilitate searching and accessing intellectual entities (IEs) that are stored in the Rosetta repository, Data Managers can create sets of IEs. A set is a group of objects (complete IEs, representations, or individual files) that satisfies criteria defined by Data Managers, such as matching on the creation date or the Producer’s name.

Data Managers can include in sets those objects that are frequently accessed. Then, instead of running a search every time such objects are required, a Data Manager accesses the appropriate set.

Data Managers can create an itemized set or a logical set.

- An itemized set contains a static group of objects that satisfies certain criteria. Data Managers manually select the objects to be stored in the set from the results of the search.

  For example, if a Data Manager runs a search for Monet artworks and 25 objects are found, the Data Manager can select 10 paintings and save them as an itemized set. The Data Manager can then access this set and work with the objects without having to search for these paintings again.

  The itemized set is static—that is, even if new objects that satisfy the criteria are moved to the Rosetta repository, the itemized set does not change.
However, Data Managers can manually add new objects to an existing itemized set.

- A logical set contains:
  - A search request defined by a Data Manager
  - All objects that satisfy the search request

For example, if a Data Manager runs a search for Monet artworks painted in 1890-1900, all objects that satisfy these criteria are automatically included in the set.

The logical set is dynamic—that is, it is updated every time Data Managers access the set and run the search request. New objects that satisfy the search criteria are automatically added to the set.

Data Managers can manage both itemized and logical sets using the Manage Sets page.

**Accessing the Manage Sets Page**

The Manage Sets page enables Data Managers to create and manage both itemized and logical sets.

**To access the Manage Sets page:**

From the Management Home page, click the Data Management link in the header or on the main pane. From the Data Management page, click Manage Sets under the Manage Sets and Processes heading. The Manage Sets (Set List) page opens.
Creating Sets

Data Managers can create the following types of sets:

- Logical sets to store search queries that result in dynamically updated groups of objects
- Itemized sets to store static groups of objects

Creating a Logical Set

Logical sets function as queries or filters that select a new set of IEs each time they are run.
To create a logical set:

1. On the Data Management main menu (see Accessing the Manage Sets Page on page 354), above the sets list, click Add Set. The Add Set page opens, step 1 of the Add Set wizard.

2. Select Logical - Based on a search query, and click Next. The Set Details page opens.

3. Complete the fields as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the set as you want it to appear in Set List pages and applicable lists of sets.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the set's content or parameters.</td>
</tr>
</tbody>
</table>
Step 3 of the wizard opens.

Logical sets display the Simple Search page with the option to switch to the Advanced Search page.

4 Click **Next**.

5 Create the query for your search using the search form.
6 Click the Go button to run the search. The system returns results. For an explanation of results columns, see Table 52.

7 If the results are appropriate for the purposes of your query, save the query. If the results are not adequate, alter some or all of your query and rerun the search.

8 Save the query/logical set.

**NOTE:** When you save the logical set, you are saving only the query, not the items returned in this particular search. When the database changes, your query may return different IEs.

### Logical Sets - Updating

Data Managers can change both the general information of a set as well as the query criteria.

**To update the general information for a logical set:**

1 On the Manage Sets > Set List page (see Accessing the Manage Sets Page on page 354), locate the set you want to change and click **Update**. The Set Details page opens.

2 Modify the fields as described in **Table 51, Set Details Page Fields** on page 356, and click **Save**.

**To update a query for a logical set:**

1 On the Manage Sets > Set List page, locate the set you want to change and click **Results** in the corresponding row.

2 Edit the search conditions as needed and click **Search**. The updated query results show on the Results section of the page.

3 Once you are satisfied with the query results, click **Save** to update the logical set query.

### Creating an Itemized Set

Itemized sets are comprised of a group of IEs that have been selected through a simple or advanced Rosetta search or through a text file of PIDs prepared by your institution. Both methods are described in the procedure below.
To create an itemized set:

1. On the Data Management main menu (see Accessing the Manage Sets Page on page 354), above the sets list, click Add Set. The Add Set page opens, step 1 of the Add Set wizard.

![Figure 184: Add Set Page](image)

2. Select Itemized - based on selected objects, and click Next. The Set Details page opens.

![Figure 185: Set Details Page for Itemized Set](image)

3. Complete the fields as described in the Set Details table on page 356.

4. To use a simple or advanced search to create set items:
   a. Click the Next button and enter search terms and parameters in the available fields.
   b. Click the Go button.
      The system returns matches to your search.
The page displays a simple search row above the sort fields for searching for IEs with the option to switch to an advanced search. The table contains the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check boxes</td>
<td>Selecting these enables Data Managers to perform an action on multiple items.</td>
</tr>
<tr>
<td>Title</td>
<td>Displays the title of the set member.</td>
</tr>
<tr>
<td>Type</td>
<td>Displays the type of the content object: IE, representation, or file.</td>
</tr>
<tr>
<td>PID</td>
<td>Displays the unique deposit number assigned to the set member.</td>
</tr>
<tr>
<td>SIP ID</td>
<td>Displays the unique SIP number assigned to the set member.</td>
</tr>
<tr>
<td>Producer</td>
<td>Displays the name of the set member's Producer.</td>
</tr>
</tbody>
</table>
If the system returns results you want for your set, select the check boxes beside the IEs, and then click the **Add Selected** button. If the system returns no items you want for your set, try different search parameters.

Repeat searches and add selections as necessary.

When you have your set, click the **Save** button. The system saves your set and returns you to the Set List page.

To upload a text file containing the PIDs you want to include in your set, do the following:

- Create a `.txt` file with one PID per line. PIDs should take the form of `IE[n]`, where `n` is the multi-digit ID. For example, `IE2984`.
- Click the **Browse** button of the **Get IEs from File** field.
- Browse to the PID text file on your computer, select it, and click **Open**.
- Click the **Next** button.

The text file loads, and the system checks for matches in the database. It returns a status message at the top of the Set Members page, as shown in the image below.

---

**Table 52. Add Set Page Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation Date</td>
<td>Displays the creation date of the set member.</td>
</tr>
<tr>
<td>View</td>
<td>Enables viewing the member using the Rosetta Delivery module.</td>
</tr>
<tr>
<td>Info</td>
<td>Enables viewing the member using a Web browser.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports the IE to a zip file.</td>
</tr>
</tbody>
</table>
You can remove any items by selecting their check boxes and clicking the **Delete Selected** button.

To complete the set, click the **Add Members** button to open the Simple Search page. From here you can conduct a search for more IEs or, if you are satisfied with your set, conduct a mock search that will take you to the next page where you can save your set.

After you save your itemized set, the system returns you to the Set List page, where the new set appears in the list.

**NOTE:**
Sets can be created and updated using APIs. For more information, see the SDK documentation.

### Itemized Sets - Adding Members

Data Managers can add members to the itemized set by manually selecting the members.
To add members to an itemized set:

1. From the Set Members page of a new or existing set (see Creating Sets on page 355), click the Add Members button.

![Figure 188: MemberList Page](image1)

The Search page opens.

![Figure 189: Search Page](image2)
Perform a simple or advanced search in the row above the sort selection fields. For details on simple and advanced searching, see Searching and Reporting For All Staff on page 23.

From the results of the search, select the members that you want to add to the set by clicking the members’ check boxes. (See Figure 189.)

Click Add Selected.

Click Save.

New members are added to the itemized set. Data Managers can access the members at any time.

**Viewing Sets**

Data Managers can view itemized and logical sets to see objects that are included in a set as well as general information.

**To view a set:**

1. On the Set Members page (Data Management > Manage Sets > Set List) locate the set that you want to view.
2. Do one of the following:
   - To view an itemized set, click Members.
   - To view a logical set, click Results.

The Set Members page opens.
Deleting a Set

Data Managers can delete a set. However, the Rosetta system does not enable Data Managers to delete a set that is scheduled for, or is being used in, a task.

To delete a set:

1. On the Manage Sets > Set List page (see Accessing the Manage Sets Page on page 354), locate the set that you want to delete and click Delete. The confirmation page opens.

2. Click OK.

The set is deleted from the Rosetta system.
Working with Processes

This section contains:

- About Working with Processes on page 367
- Viewing All Existing Processes on page 367
- Viewing Process Information on page 369
- Running a Process on page 373
- Aborting a Process on page 377

About Working with Processes

Data Managers can view processes that are executed in the Rosetta system. Processes consist of:

- **Tasks**, which are programs that perform operations on an object in the system. For example, a task may create a thumbnail of an image file. Similarly, a task may extract metadata from a file. Tasks are the basic building blocks of operations in the system.

- **Task chains**, which are ordered lists of tasks. For example, a task chain may contain the following tasks:
  - Creating thumbnails
  - Adding metadata from the collection management system (CMS)
  - Adding Oracle text (used for better indexing in the Permanent Repository)

Viewing All Existing Processes

Data Managers can view a list of all existing processes.
To view all existing processes:

From the Data Management main menu, select **Manage Processes**. The Process List page opens.

![Figure 191: List of Processes Page](image)

The page contains the following columns:

**Table 53. List of Processes Page Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Indicates the process status:</td>
</tr>
<tr>
<td></td>
<td>- Yellow - The process is active.</td>
</tr>
<tr>
<td></td>
<td>- Grey - The process is inactive.</td>
</tr>
<tr>
<td>ID</td>
<td>The process ID generated by the Rosetta system.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the process.</td>
</tr>
<tr>
<td>Task Chain Name</td>
<td>The associated task chain.</td>
</tr>
<tr>
<td>Task Chain Groups</td>
<td>The name(s) of the group that can access the process.</td>
</tr>
</tbody>
</table>
Table 53. List of Processes Page Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduling</td>
<td>Displays the day, date, and/or frequency of the running of the process.</td>
</tr>
<tr>
<td>Status Date</td>
<td>Displays the last date on which the process status was changed.</td>
</tr>
</tbody>
</table>

Actions available for the process list items appear to the right of the information columns and expand when you click the More... text with the down arrow. These actions include:

- **Duplicate:** Duplicates the values for this or any other process listed in the task chain. Sends you through the process creation wizard.
- **Update Schedule:** Allows you to change the values for the scheduling of this process. (Takes you to the scheduling page.)
- **Update Set:** Opens the set selection page, where you can choose a different set for this process.
- **Update Parameters:** Takes you to the Complete Parameters page, where you can change parameter values for this process.
- **History:** Takes you to the Monitor Process History > Summary page, where you can view information such as status and run-time for the process.
- **Delete:** Deletes the process from the system and the table.

**Viewing Process Information**

Data Managers can view various details about the processes, including a list of processes that are currently running and a summary of completed processes. Data Managers view process information by Accessing the Process Execution History Page (see page 369). The following activities can be performed from this page:

- **Viewing Completed Processes** (see page 371)
- **Viewing Process Executions** (see page 371)
- **Viewing Summarized Execution History for a Process** (see page 371)
- **Viewing the History of Execution Exceptions for a Process** (see page 372)

**Accessing the Process Execution History Page**

The Process Execution History page enables Data Managers to view the list of processes that have been executed in the Rosetta system.
To access the Process Execution History page:

On the List of Processes page (see Viewing All Existing Processes on page 367), locate the process you want to view and click History. The Process Execution History page opens.

The Execution History page contains the following columns:

<table>
<thead>
<tr>
<th><strong>Table 54. Execution History Page Columns</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column</strong></td>
</tr>
<tr>
<td>ID</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Status</td>
</tr>
<tr>
<td>Started On</td>
</tr>
<tr>
<td>Finished On</td>
</tr>
<tr>
<td>Successes</td>
</tr>
<tr>
<td>Failures</td>
</tr>
<tr>
<td>Failure Note</td>
</tr>
<tr>
<td>Exceptions</td>
</tr>
<tr>
<td>Summary</td>
</tr>
</tbody>
</table>
**Viewing Completed Processes**

Data Managers can view whether a process completed normally, or experienced a problem during execution.

*To view completed processes:*

On the History Execution page (see Accessing the Process Execution History Page on page 369), in the Filter drop-down list, select **Completed**. Only completed processes are displayed.

**Viewing Process Executions**

Data Managers can view a list of all processes that are currently executing.

*To view process executions:*

On the History Execution page (see Accessing the Process Execution History Page on page 369), in the Filter drop-down list, select **Running**. Only those processes currently executing are displayed.

**Viewing Summarized Execution History for a Process**

Data Managers can view a summarized execution history of a process. This enables them to see a summary snapshot of the process’s last execution.

*To view a summarized execution history for a process:*

On the History Execution page (see Accessing the Process Execution History Page on page 369), locate the process you want to view and click **Summary**. The Execution History Summary page opens.

![Figure 193: Execution History Summary Page](image)

The Execution History Summary page displays the following fields:
Table 55. Execution History Summary Page Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>The process ID</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the process</td>
</tr>
<tr>
<td>Task Chain</td>
<td>The name of the task chain</td>
</tr>
<tr>
<td>Set ID</td>
<td>The ID of the set that is using the process</td>
</tr>
<tr>
<td>Created On</td>
<td>The creation date of the process</td>
</tr>
<tr>
<td>Created By</td>
<td>The name of the user who created the process</td>
</tr>
<tr>
<td>Started On</td>
<td>The start date and time of the execution</td>
</tr>
<tr>
<td>Finished On</td>
<td>The end date and time of the execution</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the execution</td>
</tr>
<tr>
<td>Status Date</td>
<td>The date and time of the Status field's last update</td>
</tr>
<tr>
<td>Total Run Time</td>
<td>The total run time of the execution. This is based on the Started On and Finished On fields.</td>
</tr>
<tr>
<td>Total Records Processed</td>
<td>The total number of objects processed</td>
</tr>
<tr>
<td>Total Records with Exceptions</td>
<td>The total number of processed objects with exceptions</td>
</tr>
<tr>
<td>Total committed records</td>
<td>The actual number of records committed to the database over the course of this procedure'</td>
</tr>
<tr>
<td>Total records sent to commit</td>
<td>The total number of records sent to be committed to the database.</td>
</tr>
</tbody>
</table>

Click Back to return to the previous page.

**Viewing the History of Execution Exceptions for a Process**

Data Managers can view the history of exceptions for a process.

**To view the history of execution exceptions for a process**

On the History Execution page (see Accessing the Process Execution History Page on page 369), locate the process for which you want to view exceptions and click Exceptions. The Execution History Exceptions page opens.
Chapter 37: Working with Processes

Figure 194: Execution History Exceptions Page

The Execution History Exceptions page contains the following columns:

Table 56. Execution History Exceptions Page Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID</td>
<td>Displays the ID of the SIP to which the object belongs.</td>
</tr>
<tr>
<td>Title</td>
<td>Displays the SIP name.</td>
</tr>
<tr>
<td>Exception</td>
<td>Displays a description of the exception.</td>
</tr>
<tr>
<td>View</td>
<td>Displays the IE that failed during the initial delivery process.</td>
</tr>
<tr>
<td>Info</td>
<td>Opens the object in the Web editor.</td>
</tr>
</tbody>
</table>

You can rerun the process on the items in the exception list by clicking the **Rerun Process** button.

You can create a set for further use of the exceptions by clicking the **Create Set** button.

**Running a Process**

Data Managers can run jobs based on processes and task chains that have been set up in the system. The processes are applied to IEs, representations, or files, as specified in the Level column of the Choose Task Chain page (see below).

**To set up a process:**

1. From the Process List page (Data Management > Manage Sets and Processes > Manage Processes), click the **Add Process** button.

   The first step of the Add Process wizard opens, Choose Task Chain.
From the list of task chains, select the one that suits your purpose.

**NOTE:**
The **Status** should be **Active** and the **Level** should match the level of object (IE, representation, or file) that you want the process to encompass.

Click **Next**.

Step two of the wizard, entering parameters, opens.
4 Enter a name for this particular process. The name will be used to identify this process in a list of all processes.

5 Select the priority for this process.

**NOTE:**
Fasttrack processes (processes initiated via the Web Editor) are set to high priority by default.

6 Enter any required parameters and enter optional ones, as needed. (Some processes require no parameter specifications, others require several.)

7 Set the email notification level to receive an email notification when the process completes, only when it fails, or never. (Your registered email address will be added automatically; recipient addresses can be added, separated by semicolons.) When you are finished, click **Next**.

Step three of the wizard, defining the set, opens (**Figure 197**).
NOTE:

Only objects of the type specified in your initial process selection appear in this list. For example, this process acts on files, so the available sets are limited to those with an Object Type of File.

---

8  Select the set to which you want to apply the process. Select the check box below the list if you want to apply the process only to new objects. When you are finished, click Next.

The scheduling step of the wizard opens (Figure 198).

---

Figure 197: Define Set for Process

Figure 198: Scheduling the Process (Once Option)
9 Select the type of schedule you want the process to follow from the left side of the page, then enter details on the main part of the page. When you are finished, click Next.

The Review and Confirm step of the process wizard opens (Figure 199).

![Figure 199: Review, Correct, Confirm, Submit](image)

10 Review the information regarding the process you just created. If there are errors, click the Back link until you arrive on the page containing the error, and make any necessary changes. When the process is completed to your satisfaction, click the Submit button.

The process is set to run as you specified in this procedure.

### Aborting a Process

To abort a running process, click Abort. Rosetta removes all waiting bulks of IEs from the process queue and the process ends after the current bulk of IEs is completed.
The Publishing module in Rosetta accommodates the increasing demand for libraries to provide their users with integrated Web-based OPACs and instant retrieval of all available resources based on a user’s search and access rights.

The Rosetta Publishing module integrates the following components in a hierarchical system, where the Publishing configuration is the highest-level entity that organizes the sub-entities, set and profile, as follows:

- Publishing configuration – a logical definition for a group of IEs (a set) bound to converters and targets using certain rules and having attributes such as name and status.
- Publishing set – a group of conditions applied to IEs’ DNX and descriptive metadata (indexed fields) that defines the IEs that will be processed.
- Publishing profile – the technical definitions for the Publishing module. These consist of two parts:
  - Converter – the type of conversion used on the IEs.
  - Target – the physical location where the IEs are published.

The converter and target make up the publishing profile, which, together with the publishing set, make up the publishing configuration.
Configuring Publishing

The Web pages and their associated tasks for configuring Rosetta publishing are described below.

Opening Page: Publishing Configuration List

To begin configuring the Publishing module in Rosetta, follow the path: **Home > Data Management > Publishing Configuration List.**

![Figure 200: Publishing Configuration List Page](image)

The following viewing options are available from the Publishing Configuration List page:

- Filtering the list by **Active, Inactive, or All**
- Searching the list using the **Find** field, entering a keyword, specifying search fields, and clicking **Go**
- Sorting the list by date, description (alpha), or name (alpha) by clicking the corresponding column header

Actions that can be launched from this page are:

- Adding a new configuration (**Add Configuration** button)
- Updating an existing configuration (**Update** text link)
- Duplicating an existing configuration (**Duplicate** text link)
- Deleting a configuration (**Delete** text link)
- Synchronizing configuration (**Sync Configuration** text link): runs the task that checks if there is an update that needs to be published, and, if there is, publishes it.
Adding/Updating Configurations

The Publishing Configuration Details page opens when you click the option to add, duplicate, or update from the Publishing Configuration List page.

The page contains three tabs and opens to the General Details tab.

General Details Tab

The General Details tab provides a name for the configuration and an optional description. The Name and Description values appear on the Publishing Configuration List page.

Selecting the Republish check box republishes all records in the set whether or not they have been updated since the last publishing job. This option can be used if you have changed your job’s profile details (for example, changes to an xsl file). The check box remains checked until the next (successful) publishing job, after which it is automatically cleared.

Sets Tab

The Sets tab of the Publishing Configuration Details page allows you to create a set through a short wizard and add that set to a configuration.

For information on creating sets, see Creating Sets on page 355.

When you have created at least one set, you can click the Add Sets button from the Publishing Sets page. In Figure 200 on page 380, only one set has been saved. Select it and click the Add Selected button to make this your set for the publishing configuration.
NOTE:
Ex Libris recommends that you limit your set selection and your profile selection to one each for each publishing configuration.

Profiles Tab

Profiles consist of converters and targets that process the sets created for publishing. Profile information is accessed by clicking the Profile tab from the Publishing Configuration List page (Data Management > Manage Sets and Processes > Publishing Configuration > [Add or Update Configuration] > Publishing Configuration Details).

Any existing profiles are listed. (None are shown in Figure 202.)

To add a profile:

1. Click the Add Profile button. Step 1 of the profile wizard opens.
2. Enter a name for the publishing profile in the Name field (required) and a description in the Description field (optional).
3. Select the Preservation Type from the right pane to move your selection to the left pane. You can select multiple preservation types.
4. The Status field defaults to Active. To change the profile to inactive, use the drop down selection.
5. Select a Converter Type and a Target Type from the drop-down fields (defaults are selected, as shown in Figure 203).
Figure 203: Add Publishing Profile - Step 1

NOTE:
The converter and target types are required. For more information on converters, see Converter Types on page 385. For information on targets, see Target Types on page 385.

6 Use the check boxes (Include CMS and Include Access Rights) to include the relevant metadata in the profile.

7 Click Next.

Step 2 of the wizard opens. Selections and entries you made in Step 1 show in the header and body sections of the form. Any parameters required for converter and target types must be entered on this page.
Enter any required parameters and click **Save**.

The Profile Page refreshes with the new profile listed under the Profiles tab (Figure 205).

Once you have created a profile, you can synchronize it with the general configuration, save it to the system, or apply it (saving while remaining on the same page) to the profile.
Converter Types

Converters take the relevant information from the IE and prepare it for publication. Different converters take different fields from the IE (descriptive metadata, DNX, source metadata) and create different structures of XML files (OAI, DC, Xepicur).

The following plug-in converters are supported by Rosetta:

- CMS: Converts the metadata fields of the IE into fields published to Aleph.
- OAI: Takes the descriptive metadata fields of the IE and creates an XML in OAI-DC format.
- Xepicur: Converts the fields of the IE published to the DNB (German National Library).
- XSL: Allows libraries to use any kind of XSL file that converts the metadata fields of the IE (in DC format) to any other XML format.

**NOTE:**
Several XSL examples are located under /exlibris/dps/d4_1/system.dir/xsl/, and they will be overwritten by Rosetta service packs. If you customize these files, rename them or move them to an alternative location.

Target Types

A target is the physical location where the published metadata is sent as part of the publishing process. Targets are available for external systems to harvest.

The currently supported targets are:

- OAI: According to the protocol OAI-PMH, the published metadata is stored in database tables and can be harvested by external systems.
  
  For more information regarding OAI-PMH see [http://www.openarchives.org/pmh/](http://www.openarchives.org/pmh/).

- NFS: Used when the published metadata should be stored in the file system to which the system that harvests the data has access.

The target types, NFS and OAI, are configured with the converters according to the specifications required by the converters.

Figure 206 and Figure 207 below are examples of converter-target combinations.
NOTE:
The forms differ for each converter type.
Delete, Restore, Move, and Purge IEs

This section contains:
- Deleting, Restoring, and Purging an IE on page 387
- Moving IEs on page 397
- Restoring IEs from the Permanent Repository on page 402

Deleting, Restoring, and Purging an IE

The section includes the following information:
- About Deleting, Restoring, and Purging an IE on page 387
- Deleting an IE from the Web Editor on page 388
- Deleting IEs in Bulk on page 390
- Recovering an IE from the Recycling Bin on page 395
- Purging an IE from the System on page 397

About Deleting, Restoring, and Purging an IE

When IEs are deleted from the system, they are sent to the recycling bin, and their status changes to Deleted. From the recycling bin, they can either be restored to their original status or purged from the system.

**NOTE:**
IEs in the recycle bin retain their CMS information, and the Metadata Orphan Handler does not update the CMS system until the IEs are purged.

When an IE has been purged, only provenance events remain on record in the system.
Deleting and restoring can be performed by a user with the role of Editor - Full. Purging an IE from the system can only be performed by a user with the role of Data Manager.

**NOTE:**

Deleting and Purging an IE are assigned to different roles in order to avoid accidental and permanent deletion of an IE.

The following table describes user actions and system behavior related to deleting, restored, and purging IEs.

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Actions</th>
<th>Resulting IE Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete IE(s) (from the Web Editor or using a system process)</td>
<td>Changes the IE status to Deleted without any other actions</td>
<td>Deleted – cannot be viewed, edited, published or searched for (but can be recovered).</td>
</tr>
<tr>
<td>Recover IE (from the recycling bin)</td>
<td>Changes the IE status to In Permanent.</td>
<td>In Permanent</td>
</tr>
<tr>
<td>Purge IE permanently (from the recycling bin)</td>
<td>Deletes the streams and the operational data, all the metadata from the METS file except the provenance events that remain for audit and logging.</td>
<td>Deleted – cannot be viewed, edited, published, or searched for (and cannot be recovered)</td>
</tr>
</tbody>
</table>

**Deleting an IE from the Web Editor**

When a user deletes an IE, the IE becomes unavailable for standard actions in the Web Editor.

**To delete an IE:**

1. Perform a search on the database (through Data Management > Search for Objects, for example) to find the IE you want to delete.
2. Click Info in the row of the object you want to delete.

   The object opens in the Web Editor (Figure 208).
Chapter 39: Delete, Restore, Move, and Purge IEs

Figure 208: Deleting an IE

3 Click the IE in the lower left box of the Web Editor so that it displays a yellow highlight.

4 In the bottom pane, click the down arrow of the Actions drop-down field and click the Delete IE option.

**NOTE:**

The Delete IE option does not appear in the drop-down list if you have not locked the object. All objects must be locked before action can be taken on them. (This prevents two users from interfering with each other’s work.) If you see an option to lock the object, select that and click the GO button. When the page refreshes, you should see several options in the drop-down list, including Delete IE.

5 Click the GO button.

The Deletion Reason and Note Page opens (Figure 209).
Use the drop-down menu to select a reason for the deletion.

7 Enter a note in the text field if you want more information to be recorded with this action.

8 Click the **Save** button to complete the deletion of the IE.

### Deleting IEs in Bulk

The bulk delete process deletes IEs by removing them from the permanent repository to the recycle bin area. Users schedule the process using two input parameters:

- Task chain – created using the task chain UI.
- Set of IEs – created using the set management UI. To create a set of IEs (an itemized set), see **Creating an Itemized Set** on page 358 of this guide.

### To create a process that deletes multiple IEs:

1 From the Management Home page, click **Data Management > Manage Processes**.

   The Process List page opens to existing processes.
2. Click the **Add Process** button.

The list of task chains opens. This is the first step of a 5-step wizard that guides you through the creation of the process.

3. Select the **Delete IE** task chain and click the **Next** button.

The Complete Parameters (step 2) of the wizard opens.
Enter a process name and a reason for deleting the IE set.

Enter an optional note to be retained as provenance material even if the IE set is purged from the system.

To purge the IE set immediately from the system, select the **Delete Permanently** check box. (This is equivalent to purging the IEs in the recycle bin.)

Click the **Next** button.

The Define Set step (3) of the wizard opens.
Select the itemized set you created for this process and click **Next**.

**NOTE:**
Select the **Exclude...** check box to avoid objects that have already been processed.

The scheduling step (4) opens.
9 Select the interval in the left column of the page and enter values in the right column as they display. To run the process right away, leave the default value, **No Scheduling**. Then, from the process list, click **Run Now** for your process.

10 Click **Next**.

The Review and Confirm step (5) opens.
Review the information. To change any information or parameters, use the Back button(s) to take you to the necessary page.

When the process is complete, click the Submit button. The system adds your process to the Process List page and carries out the process to your specifications.

Recovering an IE from the Recycling Bin

IEs that have been deleted through the Web Editor can be recovered from the Recycling Bin. Retrieving an IE from the Recycling Bin restores it to its previous location in the database.

**NOTE:**
If you have moved the IE from one institution to another, the restoration will move it back to the earlier institution.
To recover an IE from the Recycling Bin:

1. From the Home page, roll your cursor over the Data Management tab, then select Recycle Bin under the Delete From Permanent heading.

   ![Figure 216: Recycle Bin Link on the Data Management Page](image)

The Recycle Bin page opens. Any IEs that have been deleted but not purged from the system are listed with identification information and information on their deletion. Items can be sorted by clicking the column headers you want to sort by and filtered by selecting an option from the Filter drop-down list.

![Figure 217: Recycle Bin Page](image)

Action items are also listed in each IE row:

- **view METS** displays the METS XML for the IE
- **Recover** restores the IE from the Recycle Bin to the repository
- **Delete Permanently** deletes the IE permanently
- **Retry** attempts to delete an IE after a previous attempt failed. This option only appears for IEs with status Failed.
- **More** opens a third link, View Reason and Note, which, when clicked, displays the PID, Delete Date, and the reason and note explaining why the IE was deleted.

2. To restore a single IE, click **Recover** on the corresponding row. To restore more than one IE, select the check box to the left of the title for each IE you
want to restore, then select Recover from the Action field and click the Submit button.

The system restores the IE or IEs you selected and refreshes the page with a message that it successfully restored the IE. The items that were restored no longer appear on the Recycle Bin page.

**Purging an IE from the System**

Users with the role of Repository Manager can permanently delete IEs from the system.

**To purge an IE from the system:**

1. Log on in the capacity of a Data Manager.
2. Open the Recycle Bin page by clicking through Home > Data Management > Delete From Permanent/Recycle Bin.
3. Do one of the following:
   - Click the check boxes beside the names of the IEs that you want to delete permanently, from the Action drop-down list select Delete Permanently, and click Submit.
   - Select Delete Permanently in the row of the IEs that you want to delete.

To delete all of the IEs in the Recycle Bin, select Delete ALL Permanently from the Action drop-down list and click Submit.

If the deletion is successful, the system sends a confirmation message to the user, permanently deletes the IEs, and saves provenance information.

If an IE fails to be deleted, it is given the status Failed. You can retry to delete failed IEs by clicking Retry in the row of a failed IE, or select Delete ALL Permanently from the Action drop-down list and click Submit.

**Moving IEs**

In the course of managing a consortium with several institutional and departmental members, libraries may want to move some or all of the IEs from one location to another. A task chain accessed from the Data Management module of Rosetta provides the steps for carrying out the transfer of IEs.

The following rules and conditions apply when transferring IEs:

- The initiating member needs to own the IEs being moved (but does not need permissions for the target institution)
- Moving IEs between institutions/departments generates a provenance event.
If an IE is assigned to a collection, and the institution changes when the IE is moved, the collection will be unassigned.

If an IE’s source and target departments are identical, the IE will be ignored by the task.

**To move IEs:**

1. From the Process List page (Data Management > Manage Sets and Processes > Process List), click the Add Process button (see Figure 218).

   ![Figure 218: Add Process Button on Process List Page](image)

   The Choose Task Chain page opens (Figure 219).

   ![Figure 219: Choose Task Chain Page](image)
Find the task chain named **Move IE to Another Institution/Department** and select it. Then click **Next** at the bottom of the page.

The Complete Parameters page opens for the task chain you selected.

![Figure 220: Complete Parameters Page of Move IE Wizard](image)

3. Provide a name for the new process in the **Process Name** field. This will identify the process for anyone who wants to use it. The name appears on the Process List page and is searchable using the quick-find box on that page.

4. From the **Move IE to** drop-down list, select the institution and department to which you want to move the objects.

5. Click the **Next** button.

The Define Set page of the wizard opens. All available sets for this wizard are listed on this page.
6 Select the set containing the IEs you want to transfer, then click the **Next** button.

The Scheduling step of the wizard opens (Figure 222). The schedule defaults to **No Scheduling**. Also available are once, daily, weekly, monthly, and an advanced option that allows you to enter a firing schedule using a Cron Trigger (with samples provided).
7 Enter a schedule for the process and click **Next**.

The system returns a summary of the process on the Review and Confirm page (Figure 223).

![Figure 223: Summary of Process Entries](image)

8 Review the information on step 5 of the wizard. If you need to make changes, use the **Back** link until you reach the page where you want to make changes. To cancel the process, click the **Cancel** button. To submit the process to the system, click the **Submit** button.

If you submitted the process, Rosetta runs it or queues it for running. The Process List page opens with the new process appearing there.

![Figure 224: New Entry in Process List](image)
Restoring IEs from the Permanent Repository

Library staff who want to view previous versions of an IE and possibly restore those versions can do so through the Web Editor. A tab on the Web Editor called Versions displays a list of current and older versions of an IE. Staff with sufficient authorization can retrieve an older version of an IE from the permanent repository and store it as the new and latest version of itself.

Rosetta uses the IE’s METS file, which consists of the preserved representation only. When the restoration is complete, the IE in the operational repository will match the version in the permanent repository.

**NOTE:** Although the IE to be overridden will take on the content and metadata of the restored object, access copies and access rights exceptions attached to the IE will migrate with the IE being restored and remain in the database.

To view or restore an IE from the permanent repository:

1. Find the object you want to restore by searching the repository for an object or for metadata (Home > Data Management > Search for Objects | Search for Metadata).
   When you find the object, the Web Editor displays its details in a tabbed pane.

2. Click the **Versions** tab in the pane.
   Information on the versions of this IE display under the tab.
Chapter 39: Delete, Restore, Move, and Purge IEs

Find the version you want to view or restore and click the text link corresponding to that IE.

If you are viewing, the METS information will open in a separate window. If you are restoring, Rosetta will open a confirmation page.

To restore, click the **Confirm** button.

The system restores the IE and refreshes the Versions tab with messages regarding the IE status and instructions for verification (Figure 226). The Restore text link is no longer available for that version you restored.
Figure 226: Versions Page After Restoring IE
Fixity, Provenance, and Storage

This section contains:

- Fixity in Rosetta with an External Storage Layer on page 405
- Managing Fixity Reports on page 406

Fixity in Rosetta with an External Storage Layer

Fixity checks occur as part of validating files as they are deposited, ingested, or otherwise altered within Rosetta. If an institution using Rosetta wants to store files in one or more storage locations outside of the Rosetta repository, fixity checks and events from this external storage layer can be integrated into Rosetta records.

As part of this process, provenance events are performed in Rosetta before an object or IE is returned to the external storage layer. Rosetta performs its part of the equation through its Data Management module and the use of an API.

As part of maintaining the preserved file copies, a fixity check is performed on each of the copies wherever they are stored. In order to record all the information about these checks in Rosetta, the library must run an API that updates Rosetta after a fixity check. This allows reports to be generated in Rosetta and provide the fixity status for all files.

The process includes the addition of an event that can be either a statistical event (not provenance) or a provenance event.

**NOTE:**
A provenance event is recorded in the IE METS file, and it requires a new version of the METS file to be written.

The provenance event functions as follows:

- The event itself is written to the database whenever it is generated, whether it succeeds or fails.
The event is written to the DNX as provenance when the check result is different from the current status:

- first time it runs (success/failure)
- success after failure
- failure after success

In addition, this event does the following:

- Captures the information about a fixity check that was performed in the storage layer on any of the file copies
- Is added to Rosetta by an API
- When triggered externally, is written to the database as if it had been triggered internally

**Managing Fixity Reports**

Fixity reports are set up as Event Reports in the Data Management section of the Management module (see Figure 227)

Access the page by following the path **Home > Data Management > Advanced Tools > Fixity Reports**. From this page you can

- Add a new report
- View, edit, or delete an existing report
- Open or generate an existing report
To add a new report:

1. From the Fixity Reports page (Home > Data Management > Advanced Tools > Fixity Reports), click the Add Event Report button. The Add Event Report page opens.

2. Enter values in the fields as described in Table 58.

Table 58. Event Report Page Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a name for the report to appear on the Fixity Reports page.</td>
</tr>
<tr>
<td>Description</td>
<td>Describe the report (not required).</td>
</tr>
<tr>
<td>Time Period</td>
<td>Specify the number of days, weeks, months, or years for the report to cover.</td>
</tr>
<tr>
<td>Number of copies and fixity events per copy</td>
<td>To select a specific number of copies and/or fixity events per copy to capture in the report, select the check boxes and specify the numbers in the fields.</td>
</tr>
</tbody>
</table>

3. To create or add a set to be included in the report, click the corresponding button and specify a new set (Create Set button) or select a set that has already been defined (Add Set button).

**NOTE:**
To create a new set with search conditions, see Creating a Logical Set on page 355.

When you have created a new set or added an existing one to the event, the Event Report Details page refreshes with the selected set shown beside an Unlink set option (see Figure 228).
4  To change the set, click Unlink set and repeat from the beginning of the previous step in this procedure. To keep the set, select Apply. To keep the set and continue with the procedure, click Save.

Rosetta returns you to the Fixity Reports page, where the new event report appears in the list of fixity reports.

To view, edit, or delete a fixity report:

1  From the Fixity Reports page (Home > Data Management > Advanced Tools > Fixity Reports), find the report you want to work with and, in its row, click

- Delete to delete the report (then click Confirm to continue the deletion)
- View to view the report details (click Back to return to this page)
- Edit to make changes to the report details

2  To edit any aspects or parameters of your report, use the definitions for adding a new report (To add a new report: on page 407), including Creating a Logical Set on page 355 if needed.

3  Click Save to save changes or Cancel to return to the report list page without saving changes.
To generate a report or open one that has already been generated:

1. From the Fixity Reports page (Home > Data Management > Advanced Tools > Fixity Reports), find the report you want to view or run and, in its row, click More Actions.

   The options for generating a new report or viewing/opening one that has already been run show below the dotted line for the row.

   Figure 229: Fixity Reports: More Actions

2. To open the most recently run report, click Open Report. To generate a new report using the same parameters, click Generate Report.

   The report opens.
To export the report to an Excel spreadsheet, click the **Export Fixity Report to Excel** button. The report is downloaded to your local drive.
Scheduling Metadata Update Jobs

This section contains:
- About Metadata Update Jobs on page 411
- Managing Metadata Update Jobs on page 411
- Adding a Metadata Update Job on page 413
- Modifying a Metadata Update Job on page 415
- Cancelling a Metadata Update Job on page 416

About Metadata Update Jobs

Metadata update jobs are used to metadata update for existing IEs.

Managing Metadata Update Jobs

The Manage Scheduled Jobs page enables Data Managers to schedule metadata Update jobs. To access this page, follow the Rosetta drop-down menu path: Data Manager > Advanced Tools > Update Metadata.

The Manage Scheduled Jobs page opens to existing metadata update jobs (Figure 231).
Chapter 41: Scheduling Metadata Update Jobs

This page enables Data Managers to monitor the status of each metadata update job and perform the following tasks:

- **Add a new job** – For more information, see Adding a Metadata Update Job on page 413.
- **View a job’s details** – Click the View link next to the job you want to view.
- **Modify a job** – For more information, see Modifying a Metadata Update Job on page 415.
- **Execute a job** – Click the Run Now link to run a job manually.

In addition, you can cancel a job. For more information, see Cancelling a Metadata Update Job on page 416.
Adding a Metadata Update Job

This task allows Data Managers to create a new metadata update job.

To add a Metadata Update job:

1. Click the Add job button on the Manage Scheduled Jobs page. The Job Details page opens.

![Figure 232: Job Details (Metadata Update Job)](image)

Figure 232: Job Details (Metadata Update Job)
2 Enter a name for the metadata update job in the **Name** field.

3 Select the interval at which to execute the job: **Hourly**, **Daily**, **Weekly**, **Monthly**, and **Advanced**.

4 To configure hourly, daily, weekly, and monthly intervals:
   a Use the following table to configure the common interval fields:

   **Table 59. Common Interval Fields**

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start At</td>
<td>Time</td>
<td>Select the hour and minutes from the drop-down fields to specify the time at which to run the job.</td>
</tr>
<tr>
<td></td>
<td>Date</td>
<td>Use the calendar tool or select the month, day, and year from the drop-down fields to select the date at which to start running the job.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Indefinitely</td>
<td>Select this option to run the job indefinitely.</td>
</tr>
<tr>
<td></td>
<td>Until</td>
<td>Select the month, day, and year from the drop-down fields to specify the date at which to stop running the job.</td>
</tr>
</tbody>
</table>

   **NOTE:**
   After this date, the state of the job will change from **Normal** to **Not Running**.

   b Use the following table to configure the interval-specific fields:

   **Table 60. Interval-Specific Fields**

<table>
<thead>
<tr>
<th>Type of Interval</th>
<th>Perform this task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly</td>
<td>Every</td>
<td>Select the hourly interval from the <strong>Hours</strong> drop-down field.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Week days</td>
<td>Select which days of the week to run this job.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Monthly At</td>
<td>Select the day of the month to run this job.</td>
</tr>
</tbody>
</table>

   For information on how to configure advanced intervals, see **Configuring Advanced Job Schedules** on page 252.

5 Complete the required fields in the **Job Parameters** pane.

6 Click the **Apply** button to add the job to the list of metadata update jobs.
Modifying a Metadata Update Job

This task allows Data Managers to modify the details for an existing metadata update job.

To modify a Metadata Update job:

1. On the Manage Scheduled Jobs page, click the Edit link next to the job that you want to modify.
   The Job Details page opens.

2. Select the interval at which to execute the job: Hourly, Daily, Weekly, Monthly, and Advanced.

3. To configure hourly, daily, weekly, and monthly intervals:
a Use the following table to configure the common interval fields:

Table 61. Common Interval Fields

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start At</td>
<td>Time</td>
<td>Select the hour and minutes from the drop-down fields to specify the time at which to run the job.</td>
</tr>
<tr>
<td></td>
<td>Date</td>
<td>Use the calendar tool or select the month, day, and year from the drop-down fields to select the date at which to start running the job.</td>
</tr>
<tr>
<td>Repeat</td>
<td>Indefinitely</td>
<td>Select this option to run the job indefinitely.</td>
</tr>
<tr>
<td></td>
<td>Until</td>
<td>Select the month, day, and year from the drop-down fields to specify the date at which to stop running the job.</td>
</tr>
</tbody>
</table>

NOTE: After this date, the state of the job will change from Normal to Not Running.

b Use the following table to configure the interval-specific fields:

Table 62. Interval-Specific Fields

<table>
<thead>
<tr>
<th>Type of Interval</th>
<th>Perform this task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hourly</td>
<td>Every</td>
<td>Select the hourly interval from the Hours drop-down field.</td>
</tr>
<tr>
<td>Weekly</td>
<td>Week days</td>
<td>Select which days of the week to run this job.</td>
</tr>
<tr>
<td>Monthly</td>
<td>Monthly At</td>
<td>Select the day of the month to run this job.</td>
</tr>
</tbody>
</table>

For information on how to configure advanced intervals, see Configuring Advanced Job Schedules on page 252.

4 Complete the required fields in the Job Parameters pane.

5 Click the Apply button to add the job to the list of metadata update jobs.

Cancelling a Metadata Update Job

Cancelling a job allows the Data Manager to postpone the execution of job indefinitely without deleting it from the system.
NOTE:
The Unschedule option will not be available when the state of the job is Not Running.

To cancel a Metadata Update job:

1. On the Manage Scheduled Jobs page, click the Edit link next to the job that you want to modify.
   The Job Details page opens.
2. Click the Unschedule button.
   The state of the job should change to Not Running.
Collections

This section contains:
- Collections in Rosetta on page 419
- Managing Collections on page 420
- Collection Delivery on page 435

Collections in Rosetta

Collections in Rosetta enable users to aggregate IEs so that they can be preserved according to their original hierarchy.

Editors (Typical and Full) and Data Managers (Typical and Full) have access to collections from the Data Management > Collection Management menu. These authorized users can create, update, and delete collections under the correct circumstances.

Collections contain:
- one or more associated IEs (and the IEs contain the associated Collection ID in their records)
- a unique path (including collection/sub-collection)
- metadata in DC format—stored as shared metadata in the database and in the permanent repository
- optional source metadata in any format other than DC (such as EAD or MARC)
- optional sub-collections

NOTE:
Collections are not sets. Process automation tasks cannot work directly with collections. In order for Process automation tasks to work with collections, sets need to be created with the collection name as a criterion for the search query.
Managing Collections

Collections can be managed from the Collections Management page (see Figure 234, Collections Management).

![Collections Management](image)

**NOTE:**
If you add collections with the API and want to see the results in Rosetta (for testing purposes, for example) you must refresh the collection tree by reopening the collection UI.

The Collections Management page includes a hierarchical navigation bar (left column of the page) and a main window with the Contents, Metadata, and History tabs.

The Contents tab (see Figure 235, Collections Management Page, Contents Tab Views) displays the contents of the collection in terms of its IEs. IEs can be viewed in a list format or as thumbnails.
The Metadata tab provides an interface for users to edit the collection’s metadata. Users can edit DC records online or upload metadata from external XML file. Import formats can be either DC or source metadata in any format (such as MARC or EAD).

In the permanent repository, the descriptive metadata of the collection is stored in a METS XML document along with some control information.

The History tab displays a list of the actions performed on the collection:
Adding a New Collection

Adding a new collection can be accomplished in two ways:

- Manually, through the UI
- Automatically, when associating IEs with a collection. (See Associating IEs with Collections on page 428)

To add a collection manually:

First determine where, in the existing hierarchy, you want to position your collection. In the example below, Adding a New Collection, the user wants to create a collection that is a sub-collection of the existing Modern collection.

1. To create a sub-collection of an existing collection, click that collection in the collection hierarchy.
   
   The system highlights the collection you clicked.

2. Click the green button with the plus sign.
   
   A new collection form opens in a light box. The Selected parent field provides you the option of creating a first-level collection or a sub-collection of the parent collection you selected in step 1.

3. Click the first-level option or the parent option.

4. Enter a name for the collection. This name will appear as the collection's label in the hierarchy and will be used as part of the path when the system needs to locate the collection.
Enter a description for the collection. The description will appear in the basic properties information for the collection.

Select Publish to publish the collection to Primo.

Select Allow Navigation to display linked breadcrumbs to this collection in the collection viewer.

Click Add under the generic thumbnail image to add a thumbnail to the collection.

NOTES:
- The image must be in jpg format with a maximum size of 100K.
- It is recommended that square (1:1) images be used.
- Images should be not less than 400x400px.

Click Add to save the collection.

The collection name appears in the hierarchy where you specified in the Selected parent field.

You can change the order and level of the collection by dragging and dropping it where you want it in the hierarchy.
Click the Sort icon to alphabetize the list of collections.

To create collections automatically while associating IEs with them, see Associating IEs with Collections on page 428.

**Editing a Collection**

To rename a collection, right-click over the folder in the left column and select Rename collection.

To update the collection description, right-click over the folder in the left column and select Edit collection, then update the necessary fields.
Figure 240: Edit Collection

**Updating Collection Metadata**

Collection metadata can be updated from the Metadata tab on the Collection Management page. Users can add metadata elements and assign values from this tab.
To add a new metadata type to a collection:

1. From the Metadata tab of the collection you want to edit, click the Add Metadata button.

![Add Metadata Button for Collection](image.png)

The Choose metadata type form opens in a light box.
From the drop-down list of metadata types, select the type you want to add. If you do not see your type in the list, select Other.
3. Select the source of the metadata: **Insert new** to copy the source into a text field, **Insert from PC** to browse to the metadata file on your PC and select that.

![Figure 244: Two Methods for Inserting Metadata](image)

4. Use the **Validate** button to check the metadata before loading it. Any errors will display in red text as the form refreshes.

5. Correct any errors and re-check the validation. When no red text displays after clicking **Validate**, the XML is valid.

6. Click the **Add metadata record** button to complete the addition. The system returns you to the Collections Management page. The new metadata appears in the **Metadata** tab under the existing metadata types.

**NOTE:** For information on editing digital collections, see **Editing Digital Collections** on page 464.

### Associating IEs with Collections

Users can associate IEs with collections even if the collection doesn’t exist yet. Collections in this case are created during the association of IEs with collections.
After a collection has been created, users can edit it and add metadata (DC or source MD).

Users can associate IEs with collections in one of two ways, both of which add a section to the IE’s DNX.

In case of failure (for example, the IE is already locked by another user or process), the Process Monitoring UI allows the user to see the details of the IEs that failed. The user can then resolve the problem.

**NOTE:**

These tasks can be configured as part of SIP processing or, after the IEs are in the permanent repository, as a maintenance process (bulk) or through the Collection tab in the Web editor (manual).

**Tasks and Task Chains**

Associating IEs with collections involves, in part, running the correct task chain from the Advanced Configuration > Repository > Task Chains page or creating a chain if the one you want doesn’t exist.

Two methods for associating IEs with collections are available out-of-the-box as tasks:

- The task **Assign Collection by Name** should be used when the collection already exists in Rosetta and the ID is known. The task verifies that the collection exists in Rosetta and assigns the IEs to this collection. The parameter for this task is the collection ID, selected by the user who schedules the process.

- The task **Assign Collection by DC** can be used for the following cases:

  - When assigning IEs to an existing collection, identifiable by Rosetta or external ID in a specified DC field
  
  - When assigning IEs to a collection, identifiable by a full path in a specified DC field

For each field occurrence, if the field contains a colon, Rosetta tries to match by Rosetta ID, then by external ID. Match by ID is case sensitive. If no match is found, the task fails. If the field does not contain a colon, Rosetta tries to match by path.

The expected syntax for assignment by Rosetta ID is `rosetta:{rosetta_id}`. The expected syntax for assignment by external ID is `{external_system}:{external_id}`. The expected syntax for assignment by path is the full collection path, delimited by a specified
delimiter. The list of delimiters is configurable in the Collection Task Separators code table.

The task supports auto-generating new collections based on a collection path only.

The task supports recursive generation, that is, if the value in the DC field is a/b/c (with the delimiter being /) and root collection a does not exist, Rosetta creates collections a, b and c (and assigns the IE to c). When a collection is generated by the task, the collection's creation event the task details.

**NOTE:**
Colon (:) is reserved and cannot be used in this task either as a collection name or a delimiter.
Figure 245: Customer-Configured Task Chain—Assign by DC

The following parameters are available for this task:
Figure 246: Task Chain - Task Parameters Tab View

- **DC Field** – the field that contains the path or external ID by which Rosetta assigns the IEs to a collection.
- **Delimiter** – the delimiter used for the collection path.
- **Delete on Assignment** – used when the DC field exists solely for collection assignment. Select to have the field deleted after a successful collection assignment based on a match for the given field.

**NOTE:**
This DC update does not generate a metadata update event. The field deletion is noted in the IE’s collection assignment event as `DCSourceDeleted=true`.

- **Generate New Collections** – select to have Rosetta generate a new collection according to the value in the DC field and the specified delimiter if no match by path is found. The following options are only available if **Generate New Collections** is selected.
- **Publish** – select to have the generated collections published to Primo.
- **Navigate** – select to display linked breadcrumbs to this collection in the collection viewer.
- **Sort** – select to have the generated collection’s parent re-sorted (0-9A-z) after the collection is generated in order to maintain its order.

**NOTE:**
Generated collections’ descriptions are not auto-populated.

Both tasks are available with Rosetta installation, but only the Assign Collection by Name has a corresponding out-of-the-box task chain. You must configure a new task chain if you want to use the Assign Collection by DC task.
Disassociating IEs from Collections

Disassociating IEs from a collection can be done using a process (bulk) or through the Web editor (manual). The action performs the following:

1. Locks the IE.
2. Creates a new version of the IE without the collection DNX section that held the collection ID.
3. Commits the new version of the IE to the permanent repository.

The task and task chain for this procedure, Unassign Collection, are available on installation. In case of failure (for example, the IE is already locked by another user or process), the Process Monitoring UI allows the user to see the details of the IEs that failed. The user can then resolve the problem.

Searching IEs Within Collections

In the Data Management area, IEs can be searched based on their collection information. The user can open the list of collections, find a particular collection/sub-collection name, and review all the IEs that are associated with the collection.

Figure 247: IEs in a Collection
Searching Collections

Users can search the list of collections by collection name. For a sub-collection, the search should start at the collection level. For example, to search for Spring semester under 2011 under Course catalogue, the user should start with Course catalogue and then 2011. In searches for 2011 or Spring semester, all the sub-collections with this name will be highlighted in the list.

Publishing Collections

Collections can be published using the OAI-PMH protocol, similar to IEs, so that they can be harvested by an OAI-PMH harvester. A published collection’s metadata will appear in the OAI set.

**NOTE:**
For additional information on setting up harvesting Rosetta collections in Primo, see the *Rosetta - Primo Integration Guide*.

To mark a collection for publishing, right-click over the collection icon in the collection tree, select **Edit** and check the **Publish** check box. Uncheck the box to unpublish the collection. The collection will be published or unpublished during the next Publishing Sync Job.

**NOTES:**
- The Collections are converted to OAI format using the (institution-level) `collection2DC.xsl` configuration file. To edit this file, go to Data Management > Collection Management > Collection Publishing. Only a single xsl configuration per institution is supported for collection publishing.
- The `set_spec` value will be `{institution code}\-collections`.
- Publishing is determined by the collection’s publish dnx field (boolean, default=false) and can also be set by collection APIs, CSV collection deposit, and the Assign to Collection by DC task.

Deleting Collections and IEs

Collections or sub-collections can be deleted from the list of collections only if there are no IEs associated with them.

The system does not allow the deletion of collections that have associated IEs. When an IE is deleted, it does not appear as part of any collection to which it once belonged.
To delete a collection that has associated IEs (or sub-collections with associated IEs), run an Unassign Collection process, using the relevant collection(s) as both IE search criteria and task parameter.

**Restoring an IE’s Previous Version**

When a user restores the previous version of an IE, the system determines whether the associated collection still exists. If it does, the system re-associates the IE with the collection.

If the collection does not exist, the IE is not re-associated with this collection. The system generates an event displaying the details of the IE and the collection so the case can be tracked and managed.

**Collection Delivery**

Rosetta allows viewing collections from outside of Rosetta by external patrons. It also allows managing collections by external applications using APIs.

The collection viewer is displayed in a separate browser tab or window, as shown in Figure 248.
The collection viewer has the following characteristics:

- Access rights are not enforced at the collection level, only at the IE level.
- All IE titles are displayed with thumbnails (see the Thumbnail Creation Rules section in the Rosetta Configuration Guide).
- Browsing among IEs within a collection can only occur within the same collection or its sub-collection(s). In Figure 248, this includes all IEs in the Israeli Collection and any IEs in the Israeli Subcollection folder, once that folder is open.
- Breadcrumbs to parent collections (up to three levels) are available depending on each collections’ Allow Navigation setting (see Adding a New Collection on page 422).

**Collection Metadata**

Users can view the descriptive metadata of a collection by clicking the information (i) button. The metadata for the collection appears in a light box (see Figure 249).

![Figure 249: Collection Viewer with Metadata Light Box](image)

**Collection Delivery Requests**

There are two possible scenarios for how a delivery request for a collection can be initiated by an external resource discovery system:

- Rosetta Collection ID: The collection ID can be published as part of the IE and extracted by the resource discovery system.
External System ID: The ID can be stored in Rosetta as part of the collection entity (for example, a DOI). The delivery URL can use the combination of the external system name (such as Aleph) and the external system ID to deliver the collection.

The collection delivery request can include, respectively, either the parameter `col_id=` with the Rosetta collection ID or the parameters `external_system_name` and `external_system_id` that hold the external system name and ID of the collection.

See Collection Viewer URL on page 437 for more information on requests and viewer parameters.

**Collection Viewer URL**

The collection can be retrieved based on:

- **Rosetta Collection ID** – For example, `http://{server-name}:{port}/delivery/action/collectionViewer.do?operation=viewCollection&col_pid=83542`

- **External System Details** – For example, `http://{server-name}:{port}/delivery/action/collectionViewer.do?operation=viewCollection&externalSystem=Aleph&externalId=83542`

Currently, the only way to populate the external system name/ID in the collection record is through the collection API.

**URL Parameters**

To control the collection viewer features, users can use the following parameters:

- **displayType** – As a default, the collection viewer opens in list view. However, users calling the viewer externally can control the view mode by adding the following parameter to the URL: `displayType=thumbnails`.

- **pageNum** – The default number of objects in the viewer are defined in a general parameter. However, users can control the number of objects by setting the following parameter: `pageNum=20` (which sets the number of objects on a page to a maximum of 20)
Derivative Copy Representations

This section contains:

- Manually Adding a Derivative Copy Representation on page 439
- Adding a Derivative Copy Representation with a Service on page 445
- Adding a Derivative Copy Representation with a Job on page 446

Creating and adding representations in general and derivative copies in particular can be performed by staff users with the Technical Analyst (TA) or Data Manager roles. A user who has both a TA role and an Assessor or Arranger role can add derivative copies from the Assessor or Arranger interface.

There are three methods for adding derivative copies:

- Manually – see Manually Adding a Derivative Copy Representation on page 439
- With a service – see Adding a Derivative Copy Representation with a Service on page 445
- With a job – see Adding a Derivative Copy Representation with a Job on page 446

Manually Adding a Derivative Copy Representation

You can manually add a derivative copy from the Web Editor. Use this method when you have the derivative copy files.
To manually add a derivative copy representation:

1. Open an IE in the Web Editor and lock it.

![Figure 250: Web Editor Displaying IE Information](image)

2. From the Actions drop-down menu, click Add Representation, and then click the Go button. The Add Representation - Details page opens:
3 Enter information in the fields:
   - Label
   - Preservation Entity Type
   - Representation Code
   - Access Rights Policy

**NOTE:** Only one derivative copy representation with given code and entity type values can be added to any given IE. To add multiple derivative copies to an IE, use different codes or entity type values.

4 Click the **Next** button.

The Load Page opens. There are two options for uploading files:
   - Insert from Local PC – the interface that appears depends on your configuration:
     - if you are a licensed Aurigma user, the following interface appears:
Figure 257: Derivative Copy Load Page – Aurigma Users

You can:

- drag and drop files onto the page
- click Add more files and select the files
- click **Add folder** and select the folder

To use the manual interface instead (**Figure 253**), click **Load Files Manually**.

- if you are not using Aurigma, the following interface appears:

![Manual Upload Interface](image)

**Figure 253: Manual Upload Interface**
Browse to the file you want to upload and click **Add Selected File**. Repeat for each file you want to upload.

Uploaded files are listed in the Selected Files portion of the page:

![Figure 254: Selected Files Order](image)

The Selected Files pane displays the selected files as described in the following table:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>The selected files’ deposit activity priority.</td>
</tr>
<tr>
<td>Set Order</td>
<td>Use the Up and Down arrows to change the selected files’ order in the IE.</td>
</tr>
<tr>
<td>File Name</td>
<td>Displays the name of the selected file.</td>
</tr>
<tr>
<td>Label</td>
<td>Provides a field for a label to be shown when the IE is viewed in Delivery (optional).</td>
</tr>
<tr>
<td>Source</td>
<td>Displays the source of the selected file. This is either Local or URL.</td>
</tr>
<tr>
<td>Size</td>
<td>Displays the size of the selected file.</td>
</tr>
<tr>
<td>Date</td>
<td>Displays the date on which the selected file was deposited.</td>
</tr>
</tbody>
</table>

For multiple files, to change the order of the files, click the arrows of the rows you want to change. When you have the files in the correct order, click the **Done** button.

- Choose from Server – To load files from a location on the server instead, first place the files you want to upload under the home directory on the server. Then click the **Choose From Server** tab on this page and enter the directory path in the **Import Directory** field. Rosetta takes all of the files under that directory and uploads them to the system.

5 When you are finished, click **Done**.

Rosetta creates the derivative copies.
Adding a Derivative Copy Representation with a Service

You can create a derivative copy representation with a service. Use the service when you want Rosetta to generate the files for you, either one-off (via the Web editor) or in bulk (as a task).

To create a derivative copy representation with a service:

1. Display an IE in the Web Editor.
2. On the IE level, select the Services tab.
3. Select the Create Derivative Copy Representation service. The following appears:

   ![Create Derivative Copy Representation Service](image)

   Figure 255: Create Derivative Copy Representation Service

4. Fill in the fields:
Priority – select the priority of the service
Preservation Type – select Derivative Copy
Representation Entity Type (Input) – select the representation entity type for the input
File Extension Filter – select the file extensions on which to run the service
Copy other extensions – copy the files with extensions not included in the filter
Plug-in Type – select one of the following:
  - Transform Profile, and select a profile from the list
  - Stream Handler, and select a stream handler from the list
  (For more information, see Stream Handlers (Deprecated) and Transformation Profiles in the Rosetta Configuration Guide.)
Representation Code – select a representation code
Access rights policy – select an access rights policy
Representation Entity Type (Output) – select an representation entity type for the output
Send Email? – enter an email address t be notified when the service is completed

The Create Derivative Copy Representation service creates the derivative copy.

**NOTE:**
Only one derivative copy representation with given code and entity type values can be added to any given IE. To add multiple derivative copies to an IE, use different codes or entity type values.

5 Click Submit.

Adding a Derivative Copy Representation with a Job

You can create a derivative copy representation with a job. Use the job when you have files and want to run in bulk.
To create a derivative copy representation with a job:

2. Click Add Job. The following appears:

![Figure 256: Derivative Copies Job]

Figure 256: Derivative Copies Job
3 Fill in the fields to schedule the job. For more information, see Submission Jobs on page 257.

4 In the Job Parameters section, enter your user ID and password and the path of the folder that contains the files to be used to create the derivative copy representations.

The NFS path you indicate should be built in the following format:

- Each folder in the NFS path indicates a separate IE.
- Each IE folder should contain a METS file that contains the information to create one or more derivative copy representations. The METS file must contain:
  - An ie-amd with PID internalIdentifier (only). For example:

```xml
<mets:amdSec ID="ie-amd">
  <mets:techMD ID="ie-amd-tech">
    <mets:mdWrap MDTYPE="OTHER" OTHERMDTYPE="dnx">
      <mets:xmlData>
        <dnx xmlns="http://www.exlibrisgroup.com/dps/dnx">
          <section id="internalIdentifier">
            <record>
              <key id="internalIdentifierType">PID</key>
              <key id="internalIdentifierValue">IE13660</key>
            </record>
          </section>
        </dnx>
      </mets:xmlData>
    </mets:mdWrap>
  </mets:techMD>
</mets:amdSec>
```

- A generalRepCharacteristics section (for each REP), specifying preservation type (must be DERIVATIVE_COPY), representation entity type, and representation code. For example:
Chapter 43: Derivative Copy Representations

A generalFileCharacteristics section (for each file), containing any field that is supported when submitting as part of a SIP. For example:

```xml
<mets:amdSec ID="rep1-amd">
  <mets:techMD ID="rep1-amd-tech">
    <mets:mdWrap MDTYPE="OTHER" OTHERMDTYPE="dnx">
      <mets:xmlData>
        <dnx xmlns="http://www.exlibrisgroup.com/dps/dnx">
          <section id="generalRepCharacteristics">
            <record>
              <key id="preservationType">DERIVATIVE_COPY</key>
              <key id="representationEntityID">JPEG Images</key>
              <key id="RepresentationCode">MEDIUM</key> (for some reason this is uppercase - fix?)
            </record>
          </section>
        </dnx>
      </mets:xmlData>
    </mets:mdWrap>
  </mets:techMD>
</mets:amdSec>
```

- A fileSec, + a fileGrp(s) for each REP.

The METS file may contain:
- File level descriptive (DC, source) metadata sections
- Representation level source metadata sections
- Representation level access rights policy
Physical structmaps. If none are provided, and no other SM is provided (and flag is false), Rosetta will generate physical structmap.

Logical (EXL/custom) structmaps

The NFS path should contain a Streams folder that contains the files of the derivative copy representations. (Absolute NFS paths and HTTP references are also supported.)

**NOTE:**
Rosetta allows only one derivative copy with a given entity type and representation code per IE. Adding a derivative copy to an IE that has a derivative copy with the same entity type and code with this job overwrites the representation.

**NOTES:**

- You can prevent the job from processing a folder. (This can be useful if you do not want it to be loaded prematurely.) To do so, create an empty file in the submission job folder and name it `locked` (or `.locked`).
- While processing a folder, the submission job adds a locked file.
- After a folder has been successfully processed, the submission job adds a done file. Folders with done files are not processed by the submission job. You can create a cron job to clean up these folders.
- After a folder has been unsuccessfully processed, the submission job adds an error file. Folders with error files are reprocessed by the submission job (and should not be deleted). Users can use this file to identify problematic submission folders.
Part VIII
Web Editor

This part contains the following sections:

- Chapter 44: Web Editor on page 453
- Chapter 45: Adding Representations on page 483
Web Editor

This section contains:

- About the Web Editor on page 453
- Accessing the Web Editor on page 453
- Viewing Digital Objects in the Web Editor on page 455
- Editing Digital Objects on page 464

About the Web Editor

When Rosetta moves files from the Deposit Server to the Staging Server, a METS file containing descriptive and administrative metadata is generated for each intellectual entity (IE). This metadata can describe an IE as a whole, its individual representations, and its files. (For more information about METS files, see the Rosetta Overview Guide.)

The Web Editor allows staff users to access repository objects at various stages of their ingestion and maintenance. Staff users can access different types and levels of metadata and make changes, where necessary, to the metadata.

Accessing the Web Editor

Staff users can view descriptive and administrative metadata in the Web Editor from a search on a home page, from any of the search fields that appear near the top of most pages, through a link on the Data Management main page, or from a search link related to a list of sets (see below, for example).
Through a Search

1. Perform a search for the object you want to edit using the Rosetta Search in the right column of any main page.
2. When the results include an object you want to work with, click the Info text link corresponding to the row of that object.
3. The object opens in the Web Editor (see Figure 257).

Through a List of Sets

1. Follow the path from Data Management > Manage Sets and Processes > Manage Sets to the Set List page.
2. Click Members (for itemized sets) or Results (for logical sets) on the row of the set containing the object you want to access.
3. Click the Info text link beside the object whose metadata you want to view in the Web Editor.

The Web Editor opens to the object whose Info link you clicked (see Figure 257).

Figure 257: Web Editor

The Intellectual Entity page of the Web Editor contains two panes:

- The tree pane on the left contains the tree view of the representations and files that make up the IE.
Viewing Digital Objects in the Web Editor

To view digital objects:

1. In the tree pane, select the object level (IE, representation, or file) you want to view. The object opens in the content pane to the default tab, **Object Summary**.

2. In the content pane, click one of the following tabs:
   - **Object Summary**, to view summary data and administrative metadata. (For more information, see **The Object Summary Tab** on page 455.)
   - **Metadata**, to view descriptive metadata and perform several actions available from this tab. (For more information, see **Metadata Tab** on page 457.)
   - **Services**, to view a list of available services that can be run for the specific IE, representation, or file you have isolated. (For more information, see **Services Tab** on page 459.)
   - **Versions** (IE only), to view information about previous versions of an IE and possibly restore those versions. (See **Versions Tab** on page 461.)
   - **Collections** (IE Only): to view details about collections to which the IE belongs. (See **Collections Tab** on page 460.)
   - **Bitstreams** (file only), to view information about file bitstreams. (See **Bitstreams Tab** on page 463.)
   - **File Summary** (file only), when you want to view technical information about a file that is a part of the IE. (For more information, see **File Summary Tab** on page 462.)

The Object Summary Tab

The **Object Summary** tab (see figure below) displays general metadata about the object. It is the default tab when a user selects any of the items in the IE tree (IE, Representation, or File).
For IEs, the **View Object** button shows on the Object Summary tab. Clicking this button opens the object in the Delivery viewer with which it is associated.

Fields displayed on the Object Summary tab are defined in the DNX profile configured by your Administrator. (For more information about DNX profiles, see the *Rosetta Overview Guide.*) Fields generally include PID, SIP ID, Created by, dates for creation and update, and other administrative and technical metadata, depending on the type of object selected in the tree pane. Representations, for example, include Preservation Type and Usage Type, while Files list values like MIME Type (see **Figure 259**).
Metadata Tab

The Metadata tab displays the list of metadata associated with the IE, representation, or file that is selected.
Depending on whether the Metadata tab is open to an IE, a representation, or a file, one or more buttons appear above the information table and allow the user to perform the following tasks:

- **Add MD**: Add source metadata to ensure no metadata is lost from the original object. The source can be any of the following types: MARC, MODS, DC, NISO, copyrights, rights. Source metadata can be added even if there is already source metadata associated with the IE, representation, or file. For information on adding and editing source metadata, see Editing Metadata through the Web Editor Interface on page 469.

- **Assign CMS**: Assign a collection management system ID to the item to allow the integration of an external system (for more information, see Editing Digital Objects on page 464)

- **Assign AR (Editors only)**: Assign access rights to the IE or representation to limit its availability (see Assigning an Access Rights Policy on page 137)

- **Assign AR Exceptions (Editors only)**: For specified IEs, provide additional access that expands the rights already defined for a group of users (see Access Rights Exceptions on page 139)

- **Assign RP**: Assign a retention policy to limit the duration of the IE’s storage period

All buttons, when clicked, open prompts and in some cases wizards for the user to complete a task.

Additional actions can be performed on the object by making a selection from the **Actions** drop-down menu in the bottom right corner of the page. This menu
changes according to the object selected in the tree view of the Web Editor, its qualities, and whether the IE has been locked or not.

**NOTE:**

When an action is being performed on an IE or other object, the system creates a working copy for the user performing the action. Any views of the object by other users will maintain the previous data for the object and will not be editable. Once the object is saved, the new version replaces the old.

**Services Tab**

The Services tab shows all the available services for the IE, representation, or file. Services consist of actions that can be performed on the data, such as those that appear in the figure below.

![Figure 261: Web Editor, Services Tab](image)

Users can run services from this tab by selecting the IE, representation, or file on the left and clicking the available service on the right.

The System Administrator can take task chains, classify them as maintenance, and they will appear here.

Editors with the necessary privileges (typical or full) can perform these services (see descriptions below).
### Collections Tab

If there are collections associated with the IEs, the Web editor displays the Collections tab (see figure below).
The **Assign to Collection** buttons always appear if the IE is locked. Collections to which the IE is already assigned are listed in the collection table. Click the **Metadata** text link to view the collection in the collection management interface. Click **View** to view the collection in the collection viewer. Click **Unassign** to detach the IE from the collection.

### Versions Tab

If more than one version of an IE exists in the database, the Web editor displays a **Versions tab**. This tab displays a list of current and older versions of an IE.
Staff with sufficient authorization can retrieve an older version of an IE from the permanent repository and store it as the new and latest version.

Click **Events** to view a list of events pertinent to a given IE version.

**File Summary Tab**

The File Summary tab (see figure below) displays the validation stack report. The report contains information about tasks that the Rosetta system performed on the file. (For more information about validation stacks, see Configuring SIP Processing in the *Rosetta Configuration Guide.*) The File Summary tab is visible only when a file component is highlighted in the tree view of the Web editor.
**Bitstreams Tab**

The Bitstreams tab displays in the Web Editor when the IE includes file streams.
The Bitstreams tab displays information for each of the bitstreams extracted from the IE. The information includes identification, location, and file type.

**Editing Digital Objects**

Editors can view and edit metadata for all three object types (IE, representation, file) using the Web Editor interface. When you make changes to data in the repository, the system creates a working copy and locks the IE so that it is read-only to other users and cannot be opened for editing. Only after you have completed edits is the edited IE regenerated by the system and unlocked. The exception to this rule is when a staff user is editing access rights. Access rights are implemented immediately with no working copy generated. For more information, see Access Rights on page 127.

For information on adding and editing representations, see Adding Representations on page 483.

**Editing Digital Collections**

To add or edit a collection metadata element:

1. From the Metadata tab of the collection you want to edit, click Edit in the row of the metadata type.

   The Add Tag page opens.

   ![Figure 266: Editing Existing Metadata for a Collection](image_url)
2 Click one or more elements from the list to add to your collection’s metadata.

3 Click Select.

The Full View page for the metadata type you selected opens. It contains the element(s) that you entered.
To enter data in the new field, click the text of the new field (in the above image, Date).

The DC Field page opens.
A definition for the field and comments about its usage appear at the bottom section of the page (under the Help tab).

5 Enter a value for the field in the **Update Value** field.

6 Enter a qualifier value, if relevant.

7 To save the new value(s), click the **Save Field** button.

The DC (or other metadata) Full View page opens with the new field and value(s) in the list of tags.
NOTE: The metadata profile assigned to the material flow that was used to create the IE continues to be enforced.

From this page, you can:

- Repeat the procedure and add another tag (click Add Tag)
- Delete any tags (by selecting their check boxes and clicking the Delete button)
- Change the display of tags from tag name (“text”) to tag code or the reverse (click the Display Option button and select the code or name display)
View any error messages (Error Message Report tab)
- Cancel your edits (click Cancel)
- Validate the metadata changes you made (click the Validate button)

When you have finished with your edits, click the Save button. The system saves your edits to the collection metadata.

**Editing Metadata through the Web Editor Interface**

**To edit metadata from the Web Editor:**

1. Access the object whose metadata you want to edit by running a search and selecting Info in the object’s row.
   
   The Web Editor opens to your object.

2. If the object is not an IE, click the IE object level in the left pane.

3. Click the Actions drop-down menu in the lower right corner. If the option to Lock Object appears, select it and click the GO button. (If the object is already locked, move to the next step.)

   ![Figure 272: Web Editor Page, Locking an Object](image)

   The page refreshes with a note in red informing you that the object is locked to your ID.
**NOTE:**

If **Lock Object** does not appear in the **Actions** drop-down menu, you (or another user) have already locked it for use or you are not authorized to edit the IE.

4 In the content pane, click the **Metadata** tab.

![Figure 273: Web Editor - Metadata Tab](image)

<table>
<thead>
<tr>
<th>Intellectual Entity</th>
<th>Created on</th>
<th>Created by</th>
<th>SIP ID</th>
<th>Version</th>
<th>Updated on</th>
<th>Updated by</th>
<th>Locked By</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIDE1039</td>
<td>13/02/2011</td>
<td>adm1</td>
<td>4</td>
<td>1</td>
<td>13/02/2011</td>
<td>adm1</td>
<td>Me</td>
</tr>
</tbody>
</table>

In the content pane, click the **Metadata** tab.
Editing Descriptive Metadata

To edit descriptive metadata:

1. In the Descriptive row, click **Edit**. The following appears:

![Tag List](image)

Figure 274: Tag List

2. To edit a tag, click the tag. The following appears, for example:
3. Enter a value and click **Save Field**.

4. To add a new tag, select **Add Tag**. The following appears:
5  Select a tag and click Select. The new tag is added to the list of tags.

**Adding or Editing Source Metadata**

The Rosetta Web editor allows you to add and edit metadata from original IEs, representations, or files when the metadata format does not conform to the standard Dublin Core used in most parts of the Rosetta system. This protects the integrity of the original metadata, which can be compromised when mapping to an often simpler DC format.

**To add and edit source metadata:**

1  From the Metadata tab of the Web editor, click the Add Metadata button. The first step of the Add Source Metadata wizard opens.
2 To insert new metadata by entering text, select the **Insert new (empty)** option. To upload an existing metadata XML file, select **Insert from PC**. The wizard prompts you to select your metadata type from a drop-down list.

If you selected the option of inserting an existing XML file from your PC, there will be an additional field for you to browse to the file on your PC and upload it.

3 For either selection, click the **Edit Metadata** button. The page opens to Text View.
To display Grid View, click Grid.
You can add tags by clicking the tag types on the right side of the page. Add or edit the text. When you are finished, you can click the **Validate** button to check the XML. Rosetta displays any errors under the Error Message Report tab.

5. Click **Save**.

The source metadata is saved to the Rosetta repository. From there, it can be:
- viewed through the Delivery module after an administrative user has edited the relevant XSL file(s); see the Delivery XSL section of the Configuring Delivery chapter of the Rosetta Configuration Guide.

- published using a converter installed as a plug-in. Rosetta supplies one that converts source metadata in MARC XML format. This converter is available through the Developer’s Network and Rosetta staff can use it to develop their own plug-in.

**Adding a Logical Structmap**

You can use the Rosetta Web Editor to add logical structmaps to representations.

**To add a logical structmap to a representation:**

1. In the Web Editor, select the representation to which you want to add the structmap.
2. Select the Metadata tab and click Add Metadata.
3. To insert new metadata by entering text, select the Insert new (empty) option. To upload an existing metadata xml file, select Insert from PC.

   If you selected the option of inserting an existing XML file from your PC, there is an additional field for you to browse to the file on your PC and upload it.

4. Select Structmap from the drop-down list, and click Edit Metadata. The page opens to Text View.

   Rosetta displays the physical structmap as a template for you to create a logical structmap.
To display Grid View, click Grid.

You can add tags by clicking the tag types on the right side of the page. Add or edit the text. When you are finished, you can click the Validate button to
check the XML. Rosetta displays any errors under the Error Message Report tab.

6. Click Save.

The structmap is added.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Mid</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNX</td>
<td>DNX</td>
<td>DNX_REP1004</td>
<td>Edit</td>
</tr>
<tr>
<td>METS Section</td>
<td>Structure Map</td>
<td>REP1004-1</td>
<td>Edit, Remove</td>
</tr>
<tr>
<td>METS Section</td>
<td>Structure Map</td>
<td>REP1004-2</td>
<td>Edit, Remove</td>
</tr>
</tbody>
</table>

Figure 282: Added Structmap

Click Edit to edit the structmap and Remove to remove it.

**Generating a Logical StructMap**

A logical <structMap> can be generated for a representation using the Generate Logical Structmap task. The generated structMap will be based on the content of each file's fileOriginalPath DNX value, with a forward or backward slash as a delimiter (the file name is ignored).

The tasks parameters are as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preservation Type (required)</td>
<td>The preservation type of the representation for which the structMap is to be generated.</td>
</tr>
<tr>
<td>Replace existing</td>
<td>Replace existing logical structMap(s) with the newly-generated structMap(s). (Default = no; if yes, all existing logical structMaps in the representation are replaced.)</td>
</tr>
</tbody>
</table>

**NOTES:**

- Objects will be tarred or flat based on the export_flat general parameter value. Refer to the General Parameters section in the System Administration Guide for further information.
- This task can be added to an enrichment task chain.
If the folder of streams is flat (that is, if all files in the representation have the same `fileOriginalPath`), no logical structMap will be generated since this is the equivalent of a physical structMap.

**Editing a Physical Structmap**

You can use the Rosetta Web Editor to edit physical structmaps of representations.

**To edit a physical structmap:**

1. In the Web Editor, select the representation whose structmap you want to edit.
2. Select the Metadata tab and click Edit for the METS Section.

3. Edit the Structmap Label, Root Label, and file label. The edited labels now appear in the viewer.
Exporting Objects

Objects can be exported out of the Rosetta system to expedite their editing or review. The export function copies information as described in the following table:

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Objects to Export</th>
</tr>
</thead>
<tbody>
<tr>
<td>IE</td>
<td>All representations and files in the IE are exported to an exports directory on the server.</td>
</tr>
<tr>
<td>Representation</td>
<td>The representation and all of its files are exported to an exports directory on the server. The export function exports the linked IEs and representations, but does not export any other representations in the IE.</td>
</tr>
<tr>
<td>File</td>
<td>The file is exported to the user’s hard drive or to an exports directory on the server.</td>
</tr>
</tbody>
</table>

**NOTE:**
The exported files are structured according to their initial structure when they were ingested into Rosetta. (This information is saved in the fileOriginalPath DNX field.)

**To export an object:**

1. Find the IE, representation, or file you want to export by conducting a search of the system.
2. Open the object in the Web Editor. (See Accessing the Web Editor on page 453.)
3. Select the IE, representation, or file in the tree view of the Web Editor.
4. Click the down arrow of the Actions drop-down field and select **IE Export**, **Representation Export**, or **File Download**, depending on your object type. Then click **Go**.

The system generates an export process and prompts the user for an export path and other export task-related parameters.
NOTE:
If the enforce_ar_export general parameter is set to true, Access Rights will be enforced during export. Certain representations, or the entire IE, may not be exported, in accordance with the IE/REP AR policies.

5 Log on to the server (if necessary) and locate the exported item in the directory specified.

Commit or Rollback Changes

When you have made changes to an object, you must indicate to the system that you want to save (commit) those changes or discard (roll back) them. Once you commit, the object will be saved as you determined and unlocked, and the object will be returned to the permanent repository.

To commit or roll back changes to an object:

1 From the Web Editor page of your object, select the object (IE, Representation, or File) in the tree view.

2 In the Actions drop-down menu, select Commit Changes to save the changes you have made or Rollback Changes to save the previous version of the object (without the changes you just made).

NOTE:
If you do not see the options for commit or roll back, click Lock Object from the Actions drop-down menu, then click Go and wait for the page to reload.

3 Click the Go button.
   The system commits or rolls back your changes. The Web page reloads with the following message appearing in red text:
   “Currently Being Committed/Rolled By: Me. Refresh Page.”

4 Click Refresh Page to continue working on this IE.
Adding Representations

This section contains:
- Introducing Representation Functions on page 483
- Managing Representations on page 483
- Adding a Representation: Process and Steps on page 484

Introducing Representation Functions

Representation functionality extends the life of intellectual entities (IEs) that require modifications for the following reasons:
- The library does not possess the technical resources or applications to render the IEs.
- The library possesses collections of objects in soon-to-be obsolete digital formats.
- Some objects in the library exist in a format that contains a problematic attribute that will not be supported in the future.

Rosetta offers preservation functionalities such as:
- adding single or multi-file representations
- ordering files in multi-file representations
- adding representation metadata and provenance information
- updating the file content of a representation in permanent storage.

Managing Representations

Rosetta breaks down representations into the following types:
- Preservation Master (PM): the system’s preservation copy of an object’s files.
Modified Master (MM): a copy of a PM that has been manually modified.

Access Copy (AC): a derivative of a PM or MM that has been created (by Rosetta or by an external system) to support greater access (for example, a low-resolution Web browser copy).

**NOTES:**

- The Preservation Master is mandatory and there can only be one
- The Modified Master is optional and there can only be one
- Derivative copies are not preserved
- Custom preservation types, defined in the Preservation Type code table, are optional and repeatable

The following table describes representation-level activities and the situations in which they are used.

**Table 67. Representation Activities in Rosetta**

<table>
<thead>
<tr>
<th>Activity</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIP Processing</td>
<td>During the Enrichment task chain, derivative copies are created and added as new representations.</td>
</tr>
<tr>
<td>Preservation Action</td>
<td>Running a preservation action involves creating a new representation (or representations) for each IE in the preservation set.</td>
</tr>
<tr>
<td>Derivative Copies</td>
<td>Functionality supports adding an access copy as a new representation through the Web Editor. (See Derivative Copy Representations on page 439.)</td>
</tr>
</tbody>
</table>
| Ongoing Maintenance | The Editor can add a new representation to a specific IE when:  
  - Higher quality representations of digitized material (PMs and MMs) need to be added to existing IEs  
  - New representations of digitized material need to be added to existing IEs. |

Preparing the material and processing the representation vary according to the user’s context in the system and the needs of the IE or preservation set. The add representation component receives the material for the new representation and launches the proper process according to the source of the call.

**Adding a Representation: Process and Steps**

Three stages comprise the process flow for adding a representation:
Locking the Intellectual Entity on page 485
Adding the Representation on page 486
Processing the Representation on page 490

Locking the Intellectual Entity

The Editor must lock the IE before adding a new representation. This is done through the Web Editor Object Summary page for the selected IE (follow the path from SIPS List > Edit IE so the Web Editor opens, or conduct a search of IEs and then open one for editing).

Select Lock Object from the Actions drop-down list, then click Go.

The IE locks, the page is refreshed, and the Actions drop-down menu contains relevant options.

When a representation is added through the Web Editor, the system creates the descriptor file with information about the IE. In this case, a new representation is added to the IE with no relationship to existing representations. Thus there is no source representation.

Users can load files for the first time using the Choose From Server tab in the Web Editor (Add Representation - Load File stage). In this case, the user places files under the home directory. The system is responsible for copying the files to the general Import directory.
Adding the Representation

To add a representation from the Web Editor, access the page containing the object summary for your IE. Make sure the object is locked.

Figure 285: IE Locked by the User

Follow these steps to complete the Add Representation wizard:

1. Select Add Representation from the Actions menu and click Go to launch the Add Representation Wizard.
   Step 1 of the wizard opens.
2. Enter values in the fields using Table 68 as a guide.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>A name for the new representation</td>
</tr>
<tr>
<td>Preservation Type</td>
<td>Select the Preservation Type. This field is mapped to the field –</td>
</tr>
<tr>
<td></td>
<td>DNX.generalRepCharacteristics.preservationType</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> IEs must contain one preservation master and may contain up to</td>
</tr>
<tr>
<td></td>
<td>one modified master. Other types are unlimited.</td>
</tr>
<tr>
<td>Usage Type</td>
<td>Mapped to the field DNX.generalRepCharacteristics.usageType. The default</td>
</tr>
<tr>
<td></td>
<td>type (and currently the only supported type) is View.</td>
</tr>
<tr>
<td>Representation Code</td>
<td>Applies only when the Preservation Type is <strong>Derivative Copy</strong>. (System</td>
</tr>
<tr>
<td></td>
<td>ignores entries for master copies.) Default value is None.</td>
</tr>
<tr>
<td>Access Rights Policy</td>
<td>Select an Access Rights Policy from the drop-down list of available policies.</td>
</tr>
<tr>
<td></td>
<td>This policy applies exclusively to this representation.</td>
</tr>
</tbody>
</table>
3 Click the Next button.
If you selected Derivative Copy for your Preservation Type, the system moves you to the final step (2) in the wizard. (Skip the next step of this procedure and the accompanying figure.) If you selected Preservation Master or Modified Master, the Additional Information page opens as Step 2 of the wizard. (See the following figure and accompanying step.)

![Image](image_url)

**Figure 287: Add Representation - Additional Information for Master Copies**

4 Enter the following information in the available fields:
- For the Additional Information section, enter values for as many of the available Preservation Properties as you want. Select the property from the drop-down menu, enter a value in the field, then click the Add button. Repeat as needed.
- For the Provenance Information section, enter information that explains why a new representation is needed.

5 Click the Next button to move to the next step in the wizard. (To return to a previous step or cancel the procedure, click the Back or Cancel button.) The Load File page opens.
6 In the Select File section, use the **Insert from Local PC** or the **Choose from Server** tab to browse to the local or server-based source of the file(s) you want to select for preservation.

**NOTES:**

- If you are unable to use the applet, you can load the files manually. To do this, click the link to **Load the files manually** at the top of the Select File section and load the files through your Windows-based file selection.

- When the Preservation Type value is Derivative Copy, this step will be Step 2 (out of two steps) rather than Step 3 (as pictured here).

7 When you have selected the file(s) for your preservation copy, click the **Done** button to finish.

The system copies the files under the general Import Directory root.
**Processing the Representation**

When the Add Representation is called, the system loads the files into Rosetta, runs the Validation Stack, performs Enrichment tasks, and moves the IE to the permanent repository.

While the Add Representation process is running, the system displays status messages indicating the task is in-progress or complete. Any problems identified during the process are sent to the Technical Analyst (TA) Inbox (similar to problems found during SIP processing). This is noted in a message to the Editor, as are any notices of the IE being committed or rolled back. When the Commit or Rollback action is complete, the system unlocks the IE and removes the Import Directory and all of its contents.

**NOTES:**

- Add Representation is an asynchronous process. Once the Add Representation process is launched, the Editor does not interact with the process. When Add Representation has finished, the system displays a message on the Web Editor page so that the Editor knows to commit or roll back the action.

- If the Editor performed a number of actions on the IE without committing and then Add Representation fails, the following scenarios are possible:
  
  If the Editor selects **Commit**, all of the actions on the IE except the failed Add Representation are committed.
  
  If the Editor selects **Rollback**, all of the actions on the IE performed after the last commit are rolled back.

When the system completes the Add Representation process, it notifies the Editor by e-mail.

**Updating a Representation**

Rosetta allows you to update existing representations with minimal impact on the AIP and associated objects. Revised representations can replace existing representations without performing enrichment, without copying all related files, and without a preservation plan. Instead, the representation

- maintains its place in the structural map of the object
- updates the content and structure of the representation (not its metadata)
- references related files rather than uploading those same files that are already uploaded with the previous version of the representation
Revisions can be performed on a single representation through the UI (see Adding the Representation on page 486) or as a batch process through one or more APIs. (Information on APIs can be found on the Developer's Network (https://developers.exlibrisgroup.com/rosetta/apis/IEWebServices)

**Replacing Files Within a Representation**

A single new representation can replace an existing one through a manual procedure in the Web editor. This revised version should be ready for upload when you begin this procedure.

**To revise a single representation:**

1. Locate the representation or the IE to which the representation belongs. You can use any of the Rosetta search functions that access the permanent repository. (For example, from the Data Management menu, go to the Search and Manage Queries heading and select Search for Objects, then perform a search for the representation you are going to revise or replace.)

2. Open the object in the Web editor and lock the IE (see Open and Lock Object on page 491)

3. Select the representation you want to revise.

   The Actions menu changes to provide relevant actions.
Select **Update Representation** and click **Go**.

The first step of the update wizard opens (Figure 291).

5. Add a Submission Reason for the update (for example, see Figure 292).

6. Click the **Add New File** button to add a new file. To replace an existing file, click the **Replace** Action beside the file you want to revise (see Figure 292).
Figure 292: Update Representation Page, Reason and Next Step

A lightbox for the update representation opens.

Figure 293: Light Box Form for Updating a Representation

7 Click the **Browse** button and select the file you want to upload from a local or network drive.
8 Enter a Label and a Structmap Label for the file and any additional information in the Note field of the form. The Structmap label and Notes fields will be displayed in the Delivery module of Rosetta.

**NOTES:**

- New files are appended to the end of the structmap.
- Only physical structmap labels can be edited. Logical structmap labels are added automatically for new files based on the file name and can be edited separately.

9 Click the **Add Selected File** button.

The lightbox closes and the new representation displays in the list of files on the Add Representation page.

10 Enter a Submission Reason (optional) and click the **Submit** button.

Rosetta reloads the IE in the Web editor. The new IE version appears in the object tree in the left column of the page (**Figure 295**).
11 Select **Commit Changes** from the Actions drop-down menu and click the **Go** button.

The page reloads with a status update and a link for refreshing the page. The object is locked again.
Index

Numerics
1st-time registration reasons, 223

A
access rights exceptions, 139
assign, 143
setting up, 139, 143
Web editor, 145
Metadata Search page, 128
policies, 128
deleting expressions, 136
editing, 134
Add Set page, 360
adding representations, 483, 486
advanced search, 28
conditions, 29
Advanced Search page, 29
approval group, 269
Arranger, 282
merge single IE, 283
rearrange IE structure map, 282
split an IE, 286
Assessor, 282
Assessors, Arrangers, and Approvers, 269, 271
approving SIPs, 280
depleting SIPs, 280
forwarding SIPs and IEs, 281
rejecting SIPs, 280
responsibilities, 269
viewing SIPs, 272
history, 276
IE metadata, 278
information, 275
notes, 277
objects, 278
tree view, 287
auto-completion
column names, 37
sort elements, 35
Auto-correction rules, 331

B
bulk delete IEs, 390

C
CMS, 291
ID, 237, 291
link to multiple IEs, 291
link metadata to IE, 291
Collection Management
dissociating IEs, 433
collection management systems
see CMS
collection metadata, 425
add type, 426
DC Full View Page, 466
download element, 464
download field, 467
collections, 419
with IEs, 428
configuration files, 111
content structure, 100
configuring, 99
material flows, 110
copyright boilerplate statements, 114
creating an itemized set, 358

D
Data Manager, 351
assign access rights, 137
processes, 367
History Execution page, 369
viewing, 369
decline content, 312
Delete IE task chain, 391
delivery
copyright statements, 113
XSL files, 113
Delivery Copyrights Statements, 113
Delivery XSLs page, 113
Deposit Activities page, 241
deposit activity, 311
deposit control settings, 228
Deposit Manager, 69
adding lists of values, 78
adding metadata forms, 75
content structures, 99
control settings, 71
copyright boilerplate statements, 114
duplicating Producer profile, 170

generic material flows, 155

managing Producer profiles, 165

material flow components, 125

material flows, 85, 171

metadata forms, 73

Producer profile, 168

submission formats, 86

Depositor e-mail, 116

E

editing metadata, 469

Editor, 343

content management, 351

e-mail

configuration files, 119
display fields, 116
notification, 120
SIPs, 116

e-mail_to_depositor.xsl, 119

error codes, 316

exporting objects, 481

external storage

fixity, 405

F

Find a SIP report, 63

fixity, 405

check, 405

reports, 406

G

generic material flows, 155

adding, 157

H

Home page, 24

I

IE, 353, 464

access rights policy, 137

deleting, 388

export, 481

locking, 485

metadata, 453

viewing, 453

permanent repository, 402

purging, 397

recovering, 395

representations, 483

restoring, 402

sets, 353

adding members, 362

creating, 355, 357

deleting, 365

itemized, 353

logical, 354

searching, 32

viewing, 364

IEs

delete multiple, 390

intellectual entity

see IE

itemized set, 353, 358

L

List of Material Flows page, 155

List of Metadata Forms page, 74

List of Metadata Profiles, 121

accessing, 122

List of Producer Profiles Page, 165

logical set, 358

query, 358

M

Manage Producers page, 211

accessing, 211

filter Producers, 215

sort Producers, 215

Manage Sets page, 354

Material Flow Details page, 231

material flows, 85

activating, 161, 174

assign to Producer, 229

associating with Producer profiles, 173

components, 125

deactivating, 161, 174

deleting, 163

duplicating, 162

generic, 155

adding, 157

list, 155

personalize, 231

removing from Producer profile, 174

updating, 162

Material Flows List page, 171

metadata

forms, 73, 82

adding, 75

duplicating, 82

generic lists of values, 81

lists of values, 78

material flows, 84

previewing, 82

updating, 83

profile
deleting, 125
editing or duplicating, 123
new, 123
shared, 345
source, 473
Metadata Search page, 128, 345

N
Negotiator, 207
adding Producer accounts, 216
depositing Producer content, 241
managing Producers, 211
personalizing material flows, 231
updating Producer accounts, 222

P
personalize
material flows, 231
metadata forms, 239
Producer profiles, 225
submission formats, 240
PID list, 361
problematic content, 303
processes
tasks/task chains, 367
viewing, 368
processing representations, 490
Producer
accounts
activating, 222
adding, 216
deactivating, 222
deleting, 223
updating, 222
cancelling reports job, 250
Contacts, 221
individual versus group, 216
managing reports job, 248
modifying reports job, 249
profile, 165
activating, 168
adding generic, 167
associating material flows, 173
deactivating, 168
deleting, 170
duplicating, 170
personalize, 225
updating, 169
reports, 245, 246
configuring job schedules, 252
search, 213
trusted, 226
Producer Agent, 222
default e-mail, 116
e-mail, 116
registration, 223
Producer Details page, 225, 227
Producer Profile List page, 165
provenance, 405
publishing, 379
configuring, 380
converter types, 385
target types, 385
purging IEs, 387

Q
quick search, 25

R
recheck
SIP files, 322
recycling bin, 395
reject content, 312
report
Producer, 245
reports, 42
available in Rosetta, 50
running, 43
representation
adding, 486
functions, 483
locking IE, 485
managing, 483
process flow, 484
processing, 490
rerun
enrichment, 323
SIP with system error, 324
validation, 323
restoring IEs, 387
retention policies
about, 147
creating, 148
working with, 151
retention policy, 147
Rule Details page, 336
Rule List page, 335
rules
auto-correction, 331
file extension mismatch, 332
format identification, 331
match, 185
metadata extraction error handling, 332
operators, 184
validation
stack, 332
S
scheduled job, 44, 258, 412
search
advanced, 28
metadata, 128, 345
Producers, 213
quick, 25
search elements
nested, 31
operators, 32
searching for objects, 23
sets
itemized, 358, 362
logical, 357, 358
shared metadata, 345
Metadata Search page, 345
SIP, 271
bitstream extraction, 306
errors, 307
failure, 309
files
recheck, 322
process flow, 65
repair and replace, 315
reports, 62
status and stage, 59
view Enrichment errors, 308
SIP Content List page, 273
accessing, 273
SIP detail report, 63
SIP processing, 177, 186
activate a configuration, 190
adding a configuration, 187
approval, 181
auto-correction rules
re-ordering, 337
deactivate a configuration, 190
deleting a configuration, 189
duplicating a configuration, 189
enrichment, 181
permanent, 181
pre-approval, 178
process flow diagram, 65
routing rules, 190
activating, 194
adding, 191
deactivating, 194
deleting, 194
duplicating, 194
updating, 193
rules
activating, 338
adding, 334
deactivating, 338
deleting, 339
duplicating, 338
updating, 337
stages, 177
updating a configuration, 188
validation stack rules, 332
workflow, 177
SIP Processing Configuration List page, 186
SIPs Dashboard report, 62
source metadata, 473
staff
reports, 23
user
overview, 21, 22
submission
formats, 86
jobs, 257
submission information package
see SIP
System Error folder, 309
T
task chains
collections, 429
associating IEs, 429
task parameters, 432
Delete IE, 391
tasks
assigning collections, 429
Technical Analyst, 299
advancing deposit activity, 312
delivering problematic SIP, 315
deposit activity
return or decline, 312
deposit error resolution, 301
problematic content, 303
replace repaired SIP, 315
re-running
processes, 321
rerunning
enrichment process, 323
system errors, 323
validation, 323
resubmit problematic content, 314
validation recheck, 321
text file upload, 361
To Permanent folder, 308
trusted Producers, 226
U
User Manager, 207, 270
V
validation
Index

recheck, 321
stack, 178, 332
rules, 332
validation stack
test error codes, 316
viewing metadata, 455

W
Web editor, 453
accessing, 453
cannot/commit back, 482
deleting IE, 387
dediting metadata, 469
exporting objects, 481
Metadata tab, 457
Object Summary tab, 455
Services tab, 459
Versions tab, 461
viewing metadata, 455
wildcard, 33

X
XSL converter, 103
Staff User’s Guide

Index